Overview
Have you ever used the Internet, America Online, or another online
service? If so, you've probably encountered Zip files. Are you a Windows
user? If so, WinZip® is the way to handle these archived files.
WinZip brings the convenience of Windows to the use of Zip files and
other compression formats.
WinZip features include:
Seamless Windows integration: WinZip includes tight integration
with My Computer and Windows Explorer. Drag and drop to or from
Explorer, or zip and unzip without leaving Explorer.
Internet support: WinZip features built-in support for the popular
Internet file formats TAR, gzip, UUencode, XXencode, BinHex, and
MIME. In addition, ARJ, LZH, and ARC files are supported via
external programs. You can use WinZip to access almost all the
compressed and encoded files you download from the Internet.
Automatic installation of most software distributed in Zip files:
If a Zip file contains a "setup" or "install" program, WinZip's Install
feature will unzip the files, run the installation program, and clean up
temporary files.
The WinZip Wizard: This optional feature uses the standard and
familiar "wizard" interface to simplify the process of zipping,
unzipping, and installing software distributed in Zip files. The WinZip
Wizard is ideal for the rapidly growing number of PC users who are
getting started with Zip files and for those who use Zip files only
infrequently. When these users gain confidence or want to use more
advanced zipping features, the full WinZip Classic interface is just a
click away.
Favorite Zip Folders: WinZip lets you organize Zip files into one
convenient list that is sorted by date, making it easier to locate all Zip
files, regardless of where they came from or where they are stored.
Unlike the standard Open Archive dialog box, the Favorite Zip
Folders dialog box treats the contents of multiple folders as though
they were one folder. A Search facility will find any Zip files lost on
your hard disk.

Large file support: WinZip supports the 64-bit Zip file format, which
eliminates all practical restrictions on the size of Zip files and on the
number and size of compressed files within a Zip file. Zip file
capacity is limited only by your system's resources.
Advanced encryption: WinZip's advanced 128- and 256-bit AES
encryption helps you prevent unauthorized disclosure of the contents
of your sensitive documents.
Create files that unzip themselves: WinZip Self-Extractor Personal
Edition is included with WinZip. Self-extracting files are ideal for
sending compressed files to others who may not own or know how to
use file compression software.
Zip and E-Mail: WinZip lets you zip files or folders and e-mail them
with just a few clicks from Windows Explorer or My Computer. In
addition, the freely downloadable WinZip E-Mail Attachment Add-On
for Outlook lets you zip your Outlook e-mail attachments quickly and
easily, right from Outlook 2000 and Outlook 2002.
Virus Scanner Support: WinZip can be configured to work with
most virus scanners.
WinZip is extremely easy to use! To open an archive simply double
click on an archive listed in My Computer or Windows Explorer, drag and
drop an archive onto WinZip, or use the standard Open dialog box. The
main WinZip window features a list with the names, sizes, and date/time
stamps of all files in the open archive. This list can be scrolled and sorted
on any field. A configurable tool bar provides fast access to commonly
used actions. Extensive context sensitive help is always available.
Double clicking on a file in the main WinZip window has the same effect
as double clicking in My Computer or Windows Explorer. First, the file is
extracted from the archive. Then, if the file is executable, it is run.
Otherwise, the file is opened by the appropriate application (for example,
WordPad for *.WRI files) based on standard Windows associations.
The Windows Drag and Drop interface is fully supported. You can drag
and drop files from WinZip to other applications. WinZip will extract the
files before dropping them on the target application. The target
application will treat the files as if they had been dropped from My
Computer or Windows Explorer. You can also drop archives on WinZip to
open them, or drop files on WinZip to add them to the open archive.

Magazine Quotes
Here's what magazine reviews say about WinZip®:
"WinZip: Compression's reigning champ" - CNET, 5/21/2003
"WinZip ... the market leader among file-compression utilities ..." PC World, 5/20/2003
"WinZip has proven once again to be one of the best investments I
ever made for my PC." - PC Buyer's Guide, 5/13/2003
"WinZip sprang onto the desktop and I was hooked for life. To this
day, no other compression client has been able to win me over." Lockergnome, 5/13/2003
"WinZip has long set the standard for file compression utilities, and
recent versions uphold its strong reputation." - PC World, 5/13/2003
"WinZip is 'The Standard' in archive and compression software." Shareware Junkies, 5/1/2003
"WinZip is the best product of its type on the market." - The CPA
Software News, 4/1/2003
"The tool is the de facto compression utility on Windows machines,
and the program undoubtedly delivers everything a user needs and
more." - Smart Computing, 3/1/2003
Visit our web site for a more complete and up-to-date list of magazine
quotes.

System Requirements
WinZip® requires Windows 98, Windows Me, Windows XP, Windows NT
4.0, or Windows 2000. It will not run under Windows 3.x or Windows NT
3.1 or 3.5.
No other programs are required to add or extract files from Zip files.
However, some optional WinZip operations do require external programs
or files:
Optional virus scanning support requires that a supported virus
scanning program be installed on your system. See below for
specific information and how to find a list of virus scanners
automatically detected by WinZip.
Optional support for some older formats (ARC, ARJ, and LHA)
requires one of the supported programs listed below. For step-bystep instructions on installing these programs see the section titled
Installing Optional External Programs.
Here are more details on some of the optional programs:
You can create self-extracting Zip files with WinZip Self-Extractor
Personal Edition, included with WinZip, or you can use the full
WinZip Self-Extractor, a $49 companion product, which includes
features tailored for software distribution and the ability to create a
single self-extracting Zip file that can be run under Windows.
To access LZH files, the LHA.EXE program is required. For the latest
information on obtaining LHA.EXE, visit the WinZip web site at
http://www.winzip.com/xextern.htm. WinZip will not work with
versions earlier than LHA 2.13 (in particular, it will not function with
LHARC, the predecessor to LHA).
To access ARJ files, the ARJ program from Robert Jung is required.
You can download the shareware version of ARJ from the Internet
and the major online services. For the latest version supported by
WinZip, visit the WinZip web site at
http://www.winzip.com/xextern.htm. WinZip will not work with
versions earlier than ARJ 2.5 (in particular, it will not function with
ARJ32).

To access ARC files, one of the following programs is required:
ARCE.COM and ARC-E.COM version 4.0e - Vern Buerg's ARC
extraction utility, available from the Internet and the major online
services. WinZip was not tested with earlier versions.
PKXARC.COM version 3.5 from PKWARE, Inc. WinZip was not
tested with earlier versions. This program may still be available from
some Internet locations.
PKXARC.EXE version 3.6 from PKWARE, Inc. This program may
still be available from some Internet locations.
PKUNPAK.EXE version 3.61 from PKWARE, Inc. This program may
still be available from some Internet locations.
ARC.EXE version 5.20 or 6.0 from System Enhancement
Associates, Inc. This is the last version of ARC available as
shareware, and may still be available from some Internet locations.
WinZip was not tested with earlier versions.
WinZip will automatically detect several popular virus scanners; for a
current listing, visit the WinZip web site at
http://www.winzip.com/xvirus.htm.
WinZip can also be configured to work with most virus scanning utilities.
For important details, see the section titled Virus Scanner Configuration.
Some toolbar configuration options require version 4.71 or later of the
Windows Common Control library. This library is part of Windows 98,
Windows Me, Windows 2000, Windows XP, and Microsoft Internet
Explorer 4.0 or greater, and is available as a separate download from the
Microsoft web site as described in the section Windows Common Control
Library.

WinZip Installation (Network)
If you are interested in information on installing WinZip® site licenses in a
networked environment, please see the web page
http://www.winzip.com/site_install.htm.

WinZip Uninstallation
There are three ways to uninstall WinZip® should you wish to do so.
Control Panel
Activate the Control Panel, double click Add/Remove Programs, and
double click the WinZip entry in the list of programs.
Start Menu
From the Start menu, click Programs, then WinZip, and then Uninstall
WinZip.
Run Dialog
You can also uninstall WinZip by running WINZIP32.EXE and specifying
the /uninstall parameter. To do this, click the Start button, choose Run,
type
winzip32 /uninstall
and click OK.
Technical details
The "Uninstall WinZip" procedure performs the following steps:
1. Verifies that it is safe to uninstall.
2. Uninstalls any WinZip add-ons (the WinZip Command Line Support
Add-On, the WinZip E-Mail Attachment Add-On for Outlook, etc.)
3. Deletes files in WinZip folder if they were installed by this version of
WinZip and if the file's date/time stamp matches WINZIP32.EXE. All
.GID, .FTS, and .PIF files in the WinZip folder are deleted,
regardless of their date/time stamp.
4. Removes any WinZip file associations from WIN.INI.
5. Removes [WinZip] entry from WIN.INI.
6. Removes the WinZip icons, WinZip desktop shortcut, WinZip Start
menu entries, and WinZip Quick Pick.
7. Removes the WinZip entries from the registry.
Note: some files, including WINZIP32.EXE, may not be deleted until the
next time the computer is restarted.

Installing Optional External Programs
WinZip® includes built-in support for the Zip, CAB, Microsoft Compress,
gzip, TAR, UUencode, XXencode, BinHex, and MIME formats, so no
other programs are required for most WinZip operations. However, virus
scanning and operations involving ARC, ARJ, and LZH files require
external programs. These optional external programs are not distributed
with WinZip. You must tell WinZip where to find these programs as
described in the section titled Program Locations. The following sections
provide step-by-step examples of how to install LHA and ARJ.
Remember: the use of these external programs is optional. If you are just
getting started with WinZip you will probably want to skip this section and
work without the external programs until you encounter a need for them
(and are more familiar with WinZip).
These instructions assume you are comfortable working with My
Computer or Windows Explorer, know how to use standard Windows
features such as dialog boxes and menus, and have a little experience
using WinZip. See Quick Start for introductory information and how to
quickly become familiar with WinZip.
Note: The first step in installing an external program is to acquire the
external program. See System Requirements for information on obtaining
these programs.
Related Topics:
Installing LHA
Installing ARJ

Installing LHA
You should be aware that LHA.EXE is a legacy DOS application that has
not been updated since the mid-1990's, and that security issues have
been reported since then that can affect various versions of LHA.EXE.
Even though WinZip® is able to detect the invalid LZH files that trigger
several known security issues affecting LHA, and will refuse to open
these files, you should be sure that you know and trust the source of any
LZH archives that you work with. Please see Security Hints and Tips for
additional security information.
Here are step-by-step instructions for installing LHA, an optional external
program required to work with LZH files.
1. LHA is distributed as a self-extracting archive called LHA255E.EXE.
For information on downloading LHA255E.EXE, visit
http://www.winzip.com/xextern.htm.
2. Use My Computer or Windows Explorer to create the folder C:\LHA.
You can use a different folder but then you will need to substitute that
folder name in the following instructions.
3. Use My Computer or Windows Explorer to copy LHA213.EXE from
your download folder to the C:\LHA folder.
4. Double click on LHA255E.EXE to run it. This will cause the files in
LHA255E.EXE to "self-extract" into the C:\LHA folder. Then go back
and delete C:\LHA\LHA255E.EXE, as it is not needed for day-to-day
work with LHA and WinZip.
5. Start WinZip. Open the Options menu and click Configuration, then
click the Program Locations tab.
6. In the LHA field of the Program Locations tab of the Configuration
dialog box, type
c:\lha\lha.exe
and click the OK button.
That's all there is to installing LHA. You can now access .LZH files
(created by LHA) the same way you access Zip files.

Installing ARJ
Here are step-by-step instructions for installing ARJ, an optional external
program required to work with ARJ files.
1. ARJ is distributed as a self-extracting archive named ARJn.EXE,
where n is a version number. Note that WinZip only supports 16-bit
versions of ARJ and does not support 32-bit versions of ARJ. The
earliest version of ARJ supported by WinZip® is ARJ 2.50a
(ARJ250A.EXE); for the current version of ARJ supported by WinZip,
visit http://www.winzip.com/xextern.htm. First download the file from
your favorite online service.
2. Use My Computer or Windows Explorer to create the folder C:\ARJ.
You can use a different folder but then you will need to substitute that
folder name in the following instructions.
3. Use My Computer or Windows Explorer to copy the ARJ installation
executable from your download folder to the C:\ARJ folder.
4. Double click on the file to run it. This will cause the files to "selfextract" into the C:\ARJ folder. You can then delete the installation
executable if you wish, as it is not needed for day-to-day work with
ARJ and WinZip.
5. Start WinZip. Open the Options menu and click Configuration, then
click the Program Locations tab.
6. In the ARJ field of the Program Locations tab of the Configuration
dialog box, type
c:\arj\arj.exe
and click the OK button.
You can now access ARJ files the same way you access Zip files.
Note: like WinZip, ARJ is not free software. As with all shareware, if you
use these programs you should register them with the appropriate
vendor. See the license.doc file in your ARJ folder for details.
Note: ARJ 2.60 and later 16-bit versions provide long filename support
under Windows 95, Windows 98, and Windows Me. Long filename

support is not available when running 16-bit versions of ARJ under
Windows NT 4.0, Windows 2000, or Windows XP.

Quick Start Information
There are several ways to get to know WinZip® quickly and easily; each
tailored to a different style of learning. Choose one or more of the
following approaches
If you haven't installed WinZip yet, see WinZip Installation for brief
installation instructions.
Take a look at the Quick Start Guide, which introduces file
compression terminology, describes the installation process, and
takes a first look at basic WinZip operations. (If you haven't installed
WinZip yet, you'll have an opportunity during installation to print a
nicely formatted version of the Guide.)
Some users just like to dive right in! If you have experience with
archives and Windows, you might want to do just that. Contextsensitive help is available at any time by pressing the F1 key.
You can get an overview of the primary operations of WinZip
from the Brief Tutorial.
If you like to learn by doing, try the WinZip Tutor, which takes you
step-by-step through the process of zipping and unzipping.
The WinZip Wizard leads you through the process of zipping or
unzipping using a series of panels or pages in a special
window, commonly known as a "wizard." This convenient alternative
interface for WinZip can help to simplify zipping, unzipping and
installing software.
Don't miss some of the other topics of interest that can help you get
started:
See Using the Explorer Interface for specific examples of how
WinZip integrates with the Windows shell.
Using Drag and Drop describes a useful WinZip feature. Be sure to
give it a try!
The section on Hints and Tips lists many helpful ideas for using
WinZip.

The WinZip Quick Start Guide
This Guide introduces some file compression terms,
describes some of the initial steps in installing WinZip,
and provides a first look at using some WinZip features.
For additional information, see the tutorials that come
with WinZip, the WinZip help file, and the WinZip web
site at http://www.winzip.com.
What is an Archive or Zip File, Anyway?
Zip files are "archives" used for storing and distributing
files, and can contain one or more files. Usually the files
"archived" in a Zip are compressed to save space. Zip
files are often used to:
Distribute files on the Internet: Only one Zip file
transfer operation (download) is required to obtain all
related files, and file transfer is quicker because the
archived files are compressed.
Send a group of related files to an associate: When
you distribute the collection of files as an archive, you
benefit from the file grouping and compression as
well.
Save disk space: If you have large files that are
important but seldom used, such as large data files,

simply compress these files into an archive and then
unzip (or "extract") them only when needed.
What Does WinZip Do?
WinZip makes it easy for Windows users to work with
archives. WinZip features an intuitive point-and-click
drag-and-drop interface for viewing, running, extracting,
adding, and deleting files in archives with a standard
Windows interface, and also provides a Wizard interface
that further simplifies the process of working with Zip
files.
About WinZip's Setup Options
During the WinZip setup procedure you are asked to
select either the WinZip Classic interface or the WinZip
Wizard interface.
WinZip Classic: The powerful WinZip Classic
interface is preferred if you have a general
understanding of Windows and of Zip files. Most
users will be quite comfortable with its Explorer-like
interface once the basics of Zip files are understood.
WinZip Wizard: The WinZip Wizard guides you
through some of the most common operations
involving Zip files. If you are new to Windows or

unfamiliar with Zip files, you may wish to start with
the Wizard and switch later to the more powerful
Classic interface.
In the following sections we will describe the Classic and
Wizard interfaces. With either interface, the setup panels
provide information about the options offered. Whichever
setup option you choose, you can easily switch between
the two interfaces at any time with a single click, and you
can always change the default settings later.
Using WinZip Classic
Here is a brief introduction to some of the features of
WinZip Classic.
Quick Unzipping with WinZip Classic
1. In the WinZip window, click the Open toolbar button
or choose Open Archive from the File menu. The
Open Archive dialog will appear.
2. In the Open Archive dialog, locate the archive you
want to unzip, then click Open. The contents of the
archive will be displayed in the WinZip window.
3. To extract files from the archive, click the Extract
toolbar button or choose Extract from the Actions
menu. The Extract dialog will appear.

4. In the box labeled Extract to, choose the folder
where you want to place the extracted files and click
Extract.
That's it--you have extracted the contents of the archive
to the chosen folder. You can now work with the
extracted files, select another activity within WinZip, or
close the WinZip window.
Note: You can also extract files from an archive in the
WinZip Classic window by dragging them to the desktop
or to the desired folder in Windows Explorer.
Quick Zipping with WinZip Classic
1. In the WinZip window, click the New toolbar button
or choose New Archive from the File menu. The
New Archive dialog will appear.
2. In the New Archive dialog, specify the location where
you want to create the archive and type the name you
want to use for your new archive, then click OK. The
Add dialog will appear.
3. In the Add dialog, select the files that you want to add
to your new archive and click Add.
That's it--you have created a new archive. You can now
examine the contents of your new archive, select another

activity within WinZip, or close the WinZip window.
Note: You can also add files to an archive by dragging the
files from My Computer or Windows Explorer and
dropping them on the WinZip window.
WinZip Classic Tips
You can view the contents of most documents in an
archive (such as Microsoft Word documents and
Excel spreadsheets) by just double-clicking them in
the WinZip Classic window.
You can extract files from an archive in the WinZip
Classic window by dragging them to the desired
folder in Windows Explorer or to the desktop.
Using WinZip Classic's Help menu, you can:
work with the built-in Brief Tutorial to get
acquainted with more of WinZip's features
view collections of Hints and Tips
find answers to Frequently Asked Questions
Installing the WinZip Wizard
If you decide during installation that you want to use the
WinZip Wizard, WinZip will need to perform a brief
setup procedure that will help it find the Zip files on your
computer. This simple procedure will only need to be

performed once.
1. In the WinZip Setup panel, click Start with the
WinZip Wizard and then click Next.
2. In the Search for Favorite Zip Folders panel, we
recommend that you choose Search Entire Hard
Disk so the Wizard can search your system for Zip
files. You will see the search progress, and then a
panel that indicates how many folders were added to
your Favorite Zip Folders. Click Next.
3. The Wizard will open an Explorer window displaying
the WinZip program group icons. Click Next to
continue, and the Wizard Welcome panel will appear.
4. In the Wizard Welcome panel, click Next again, and
the Select Activity panel will appear.
That's it--you have installed WinZip, and you're ready to
begin using the WinZip Wizard. The sections below
describe using the Wizard for unzipping and zipping files.
Using the WinZip Wizard
If you have just installed WinZip and chosen the WinZip
Wizard interface, you should see the Select Activity panel
on the screen.
If you have previously installed WinZip, you can start a

WinZip session using the Start menu, the WinZip icon
on your desktop, or the WinZip item in the Programs
menu. Click Next in the welcome panel to reach the
Select Activity panel.
Here is a brief introduction to the features of the WinZip
Wizard.
Quick Unzipping with the WinZip Wizard
1. In the Select Activity panel, choose Unzip or install
from an existing Zip file and click Next.
2. In the Select Zip File panel, click on the Zip file you
want to work with and click Next. The Unzip panel
will appear.
3. In the Unzip panel, click Unzip Now to unzip
(extract) the files in the archive. The WinZip Wizard
will open a Windows Explorer window showing the
unzipped files.
That's it--you've just unzipped a Zip file using the
WinZip Wizard. You can now work with the unzipped
files, or click Next to select another activity within
WinZip, or close the WinZip Wizard window.
Quick Zipping with the WinZip Wizard
1. In the Select Activity panel, choose Create a new

Zip file and click Next.
2. In the Choose Zip Name panel, type the name you
want to use for your new Zip file and click Next. For
example, if you are creating a Zip file that will
contain some files related to yearly reports, you might
type "1999 reports" as the name for your Zip file.
3. In the Select Files panel, click Add files to choose the
files you want to add to the Zip file. Select the files
you want to add and click OK.
4. Click Zip Now to create the new Zip file.
That's it--you've just created a Zip file using the WinZip
Wizard. You can now click the WinZip Classic button if
you would like to examine the contents of your new
archive, or click Next to select another activity within
WinZip, or close the WinZip Wizard window.
WinZip Classic and Wizard: Switching Interfaces
You can easily switch between the WinZip Classic and
WinZip Wizard interfaces with a single mouse click.
Here's how:
In WinZip Classic: to switch to the WinZip Wizard
interface, click the Wizard button at the right end of
the toolbar.
In WinZip Wizard: to switch to the WinZip Classic

interface, click the WinZip Classic button at the
lower left.
Zip and Unzip Files without Leaving Windows Explorer
Using WinZip's Explorer interface, you can access most
of WinZip's functionality directly from My Computer,
Windows Explorer, or the desktop. Here is how to zip and
unzip files directly from Explorer; be sure to see the
WinZip help for more things you can do, including Zip
and E-Mail.
To create an archive: select the file(s) you want to
compress in Windows Explorer, right click, choose
WinZip, and then click Add to Zip file from the
submenu menu that appears.
To extract files from an archive: select the archive in
Windows Explorer, and either:
right click and choose Extract to... from the WinZip
menu, or
right click and drag the archive onto the folder where
you want it extracted, and then choose an extract
option from the WinZip menu.
Contacting Technical Support

The best way to ask questions or report problems is to use
the support form available from the "Support" link on the
WinZip home page (http://www.winzip.com). We try to
respond to all inquiries within one business day.

About Zip Files and Other Archives
What is an Archive?
Archives are files that contain other files. Typically the files in an archive
are compressed. Archives usually have file names ending with ZIP, LZH,
ARJ, or ARC, depending on how they were created. Archives make it
easy to group files and make transporting and copying these files faster.
Typical Uses for Archives:
Most files available on the Internet and on electronic services like
America Online are distributed as archives. Two benefits of using
archives for electronic file distribution are that only one file transfer
operation ("download") is required to obtain all related files, and file
transfer time is minimized because the files in an archive are
compressed.
It is often useful to send a group of related files to an associate.
Rather than distributing individual files it is often easier to distribute
the files as an archive to benefit from the file grouping and
compression.
Some files are important but not used often. To save disk space
simply compress these files into an archive when they are not used,
and decompress them only when needed.
What is a Self-Extracting Zip File?
A self-extracting Zip file is an executable program file (.EXE file) that
includes both a Zip file and software to extract or "unzip" the contents of
the Zip file. Users can extract the contents of a self-extracting Zip file by
simply running it. This is convenient, because the end user does not
need an unzip program (like WinZip®) to extract files from these selfextracting archives.
WinZip Self-Extractor Personal Edition, included with WinZip, creates
Windows self-extracting Zip files.
Archive formats:
Zip files are the most common archive format. Zip files can span
multiple disks, and provide both compression and file grouping.

WinZip does not use external programs to work with Zip files.
TAR, Z, GZ, TAZ, and TGZ files are often found on Unix-based
Internet sites. TAR stands for "Tape ARchive". The TAR format does
not provide compression; it is used only to group files. GZ and Z files
are gzip files. GZ and Z files cannot contain multiple files. TAZ and
TGZ files are TAR files compressed in the gzip format. Since almost
all new archives are created in Zip format, WinZip does not provide
facilities to add to or create files in these formats (however, all other
WinZip functions are supported). WinZip does not use external
programs when working with files in these formats.
File formats such as UUencoded, XXencoded, BinHex, and MIME
are used primarily to transfer binary files by Internet e-mail. If you
encounter one of these files, you can open it and extract its contents
with WinZip. You can UUencode an archive using the UUencode
entry in the WinZip Actions pull-down menu. WinZip does not use
external programs when working with files in these formats.
WinZip also handles most files in the old Microsoft Compress format
(also known as LZEXPAND format). However, there are several
variations on this format, and Microsoft has not released
documentation on these variations. WinZip issues an appropriate
message if you attempt to decompress a file not supported by your
version of Windows. Microsoft Compress files usually end with a
trailing underscore, for example, "commdlg.dl_". Like Z and GZ files,
Microsoft Compress format files contain only one file. This format is
used for many files on the Windows 3.1 distribution disks and many
older Microsoft products. Note that not all files ending with an
underscore are Microsoft Compress format files. WinZip does not
use external programs when working with files in these formats.
The Microsoft CAB (short for Cabinet) format is used by most
Microsoft setup programs, including those used to install Windows.
CAB files provide both file compression and file grouping. You can
use WinZip to open and extract the contents of CAB files. WinZip will
handle most self-extracting CAB files. WinZip does not use external
programs when working with CAB files.
ARC, ARJ, and LZH are older formats that provide both grouping
and compression, like Zip files. Unlike other supported file formats,
WinZip's optional support for these formats requires external

programs that are not included as part of the WinZip distribution
package (see the section titled System Requirements for details).

Brief Tutorial - Contents
Click on each tutorial topic, in sequence, to learn all about WinZip®:
1.
Introducing
WinZip

2. The WinZip
3. Opening
Window
Archives

4. Viewing
Files

5. Extracting
Files

6. Creating
New Archives

7. Adding
Files

8. Deleting
Files

9. Custom
Configurations

10.
Additional
Features
This brief overview tutorial introduces you to each of the main
WinZip concepts and features to get you working productively as
quickly as possible.
Note: if you prefer a strict "learning by doing" approach, you may prefer
the WinZip Tutor, which uses a "step by step" approach to introduce new
users to zipping and unzipping.
You will get the most benefit from these lessons if you change the size of
this Help window to leave enough room on the screen to have WinZip
opened at the same time. As each screen describes an operation, you
may want to try certain things with WinZip to gain an even better
understanding. You can move through the tutorial as quickly or as slowly
as you like. If you ever have any questions when you are using WinZip,
remember that context-sensitive help is available by pressing the F1 key.
As you explore this tutorial, you will find highlighted text that will take you
to additional information about a particular topic. If you elect to take the
detour, you can click on the Back button at the top of this window to
return to where you left off in the Brief Tutorial.
Important: WinZip offers many convenient ways to work with archives.
This tutorial approaches the topic using the main WinZip window as its
base of operations. This is not the only way to access WinZip's

convenient features. For example, you can use WinZip to zip and unzip
files without leaving My Computer or Windows Explorer. Once you are
comfortable with the basic operations described in this tutorial, be sure to
read Using the Explorer Interface, Using Drag and Drop and Hints and
Tips.
Next>

The WinZip Tutor
The WinZip® Tutor leads you through the steps required to create a new
Zip file and to extract files from a Zip file.
Click here to open the WinZip Tutor in a separate window.

Downloading and Processing Files
with WinZip
WinZip® has special features that make it simple and
convenient to download and process compressed files
from the Internet and online services like America
Online.
Click to choose the method about which you would like
to learn more:
Downloading From The Internet
Downloading From America Online and Other Online
Services

Wizard Interface
The WinZip® Wizard is an optional interface that provides a familiar
"wizard" interface for the process of zipping, unzipping, and installing
software distributed in Zip files. The WinZip Wizard is not targeted at
experienced users, but is ideal for users who are just getting started with
Zip files or only need basic Zip file services.
The WinZip Wizard is documented separately.

UUencoded, XXencoded, BinHex, and
MIME files
WinZip® can open and extract UUencoded, XXencoded, BinHex, and
MIME files (base64, plain/text, and quoted-printable), and can UUencode
files. This section explains the need for these features and abilities,
includes instructions for using them, and shows how they can bring a
whole new dimension to your e-mail operations.
Use the <Back and Next> links or the index below to page through this
tutorial and learn about using these important and useful WinZip features.
These instructions assume that you understand basic Windows and
WinZip operations, and the basic use of your e-mail program.
UUencoded, XXencoded, BinHex, and MIME files
Sending Files using Internet Mail
The Why behind UUencoding and Other Schemes
Receiving and Preparing Files for Decoding
Decoding Files using WinZip
UUencoding a File using WinZip
Mailing a UUencoded File
Hints, Tips, & Troubleshooting
<Back Next>

Using WinZip: Introduction
If you've used WinZip® for a while, or if you've looked at any of the
overview or Quick Start information, you know that there are three basic
ways to use WinZip.
You can use the WinZip Wizard. This is ideal if you just want to do
quick zipping and unzipping and you don't want to worry about the
details of archives. (The WinZip Wizard is documented separately.)
You can use WinZip in Classic mode, that is, you can open WinZip
and use its menus and toolbars to perform all of your archive
operations. This mode gives you complete access to all WinZip
functionality.
You can use WinZip's Windows integration features, which include
drag and drop features and WinZip's Windows Explorer interface.
These features allow you to perform most of the commonly needed
archive operations right from your desktop, Windows Explorer, or My
Computer; in most cases, you don't need to open WinZip at all.
Which technique you use depends on your preferences and your
archiving needs. You may use more than one. A little experimentation
should find what's right for you.
This section of the WinZip documentation describes the entire WinZip
menu system and WinZip's Windows integration features.
Section contents
Using the WinZip Menus
Using the Explorer Interface
Using Drag and Drop
WinZip Self Extractor Personal Edition

Menu Tree
File Menu
New Archive

Working with whole archives
Open a new archive

Open Archive

Open an existing archive

Favorite Zip Folders

Open the Favorite Zip Folders dialog

Close Archive

Close the open archive

Manage Archive

Move, copy, rename, or delete the open
archive

Mail Archive

E-mail the open archive

Print

Print a listing of the open archive's
contents

Properties

Display the open archive's properties

Create Shortcut

Add a shortcut to the open archive to the
desktop

Wizard

Switch to the Wizard interface

Recent (History)

Re-opens recently used archives

Exit

Close WinZip

Add

Performing tasks with the open
archive
Add files to the open archive

Delete

Delete files from the open archive

Extract

Extract files from the open archive

View

View files in the open archive

Select All

Select all files in the open archive

Invert Selection

Reverse selected and unselected file
status in the open archive

Actions Menu

Virus Scan

Run a virus scan program against

archive contents
Make .Exe File

Create a self-extracting archive

UUencode

UUencode the open archive

Split

Split a Zip file into multiple parts of a
specified size

Encrypt

Encrypt all files in a Zip file

Test

Test integrity of the open archive

Comment

View, add, edit, or delete a Zip file
comment

CheckOut

Examine and/or run programs in the
open archive

Install

Install the software contained in the open
archive

Options Menu
Configuration

Configuring WinZip
Change WinZip settings

Sort

Specify sort order for list of files in
archive

Reuse WinZip
Windows

Don't open new windows when WinZip is
started

Save Settings on Exit

Control whether options are saved when
WinZip is closed

Save Settings Now

Save configuration settings immediately

Set Installation
Defaults

Set many options to original installation
defaults

View Last Output

View output from the last command
issued by WinZip

Help Menu
Help Contents and
Index

Getting help and information
Start Help and display the WinZip help
file contents and index

Brief Tutorial

Display brief WinZip tutorial

Frequently Asked
Questions

Open this Help File to that topic

Hints and Tips

Display hints and tips

Tip of the Day

Open the Tip of the Day window

Enter Registration
Code

Access the dialog for entering
registration information

License Agreement

Display license agreement

Ordering Information

Display order form

WinZip Home Page

Start your default browser and visit the
WinZip web site

About WinZip

Display copyright notice and version
information

The File Menu
Use the File menu for actions that affect entire archives or WinZip® itself.
The menu contains the following entries:
New Archive creates new archives.
Open Archive opens existing archives.
Favorite Zip Folders displays a list of Zip files in your favorite Zip
folders.
Close Archive closes the currently open archive. This menu entry is
included primarily for completeness, since the New and Open menu
entries automatically close the open archive, as does closing WinZip.
The Manage Archive submenu allows you to move, copy, rename,
and delete the currently open archive.
Mail Archive, available only if your system is configured to use
MAPI (the standard Mail Application Program Interface), makes it
easy to mail an archive.
Print prints a listing of the files in the archive.
Properties displays a dialog box showing the properties of the
currently open archive.
Create Shortcut creates a shortcut to the open archive on your
desktop.
Wizard activates the WinZip Wizard. (The WinZip Wizard is
documented separately.)
Recently opened archives can be re-opened directly from the
Recent (History) submenu.
Exit closes WinZip.
Note that the File menu does not contain the common Save or Save As
menu entries. Save is not necessary because WinZip automatically
saves changes to your archives as you make them. Copy (in the
Manage Archive submenu) performs a similar action to Save As: it
creates a copy of your archive using a name that you specify. However,
the original archive will remain open.

Creating a New Archive
To create a new archive, click New Archive from the WinZip® File pulldown menu. This activates the New Archive dialog box. Type the name of
the archive you want to create. Do not enter the names of the files you
want to compress. This dialog box works almost like the standard
Windows Open dialog box. You can use the Save in combo box to
choose the drive and folder where the archive will be created. For
example, to create an archive on your floppy drive, select "3½ Floppy" in
the Save in combo box. The names of any existing archives on the
selected drive and folder will be listed to help you choose a name that is
not already in use.
Check the Add dialog check box in the New Archive dialog box if you
would like to automatically activate the Add dialog box after the new
archive is opened.
To list self-extracting archives in the New and Open dialog boxes, choose
the "Archives and .exe files" entry in the Files of type combo box. Note:
When self-extracting archives are listed in the open dialog box, all EXE
files in the selected folder will be listed, even if they are not self-extracting
archives. WinZip is not able to check whether a file is a self-extracting
archive until it is opened.
See File Type Filters for details on the File Type filters in the Files of
type combo box.

Opening an Existing Archive
To open an existing archive, select Open Archive from the WinZip® File
pull-down menu. This activates the standard Open Archive dialog box.
Then select the archive you want to open in the Open dialog box.
Opening an archive is just like opening a document in Write or a
spreadsheet in Excel; the only difference is that you open an archive
instead of a document or spreadsheet. Use the combo box at the top to
select the appropriate folder and click on the archive in the list below.
Press the Open button when you have made your selection.
You can also click the Favorites button to see a list of files in your
Favorite Zip Folders. To open an archive from this list, just double click its
name.
To list self-extracting archives in the New and Open dialog boxes, select
the "Archives and .exe files" entry in the Files of type combo box. Note:
when self-extracting archives are listed in the open dialog box, all EXE
files in the selected folder will be listed, even if they are not self-extracting
archives. WinZip is not able to check whether a file is a self-extracting
archive until it is opened.
See the section File Type Filters for details on the File Type filters in the
Files of type combo box.

Favorite Zip Folders
About Favorite Zip Folders
The "Favorite Zip Folders" feature organizes Zip files into one convenient
list that is sorted by date, making it easier to locate all Zip files,
regardless of where they came from or where they are stored. Unlike the
standard Open Archive dialog box, the Favorite Zip Folders dialog box
treats the contents of multiple folders as though they were one folder.
Using the Favorite Zip Folders Dialog Box
Click the Favorites button on the toolbar or select Favorite Zip Folders
from the File pull-down menu to activate this facility. When you open the
Favorite Zip Files dialog box, all Zip files in your Favorite Zip Folders are
listed by date, with the most recently modified files listed first.
The first time you activate the Favorite Zip Folders dialog box, it will
automatically search your computer for folders containing or likely to
contain Zip files. You can easily add and remove folders from your list of
"Favorite Zip Folders" using the Options button.
To open a Zip file, select it and click Open, or simply double click on the
Zip file.
Click Search to search for Zip files in other folders. The results of your
search will temporarily replace the list of files in the Favorite Zip Folders
dialog box.
To add folders to your Favorite Zip Folders
To add a folder to the list of Favorite Zip Folders, click the Options button
in the Favorite Zip Folders dialog and then click Add a folder to list. In
the resulting folder-browsing dialog, select the desired folder and click
OK.
Here's another way to add folders to the list: click the Search button in
the Favorite Zip Folders dialog box, select the type of search you want,
and click OK. When the search completes, the list of files in the Favorite
Zip Folders dialog is temporarily replaced by the search results; select a
Zip file and click Open, or double click the Zip file. If the Zip file resides in
a folder that is not currently in your Favorite Zip Folder list, then by
default, WinZip® will ask if you would like to add the folder to your
Favorite Zip Folders.

WinZip can be configured to handle the folder in one of three ways: it can
automatically add the folder to your Favorite Zip Folders, it can ask if you
want to add the folder to the Favorite Zip Folders (as described above),
or it can skip adding the folder to the Favorite Zip Folders. You can
change this section by clicking Options in the Favorite Zip Folders dialog
and then clicking the Other Zip Folders tab.
This setting should be chosen prior to running a search and only applies
when opening a Zip file from search results. In particular, note that setting
the option to "Add the folder to Favorite Zip Folders automatically" does
not automatically add the folder of every Zip file you open to your
Favorite Zip Folders.

Viewing Archive Properties
The Properties menu entry in the WinZip® File menu displays a dialog
box with the path, file's name, actual archive size (in bytes), number of
files in the archive, average compression ratio, and the date and time that
the archive was last updated. The Details button displays extensive
internal information about the archive and the files contained within it.

Archive Management
The Move, Copy, Rename, and Delete entries in the Manage Archive
submenu of the File menu facilitate archive management.
Move moves the open archive to another folder or disk. The Move dialog
box is displayed so you can choose the destination for the move
operation.
Copy copies the open archive to another folder or disk. The Copy dialog
box is displayed so you can choose the destination for the copy
operation.
Rename gives you an opportunity to change the file name of the open
archive. The Rename dialog box lets you change the open archive's file
name but not the filename extension (file type). Simply type the new file
name and press the OK button.
Delete deletes the open archive. A confirmation dialog is displayed to
avoid accidental deletion. If you choose to continue the archive is closed
and deleted.

Printing a List of the Files in an Archive
To print the list of files shown in the main WinZip® window, choose Print
from the File pull-down menu. The columns shown in the WinZip window
will be printed. The standard Print dialog box lets you choose which
printer should be used, how many copies are printed, whether to print in
landscape or portrait mode, etc.
You can also print a listing of the files in an archive from a My Computer
or Windows Explorer window. Simply right click the archive and choose
Print from the context menu.
Hint: you can change the content of the printed file listing by changing the
columns that are shown in the WinZip window. To do this, cancel the print
request, right click any column header and choose the columns you want,
and click Print again.
How to Print a List of the Files in an Archive to a Text File on Disk
You can also use the Print item on the File pull-down menu to save the
list of files in an archive in a text file on disk. However, you first may need
to set up a "printer port" to do this.
To set up such a printer port, perform the following steps:
1. From the Start menu, click Settings, then Printers.
2. Double click Add Printer. The Add Printer Wizard will start. Click
Next to advance to the next panel.
3. Check the Local printer option button, and click Next. Windows
may display a small window and progress meter while it builds a
printer information database. If you see such a window, wait until the
process completes.
4. You should now see a panel with two lists: one of printer
manufacturers and another of printers. Scroll down the list of
Manufacturers until you see the item Generic, and then click this
item. The Printers list should automatically change to have the entry
"Generic/Text Only". Click Next.
5. Windows then may need to load a driver from files already on your
hard disk or from your Windows distribution CD-ROM or diskettes.
Follow the instructions for doing so. If instead you see a panel that
says "A driver is already installed for this printer ...", check the Keep

6.
7.

8.

9.

10.

existing driver option button, and click Next.
In the next panel, select "File" from the Available ports window, and
click Next.
In the next panel, you can use the Windows-generated name for the
printer, or you can enter a more descriptive name such as "Print to
Disk File" in the Printer name field, and then click Next.
In the next panel, check the option button labeled Yes in response to
the question "Would you like to print a test page?", and then click
Finish.
Windows will prepare a test page, and then display a "Print To File"
dialog. You can use this dialog to specify the file and folder into
which the print output should go.
After printing is complete, there should be a file containing the print
output in the location you specified. Using a utility such as Notepad,
check the output to make sure it looks all right. Windows will ask you
if the test page printed correctly. Assuming it did so, click Yes.

From now on, when you print to your new "Print to Disk File" printer, the
output will go to a plain text file on your disk, and you can then use a
utility such as Notepad to view and edit the output.
In WinZip, to save an archive listing to a text file, select Print from
WinZip's File menu. When the Print dialog appears, click the arrow on
the Name drop-down list, select your "Print to Disk File" printer, and click
OK. Windows will ask for a file name for your text file and then WinZip
will direct the listing to the text file.
Windows tip: you can use your new Print to Disk File printer to send
print output to disk from almost any Windows application, as long as the
application allows you to select a printer when you produce print output.
Just select your "Print to Disk File" printer as the destination for the
output.

Using WinZip to E-Mail Archives
WinZip® includes three features that make it easy to e-mail compressed
files to others via the Internet:
The Zip and E-Mail feature provides "one click" compression and
mailing of files and folders from My Computer or Windows Explorer.
It quickly compresses selected files and folders into a temporary Zip
file, creates an e-mail message, and attaches the Zip file to the
message. You can then address the message, add any desired text,
and send the e-mail as you usually would. WinZip automatically
deletes the temporary Zip file when it is no longer needed.
To use the feature, simply select the desired files or folders in My
Computer or Windows Explorer, click the right mouse button, and
choose Zip and E-Mail filename.zip from the WinZip shortcut menu.
The filename shows the name that WinZip will use for the Zip file it
creates.
The Zip and E-Mail Plus feature is similar to Zip and E-Mail but
allows you to specify the name of the Zip file and add encryption if
desired. To use the feature, simply select the desired files or folders
in My Computer or Windows Explorer, click the right mouse button,
and choose Zip and E-Mail Plus from the WinZip shortcut menu.
Note that if you find that you are using either Zip and E-Mail or Zip
and E-Mail Plus all the time, you can remove the one you don't use
from the context menu using the Explorer Enhancements tab of
WinZip's Configuration dialog.
You can e-mail the currently open archive by choosing Mail Archive
from the File menu. WinZip will create a new e-mail message and
attach the open archive to it. You can then address the message,
add any desired text, and send the e-mail as you usually would.
Like the Windows "Send To Mail Recipient" feature, these WinZip e-mail
features use a protocol called Simple MAPI to "talk" to your e-mail
program. MAPI, which is provided by your e-mail software and not by
Windows itself, allows Windows and application programs to instruct your
e-mail program to create new mail messages, add attachments, etc.
WinZip's e-mail features require that you have a MAPI-compatible e-mail

program installed and correctly configured (just as the Windows Send to
Mail Recipient feature does).
Examples of MAPI-compatible e-mail programs are Outlook, Outlook
Express, Eudora, and AOL 7.0 and 8.0.
AOL versions 4.0 - 6.0 do not support Simple MAPI. Therefore, neither
Windows' Send To Mail Recipient nor WinZip's e-mail features can be
used with these AOL versions.
Compressing attachments from within your e-mail program
There is another technique you can use to compress attachments while
composing messages in your e-mail program. This technique does not
require that your e-mail program support the MAPI interface that WinZip
uses for the above features; it works with most e-mail programs that use
the standard Windows "Open File" dialog box to attach files. Here is the
technique:
1. In your e-mail program, open the dialog box you normally use to
attach files to your e-mail messages.
2. Using the standard Open File dialog box, locate the file or folder you
wish to attach.
3. Position the mouse pointer over the file or folder name in the dialog
box, then click the right mouse button and choose Add to
filename.zip from the shortcut menu (note: the filename shown in
the menu entry will be the name of the file you selected). This will
create a Zip file called "filename.zip".
4. Still in the Open File dialog box, click once on filename.zip (the zip
created in the previous step). This file will normally be at the end of
the current directory listing.
5. Click the appropriate button to attach the Zip file (this is typically
labeled Open, Attach, or Insert).
Note: this technique has been tested with current versions of the most
popular e-mail programs (such as Outlook and Eudora). We can't
promise that it will work with all e-mail programs or with future versions of
the programs we have tested.
Related topic
Why aren't WinZip's e-mail features working for me?

The Actions Menu
Use the Actions menu for commands that affect the currently open
archive or selected files within the archive. The menu contains the
following entries:
Add adds new files to the archive or updates files that are already in
the archive.
Delete removes files from the archive.
Extract uncompresses files in the archive and saves the
uncompressed files to disk.
View allows you to look at the contents of files in the archive.
Select All selects all of the files in the archive.
Invert Selection selects all files that are currently unselected and
deselects all files that are currently selected.
Virus Scan uses your external virus scanner to check files in the
archive for viruses.
Make .Exe File converts the archive into a self-extracting archive.
UUEncode encodes the archive so that it can be sent via mail
systems that do not support binary e-mail.
Split splits the archive into multiple smaller parts of a size that you
specify.
Encrypt
allows you to encrypt or re-encrypt all files in the Zip file. This action
is available for Zip files only.
Test performs internal testing to make sure that the archive is not
damaged.
Comment allows you to add or edit the Zip file comment.
CheckOut makes it easy for you to examine archive contents by
extracting files to a temporary folder and setting up a Windows
Explorer window to display the files.
Install helps you to install software from archives that contain SETUP
or INSTALL programs.

Adding Files to an Archive
New users: for introductory information, please see the section Brief
Tutorial - Adding Files to an Archive.
This section describes the Add dialog box. There are other ways to add
files to an archive:
The drag and drop interface.
The Explorer interface.
The Add dialog box
To open the Add dialog box, click on the Add button on the toolbar or
select the Add entry from the Actions pull-down menu to bring up the
Add dialog box.
You can select the files you want to add in several ways:
Click on the desired files in the list near the top of the Add dialog
box. You can select multiple files using normal Windows file
selection conventions (for example, hold down the Shift key while
clicking to select multiple files). Then press the Add button.
Type the name(s) of the files you want to add. If you specify multiple
filenames, each filename must be enclosed in double quotes. Then
press the Add button.
To add files with wildcards (for example, "*.doc" to add all files with
an extension of .doc), type the filename with wildcards in the File
name edit field, then press the Add with wildcards button.
Standard wildcards are accepted.
See Add Dialog Box Options for a description of the options available in
this dialog box.
Compatibility note
Beginning with version 9.0, WinZip® supports the 64-bit extensions to the
Zip file format. The extended format lets you store all the data you need
in Zip files of virtually unlimited size.
The original Zip file format limited the number of member files in a Zip file
to 65,535, and the maximum size of both the Zip file itself and any

member file to 4 gigabytes. For all practical purposes, the 64-bit
extended format eliminates all these restrictions: member file size, Zip file
size, and number of member files are limited only by your system's
resources.
WinZip remains fully compatible with the original file format and uses the
original format whenever possible. WinZip uses the 64-bit extended
format only when the limits of the original format are exceeded.
You should be aware, however, that very large Zip files compressed with
WinZip 9.0 are not compatible with earlier versions of WinZip and may
not be compatible with other Zip file utilities.

Deleting Files from an Archive
There are two ways to delete files from an archive:
Select entries in the main WinZip® window, then choose Delete from
the Actions menu. You can then delete the selected file, all files in
the archive, or files specified by name (standard Windows wildcards
are accepted, so you could use "*.doc" to delete all .doc files).
Select entries in the main WinZip window, right click any selected
file, and click Delete from the shortcut menu. This displays the same
Delete dialog described above.
Notes:
These operations cannot be undone.
To delete an entire archive, choose Delete from the Actions menu to
bring up the Delete dialog. Then choose the All files/folders in archive
option and click Delete. Alternatively, you can choose Delete from the
Manage Archive submenu of the File menu.

Extracting files from an archive
New users: For introductory information, please see the section Brief
Tutorial - Extracting Files.
This section describes the Extract dialog box. There are other ways to
extract files from an archive:
Using the drag and drop interface.
Directly from My Computer or Windows Explorer, as described in the
section Using the Explorer Interface.
If a Zip file contains a "setup" or "install" program, you can use the
Install Feature to automatically extract the files, run the installation
program, and clean up temporary files.
The Extract dialog box
Use the Extract button on the toolbar or select Extract from the Actions
menu to display the Extract dialog box. Use the Extract dialog box to
extract or "unzip" files from the open archive to your disk.
WinZip® extracts files from the archive to the folder specified in the
Extract to field. You can specify this folder in one of four ways:
Select a folder and drive in the Folders/drives list boxes.
Type a folder name in the Extract to field.
Pull down the Extract to combo box and select a folder from the list
of previous Extract to folders.
Click the "new folder" button

and create a folder.

The Extract dialog box provides the following options:
The Selected files/folders option button instructs WinZip to extract
only files that are selected in the main WinZip window. You can use
conventional file selection methods to choose files. This option is
disabled if no files are selected.
The All files/folders in archive option button instructs WinZip to
extract all files from the archive.
The Files option button and edit field allow you to specify which files

are extracted using filenames (standard Windows wildcards are
accepted, so you could use "*.doc" to extract all .doc files)
The Overwrite existing files checkbox determines whether you are
prompted before existing files are overwritten with files from the
archive.
The Skip older files checkbox determines whether WinZip skips
(does not extract) existing files when the date/time stamps of the file
in the archive is older than the file on disk.
The Use folder names checkbox determines whether WinZip will
use folder names (also known as path names) stored in the archive.
You will probably want to check this option for most extract
operations. If this option is checked, any folder names stored in the
archive will be appended to the Extract to folder when appropriate.
If this option is not checked all files will be extracted to the same
folder, regardless of any folder names in the archive.
For example, assuming the Extract to folder is "c:\temp", the file
"mydir\filename" will be extracted to the folder "c:\temp\mydir" if the
Use folder names option is checked, or the folder "c:\temp" if the
option is not checked.
If the Open Explorer window checkbox is checked, a Windows
Explorer window is opened after the extract operation is complete.
The window will show the folder to which the files were extracted.
This checkbox is not present if you are extracting from multiple Zip
files directly from Windows Explorer using the WinZip context menu.
If you extract from multiple Zip files using WinZip's Extract to...
Windows Explorer context menu entry, there will be a checkbox
labeled Use Zip file names for folders. If this checkbox is checked,
WinZip will create a folder for each Zip file under the Extract to
folder; the folders will be named with the base names of the Zip files.
For example, if the Extract to folder is "c:\temp", WinZip will extract
files from "NewDocs.zip" to "c:\temp\NewDocs". If this checkbox is
not checked, files will be extracted to the Extract to folder. In most
cases, you will probably want to leave this option checked when you
extract from multiple Zip files.
The "new folder" button
activates the Create Folder dialog box.
Note that you can extract files and create a folder without this dialog

box: simply type the name of the new folder in the Extract to field of
the Extract dialog box and press the Extract button.
Note: You can change the default Extract to folder using the Folders tab
of the Configuration dialog.

Viewing Files in an Archive
You can view files in an archive in several ways:
With the View button in the toolbar or the View entry in the Actions
pull-down menu. This activates the View Dialog Box.
With the drag and drop interface.
With the features described in the section titled CheckOut Feature.
Most files can be viewed by double clicking on the file name in the
main window's list box, as described in the section titled Double
Clicking.

Select All and Invert Selection
The Select All entry in the Actions menu selects all the files in the main
window's list box. Invert Selection deselects the currently selected files
and selects the currently unselected files. Selected files can then be
easily deleted, extracted, or viewed.

Virus Scan
Use the Virus Scan entry in the Actions pull-down menu to determine
whether files in the archive contain viruses. To use this feature a virus
scanner must be configured, as described in the section titled Virus
Scanner Configuration. Note that the CheckOut feature also provides
optional virus scanning.
The Virus Scan operation performs the following actions:
1.
2.
3.
4.

Creates a temporary folder
Extracts all files in the current Zip file to the temporary folder
Runs the virus scanner against files in the temporary folder
Deletes all files in the temporary folder and removes the temporary
folder
5. Displays the results of the scan operation in the View window

Creating a Self-Extracting Archive
Use the Make .Exe File entry in the Actions menu to convert the open
archive to a self-extracting archive. Self-extracting archives have an
extension of .EXE, and can be run as commands. When a self-extracting
archive is run, the files in the archive are automatically extracted. This is
convenient, because the end user does not need an unzip program (like
WinZip®) to extract files from these self-extracting archives.
When working with a Zip file, this operation normally runs WinZip SelfExtractor Personal Edition, but you can also configure WinZip to use
another program. When working with an LZH file, this operation runs the
external LHA program with the s option. When working with an ARJ file,
this operation runs the external ARJ program with the y option. For
details on configuring WinZip to work with external programs, see the
sections titled System Requirements and Installing Optional External
Programs.
Notes
If you are using WinZip Self-Extractor Personal Edition or WinZip
Self-Extractor, you should be aware of certain restrictions. You
cannot create self-extracting Zip files using either of these products if
the original Zip file
contains any files encrypted using AES encryption, or
contains any files that were compressed using the enhanced
deflate compression method, or
uses the 64-bit Zip file format extensions. These extensions are
used if there are more than 65,535 files in the Zip file or if the
Zip file itself or any file contained in the Zip file exceeds 4GB in
size.
If the first file in a self-extracting LZH file is named "!" (i.e. an
exclamation mark is the only character in the filename) this file will
be displayed when the self-extracting executable is run. To ensure
that this file is the first file in the archive, first create a new LZH file,
then add the "!" file (do not add other files in this step), and finally
add the remaining files.

UUencoding an Archive
Use the UUencode entry in the Actions pull-down menu to UUencode
the open archive. The UUencoded file can be sent across mail systems
that do not support binary e-mail. For further details on UUencoded,
XXencoded, BinHex, and MIME files, refer to that section of this help file.

Splitting Zip files
WinZip® makes it easy to create Zip files that are split into smaller pieces
of a size that you specify. There are several reasons why you might want
to do this, such as:
To overcome e-mail size limits. Some e-mail systems limit the size of
attachments; if you want to e-mail a large Zip file that exceeds your
limit, you can split it into smaller parts and e-mail them separately.
As an alternative to spanned Zip files when you want to make
multiple copies of the disk set.
As an alternative to spanned Zip files when you want to make the
disk contents as a separate step from making the disks themselves.
To assist with large downloads. Some users may have difficulty
downloading very large Zip files from web sites, FTP sites, etc. You
can use the split Zip feature to break large files into smaller pieces
that can be downloaded separately.
To split a Zip file into smaller pieces:
1. Open or create the Zip file.
2. Choose Split from the Actions menu.
3. Specify the name to be used for the split Zip file. The name must be
different from the name of the open Zip file.
4. Specify the size to be used for the individual parts. You can choose
from common sizes using the Part size drop-down list or you can
specify your own size. To specify your own size, choose "Other size"
in the drop-down list and type the desired size in the Other size
field. You can specify the size in bytes, kilobytes (KB), or megabytes
(MB); indicate which you're using by clicking the appropriate radio
button. The minimum size allowed is 65,536 bytes (64KB).
5. Click OK to create the split Zip file.
Notes
Each of the segments of the split Zip file will have a different
extension. WinZip creates files with names like Data.Z01, Data.Z02,

and so on, except for the very last segment of the new Zip file. The
last segment will always have the .zip extension (e.g., Data.zip).
To open the split Zip file, open the file with the .zip extension. Don't
try to open any of the files with the numbered extensions; WinZip
won't recognize them as Zip files.
Once the split Zip file has been opened, you can work with it much
as you would work with a regular Zip file, except you can't add any
new files or remove existing files. Some operations such as creating
self-extracting Zip files and editing comments are also disabled for
split Zip files.
The sizes listed as "1.2MB," "1.44MB," and "2.88MB" are
approximate. The segments of the split Zip file are sized
appropriately to fit on media of the specified size. You cannot,
however, use decimal points when specifying sizes in the Other size
field.
The split Zip file format is an extension of the Zip 2.0 specification.
Therefore, some Zip utility programs may not be able to open split
Zip files. Please see Split Zip file compatibility information for more
details.
See also
Multiple disk spanning

Encrypting a Zip File
Please read about encryption before using this feature.
To encrypt or re-encrypt all of the files in an open Zip
file, choose Encrypt from the Actions menu. WinZip®
will ask for a password and encryption method and then
encrypt all files currently in the Zip file.
Any files in the Zip file that are already encrypted must
first be decrypted before they are re-encrypted using the
method and password you specified. WinZip will first try
to decrypt the files using the current encryption
password; if a file cannot be decrypted with this
password, WinZip will ask you for the correct decryption
password. If you are unable to supply the correct
password, the file will be skipped, and it will remain
unchanged in the Zip file.
Notes
It is more efficient to encrypt files while they are
being added to the Zip file than to encrypt them after
they have been added. To encrypt files while adding,
simply check the Encrypt added files checkbox in
the Add dialog.

You can also perform this action from the My
Computer or Windows Explorer shortcut menu.
Simply right click the Zip file and choose Encrypt
from the WinZip shortcut menu.
This feature is available only for Zip files.
See also
About Encryption
Using Encryption

Testing an Archive
Use the Test entry in the Actions pull-down menu to test the integrity of
the open archive. A dialog box is displayed with the results of the test
operation.
Press the Esc key during the Test operation to terminate the integrity test.

Zip file comments
Use the Comment entry in the Actions pull-down menu to activate the
Comment dialog box. This feature is available for Zip files only.
A comment is optional text information that is embedded in a Zip file. It
can be viewed, created, edited, or deleted using the Comment dialog
box. Simply type in your text or use any common Windows cut, copy, or
paste method.
Use the Close button to close this dialog.
Click Save to save any comment or edits you've made.
Clear erases the comment text. Clicking Save after Clear removes the
comment from the Zip file.
Click Font to specify a new display font. It does not affect the comment in
the Zip file, but is retained as your preference for viewing comments in
future sessions.
Zip file comments are limited in length. If you have recent versions of the
Windows "Rich Edit" control installed, the limit is about 64,000
characters; otherwise, the limit is about 48,000 characters. For greatest
compatibility with other users' systems and with other Zip file utilities, we
recommend limiting comments to 48,000 characters.
Tip: if you would like WinZip® to automatically display comments when
opening Zip files that contain comments, choose Configuration from the
Options menu, click the Miscellaneous tab, and check the box labeled
Show comments when opening Zip files.

CheckOut Feature
The CheckOut feature makes it easy to examine and/or run files in an
archive. It creates a temporary folder, extracts all files from the archive
into the folder, creates entries in the Programs menu for the extracted
items, and opens a My Computer-style window showing shortcuts to the
files in the folder. Double click any item in the window to perform the
action normally associated with the document or program (associations
are described in the section titled Windows Associations). WinZip® will
optionally close the window and delete the temporary folder (and the
extracted files) when you close the archive or close WinZip.
CheckOut Dialog Box
Use the CheckOut toolbar button or the CheckOut entry in the Actions
pull-down menu to activate the CheckOut dialog box. This dialog box lets
you configure these aspects of the operation:
Use the Folder edit field to specify the temporary CheckOut folder
name. The folder will be created if it does not already exist. The
suggested folder depends on the setting of the CheckOut base
folder in the Folders tab of the Configuration dialog.
Use the Group name edit field to specify the name to use for the
CheckOut window.
Use the Maximum icons edit field to specify the maximum number
of items to be placed in the CheckOut window.
The Create icons for programs and documents only check box
lets you control whether WinZip creates icons for all files in the
archive or only for the specified files. When this option is selected,
icons are created for executable files and files with associations.
Icons are also created for any files with names starting with "read"
(in order to catch files with names like "readme.1st", "read.me", etc.).
The Run virus scanner check box lets you specify whether WinZip
will run a virus scanner on the files in the archive. This option is
disabled unless a virus scan utility is installed in the Program
Locations tab of the Configuration dialog.
Operations performed by the CheckOut feature:

When you click on the OK button in the CheckOut dialog box, WinZip
performs the following operations:
1. If the specified folder does not already exist, WinZip will create it. If it
already exists and contains files, WinZip will delete the files (after
asking your permission, of course). This ensures that the folder will
contain only files from the current archive.
2. WinZip extracts files in the current archive to the specified folder.
3. If the Run virus scanner check box is selected, your virus scanner
is run against all files in the specified folder. If the virus scan utility
returns a non-zero error level, the CheckOut operation is cancelled
and messages from the scanner are displayed.
4. WinZip creates a second folder, located in \Windows\Start
Menu\Programs. If a folder with the specified name already exists,
WinZip will delete it after getting your permission. This ensures that
the folder will contain only icons for files in the current archive.
5. In the second folder, WinZip creates shortcuts to the extracted files.
It then opens a My Computer-style window displaying icons for the
extracted files. These items will also appear in the Programs menu,
accessible from the Start button.
Using the CheckOut window:
The window created by CheckOut is a My Computer-style view of the
checkout folder and works like any similar window. WinZip creates
shortcuts in this folder for each extracted file so that you can use them as
follows:
If a file is executable, double clicking on the icon runs the program.
If a file has an association, double clicking on the icon loads the file
in the associated program so you can view the file.
Otherwise, double clicking on the icon loads the file in the WinZip
Default association program specified in the Program Locations
tab of the Configuration dialog.

Install Feature
WinZip's® Install feature makes it easy to install software distributed in
archives. The Install feature is available if an archive contains an "install"
or "setup" program, a desktop theme, or a screen saver. This help topic
describes the software installer. The Desktop Theme Installer and the
Screen Saver Installer operate in a slightly different way and have their
own help topics.
Caution: you should be careful when installing any kind of
software. Be certain that you trust the source of this Zip file. Do
not install anything contained in a Zip file that was attached to
an unexpected or suspicious e-mail message. See Security
Hints and Tips for additional information.
The software Install feature performs these functions:
1. Extracts all the files to a temporary folder,
2. Runs the Setup program.
3. Deletes the temporary installation folder and files.
The Install Dialog Box
Click the Install button on the toolbar or select Install from the Actions
menu command to open the Install dialog box.
Use the Minimize during install checkbox to control whether WinZip will
be minimized while running the install program.
Click the OK button to begin the installation.
Notes:
Self-extracting Windows archives are treated as a special case. If you
have opened a self-extracting Windows archive, the Install feature will
simply run the self-extractor instead of extracting all the files to a
temporary folder, running the setup program, and deleting the temporary
installation folder and files.
If the Install button is not displayed, but you recognize an installable file,
you can use the CheckOut Feature to try to install the software in the
archive.

The Options Menu
The Options menu allows you to set many WinZip® options. The menu
entries are:
Configuration activates the main Configuration dialog box. This
dialog box controls most WinZip settings.
Sort lets you specify whether the list of files in the archive is sorted
by name, type, date, size, compression ratio, packed size, CRC, file
attributes, path, or whether the original archive order should be used.
Note: You can also change the sort order by clicking on the
appropriate portion of the main list box header. For example, click on
the word "Date" in the header to sort by date. To reverse the sort
order, click it again.
Reuse WinZip Windows determines whether a new window is
opened when you start WinZip by double clicking in My Computer,
Windows Explorer, or the desktop. When this entry is checked, an
existing WinZip window is used. When this entry is not checked, a
new WinZip window is created. One advantage to reusing WinZip
windows is that double clicking acts the same as drag and drop, and
you never accidentally wind up with multiple WinZip windows.
Save Settings on Exit determines whether your currently chosen
configuration options are automatically saved when WinZip is closed.
Save Settings Now saves selected options immediately.
Set Installation Defaults sets many configuration options and folder
names to the original installation defaults.
View Last Output displays the results of the last WinZip operation.

Configuration Dialog Box
Choose Configuration from the Options menu to activate the
Configuration dialog box. This dialog box contains tabs that control most
WinZip® settings. Click on any tab title for further information on its
content.
The View tab controls the appearance of the main WinZip window.
The Toolbar tab lets you customize the look and content of your
WinZip toolbar.
The Folders tab offers choices for start-up, extract, add, working,
checkout, and temporary folders.
The System tab provides options for accessing WinZip through My
Computer and Windows Explorer.
The Explorer Enhancements tab provides options for configuring
WinZip's Windows Explorer enhancements.
The Program Locations tab controls the default viewer, virus
scanner, and optional archive utilities.
The Miscellaneous tab includes start-up, "on top," Smart DOC, and
other general options.

The Help Menu
The Help menu provides access to WinZip's® help information, hints and
tips, frequently asked questions, and WinZip registration and ordering
information. The entries are:
Help Contents and Index displays the table of contents and index
of WinZip's help. You can browse to the topic you need, look in the
help index, or perform a full text search for keywords of interest.
Brief Tutorial starts a brief step-by-step tutorial on using WinZip's
main features.
Frequently Asked Questions helps you get answers to questions
you might have. You can choose between the FAQs in the help or a
more extensive set of FAQs on the WinZip web site.
Hints and Tips displays a help topic that contains miscellaneous
hints and tips on how to use WinZip productively.
Tip of the Day displays a dialog containing a useful tip about
WinZip.
Enter Registration Code appears only in the evaluation version of
WinZip. Use this entry to register your copy of WinZip after you have
purchased a WinZip license.
License Agreement displays the WinZip License Agreement.
Ordering Information displays information from the WinZip help
about how to order WinZip.
WinZip Home Page takes you to the WinZip web site.
About WinZip displays the WinZip copyright notice, version number,
and other information about your installation of WinZip.

Using the Explorer Interface
Using WinZip's® Explorer interface, you can access most WinZip
functionality directly from Windows Explorer or My Computer shortcut
menus, from the Start menu, or from the desktop.
Here is a partial list of the things you can do using WinZip's Explorer
interface:
Create new archives
Add to existing archives
Extract files from archives
E-mail archives
Encrypt Zip files
Create self-extracting Zip files
You can do all of these things without opening WinZip itself.
See the following topics for more information about using the WinZip
Explorer interface:
Working with the Explorer Context Menu
Working with the Start Menu and Desktop
WinZip Quick Pick taskbar tray icon
Related Topics:
Using WinZip Menus
Using Drag and Drop
See also
Hints and Tips
More Hints and Tips
Hints For Working With Downloaded Files
Frequently Asked Questions (FAQs)

Working with the Explorer Context Menu
You can initiate most common operations on archives from My Computer
or Windows Explorer context menus. In many cases, you won't even
need to display or use the main WinZip® window.
Unzipping files from My Computer or Windows Explorer
Right click a Zip file in a Windows Explorer window, then choose
WinZip from the context menu and pick the appropriate Extract
choice from the WinZip submenu. You can extract to the current
folder ("here"), a recently used folder, a new subfolder created by
WinZip, or any folder of your choice.
Or, use the right mouse button to drag and drop a Zip file from a
Windows Explorer window to any folder, then choose Extract to
from the context menu. Be sure to use the right mouse button while
dragging.
You can extract from multiple Zip files in one operation, too: just
select the Zip files in Explorer, right click any of the selected files,
choose WinZip from the context menu, and pick the appropriate
Extract choice from the WinZip submenu.
Zipping files from My Computer or Windows Explorer
Select one or more files in a Windows Explorer window, then right
click any of the selected files, choose WinZip from the context
menu, and pick the appropriate Add choice from the WinZip
submenu. You can create a new Zip file or you can add the files to
any existing Zip file.
Alternatively, select one or more files, then drag and drop them on
an existing Zip file in the same Explorer window, in another Explorer
window, or on the desktop. Note that you can create a new, empty
Zip file in Explorer by right clicking and then choosing WinZip File
from the New submenu.
Compressing and e-mailing files and folders from My Computer or
Windows Explorer
Select one or more files or folders in a Windows Explorer window,

then right click any of the selected items, click WinZip from the
context menu, and choose one of the Zip and E-Mail entries from
the WinZip submenu. Zip and E-Mail filename.zip quickly
compresses the selected items, creates a temporary Zip file with the
specified name, and attaches it to a new e-mail message. Zip and
E-Mail Plus performs the same basic operation but allows you to
apply encryption and to specify the name of the temporary Zip file to
be created.
For a complete list of the actions available from the context menu, see
the Explorer context menu enhancements.
See also
Using the Start Menu and Desktop
Using Drag and Drop
WinZip Quick Pick taskbar tray icon
Explorer context menu enhancements
Explorer Enhancements (Configuration)

Using the Start Menu and Desktop
Using the Windows Desktop:
You can create a new, empty Zip file on the desktop: right click
anywhere on the desktop and select WinZip File from the New
submenu. After you've created it, change the name if desired and
then double click the icon to open it using WinZip®, or use drag and
drop to add files to the new Zip file.
Be sure to read about drag and drop for more things you can do on
the desktop.
Using the Start menu:
If you have WinZip configured to include a Start menu entry, you can
start WinZip directly from the system Start menu.
You can open recently used archives from the Documents submenu
in the Start menu.
Note: Windows XP does not display Zip files in the Documents
submenu. You can use the WinZip Quick Pick taskbar tray feature to
open recently used archives.
See also
WinZip Quick Pick taskbar tray icon
Working with the Explorer Context Menu
Using Drag and Drop

WinZip Quick Pick Taskbar Tray
Icon
The WinZip® Quick Pick taskbar tray icon gives you
instant access to WinZip and recently used archives.
Enabling and disabling the Quick Pick taskbar tray
icon
To enable or disable the WinZip Quick Pick taskbar tray
icon, check or uncheck Include WinZip Quick Pick in
the taskbar tray in the System tab of WinZip's
Configuration dialog. When Quick Pick is enabled, the
WinZip icon will automatically appear in the system
taskbar tray whenever you start your system.
Using the WinZip Quick Pick taskbar tray icon
To open WinZip, simply click the Quick Pick icon using
the left mouse button. For more options, right click the
icon to open the Quick Pick menu and:
Click any archive in the list of recently opened
archives to start WinZip and reopen the archive.
Click Favorites to start WinZip and display a list of
files in your Favorite Zip Folders. You can open any

listed archive by double clicking it.
Click Open WinZip to start WinZip (same as left
clicking the icon).
Click WinZip Help to view WinZip's help.
Click About for Quick Pick version and copyright
information.
Click Close to close WinZip Quick Pick and remove
the icon from the taskbar tray. You will have the
option to close Quick Pick but leave it enabled (so it
will return the next time Windows is started) or to
close it and disable it (so it won't return the next time
Windows is started).
Restarting Quick Pick after closing
If you close Quick Pick but leave it enabled, Quick
Pick will restart automatically the next time Windows
is started. To restart it manually (without restarting
Windows), click the Start button, choose Startup
from the Programs menu, and click WinZip Quick
Pick.
If you close and disable Quick Pick, it will not restart
automatically the next time Windows is started. To
restart it, you must re-enable it as described above.

Using Drag and Drop
The drag and drop interface is one of the most natural ways to use
WinZip®. Using drag and drop, you can create, open, update, extract
from, print, and e-mail archives--and more. Almost any drag and drop
operation you can think of will work.
To drag and drop a file or folder, click it with your left mouse button, then,
without releasing the button, drag it to the desired location and release
the mouse button to drop it. Refer to your Windows help for more
information if you haven't used drag and drop.
Creating a new Zip file
Drag one or more files or folders from My Computer or Windows
Explorer to the WinZip desktop icon or an open WinZip window.
Then, using the Explorer Add dialog, you can specify the name and
location for your new Zip file.
Opening an archive
Drag an archive from My Computer or Windows Explorer and drop it
on the WinZip desktop icon or an open WinZip window.
Remember, you can also double click the archive to open it, or right
click it and choose Open with WinZip from the shortcut menu.
Adding files to an archive
To add files to an existing archive, select one or more files or folders in
My Computer or Windows Explorer and drop them on any of the
following:
an open WinZip window
the WinZip desktop icon
an archive shown in a My Computer or Windows Explorer window
an archive on the desktop
a shortcut to an archive
Extracting, viewing, and printing files in an archive

You can drag files from an archive open in a WinZip window to other
applications, My Computer or Windows Explorer windows, the desktop,
printers and shortcuts.
If you drop files on a folder listed in My Computer or Windows
Explorer, the files are extracted to that folder.
If you drop files on the desktop, the files are extracted to the
desktop.
If you drop files on a printer icon, the files are printed.
If you drop files on another application or on a shortcut to an
application, the files are extracted to a temporary folder and passed
to the application for handling. The files are removed from the
temporary folder when the archive is closed.
Note: it's important to remember that different applications handle
dropped files in different ways. For example, when you drop a file on the
WordPad application distributed as part of Windows it will embed the file
as an OLE object, but when you drop a file on the Notepad application
distributed as part of Windows it will open the file. You may need to
experiment with drag and drop to understand how each application reacts
to files dropped on it.
Dropping an archive on another application
Sometime it can be useful to drag an entire archive from WinZip and drop
it on an application. For example, you can drop an archive on an e-mail
message to send it as an attachment, or on a Word document to embed
it as an object.
To drop an open archive from WinZip to another application, click the
WinZip status line, drag the mouse pointer to the application window, and
release the mouse button.
Related Topics:
Using the Explorer Interface
WinZip Quick Pick taskbar tray icon
Add Dialog Box
Add Dialog Box Options

Add Dialog Box
The Add dialog box is displayed when you use the drag and drop
interface to add files to an archive. You can either create a new archive
or add the files to an existing archive.
The Add dialog box lets you specify the name of the open archive in one
of two ways:
Type the name of the archive in the Add to archive edit field.
Click on the New or Open buttons to activate the standard New and
Open dialog boxes, respectively.
These shortcuts provide a quick way to add files to a different archive
without going through the File menu.
See Add Dialog Box Options for a description of the options available in
this dialog box.
Compatibility note
Beginning with version 9.0, WinZip® supports the 64-bit extensions to the
Zip file format. The extended format lets you store all the data you need
in Zip files of virtually unlimited size.
The original Zip file format limited the number of member files in a Zip file
to 65,535, and the maximum size of both the Zip file itself and any
member file to 4 gigabytes. For all practical purposes, the 64-bit
extended format eliminates all these restrictions: member file size, Zip file
size, and number of member files are limited only by your system's
resources.
WinZip remains fully compatible with the original file format and uses the
original format whenever possible. WinZip uses the 64-bit extended
format only when the limits of the original format are exceeded.
You should be aware, however, that very large Zip files compressed with
WinZip 9.0 are not compatible with earlier versions of WinZip and may
not be compatible with other Zip file utilities.

About Encryption
About encryption and encryption methods
WinZip's encryption facility gives you a way to protect
sensitive documents contained in your archives from
unauthorized viewing. The contents of the files that you
want to protect are encrypted by WinZip® based on a
password that you specify. In order for WinZip to later
extract the original contents of the encrypted files, the
correct password must again be supplied.
This section gives a general overview of WinZip's
encryption facilities. Once you are familiar with this
information, you can read about the specifics of using
encryption.
Additional or updated information about WinZip
encryption may also be available on the WinZip web site
at http://www.winzip.com/encryptioninfo.htm
WinZip provides two encryption methods for Zip files:
AES encryption: AES is the Advanced Encryption
Standard, which is the result of a three-year
competition sponsored by the U.S. Government's

National Institute of Standards (NIST). This
encryption method, also known as Rijndael, has been
adopted by NIST as a Federal Information Processing
Standard.
WinZip supports AES encryption in two different
strengths: 128-bit AES and 256-bit AES. These
numbers refer to the size of the encryption keys that
are used to encrypt the data. 256-bit AES is stronger
than 128-bit AES, but both of them can provide
significantly greater security than the standard Zip 2.0
method described below. An advantage of 128-bit
AES is that it is slightly faster than 256-bit AES, that
is, it takes less time to encrypt or decrypt a file.
The security of your data depends not only on the
strength of the encryption method but also on the
strength of your password, including factors such as
length and composition of the password, and the
measures you take to ensure that your password is not
disclosed to unauthorized third parties. Please read
about encryption passwords.
Note that the Zip file format extension used by
WinZip to store AES-encrypted files is not supported
by earlier versions of WinZip and is not yet supported
by most other Zip file utilities. Because the technical

specification for WinZip's AES format extension is
available on the WinZip web site, we anticipate that
other Zip file utilities will add support for this format
extension.
Standard Zip 2.0 encryption: this older encryption
technique provides a measure of protection against
casual users who do not have the password and are
trying to determine the contents of the files. However,
the Zip 2.0 encryption format is known to be
relatively weak, and cannot be expected to provide
protection from individuals with access to specialized
password recovery tools.
You should not rely on Zip 2.0 encryption to
provide strong security for your data. If you have
important security requirements for your data, you
should instead consider using WinZip's AES
encryption, described above.
The only advantage of Zip 2.0 encryption over the
more secure AES encryption is that it is supported by
most Zip file utilities, including earlier versions of
WinZip. Files that you encrypt using this technique
can be extracted by anyone who knows the correct
password and has access to almost any Zip file utility.
Additionally, Zip 2.0 encryption is supported by

WinZip Self-Extractor 2.2 and by WinZip SelfExtractor Personal Edition (included in WinZip 9.0);
the AES encryption method described above is not
supported by either self-extractor program.
Limitations to be aware of
WinZip 9.0's AES encryption facility represents a
significant advance on the previous Zip 2.0 encryption,
and it can help meet the need that many WinZip users
have for preventing their confidential information from
being viewed by unauthorized individuals. There are,
however, some limitations that you should be aware of:
Encryption applies only to the contents of files stored
within a Zip file. Information about an encrypted file,
such as its name, date, size, attributes, and
compression ratio, is stored in unencrypted form in
the Zip file's directory and can be viewed, without a
password, by anyone who has access to the Zip file.
WinZip's encryption method is not the same thing as
an authentication method for the Zip file. WinZip
encryption is intended to prevent someone who
doesn't know the correct password from finding out
the contents of your encrypted data. The password is
not needed for actions that do not involve decryption
of the encrypted contents of data stored within a Zip

file. In particular, encrypted files can be deleted from
a Zip file, or can be renamed within a Zip file, and
new, unencrypted, files can be added to a Zip file,
without a password.
WinZip 9.0 uses password-based encryption, and even
a strong encryption algorithm like AES is of little or
no benefit if the passwords you use are weak, or you
do not keep track of them in a secure manner.
We recommend that if you are going to be using the
same password to encrypt very large numbers of files
with WinZip's AES encryption (that is, files totalling
in the millions, for example 2000 Zip files, each
containing 1000 encrypted files) you use 256-bit AES
keys rather than 128-bit AES-keys. The technical
reasons for this are discussed below.
Notes on encryption safety
Encryption provides a measure of safety for your
sensitive documents, but even encrypted documents can
be compromised (regardless of whether they were
encrypted by WinZip or by other encryption software).
Here are some of the ways this can occur. This is by no
means an exhaustive list of potential risks; it is intended
only to give you an idea of some of the safety issues
involved with sensitive documents.

If a keystroke monitor or other malicious code (such
as a virus) is running on your computer, your
password may be recorded when you type it. Be sure
to check frequently for viruses and follow other
recommended computer safety procedures.
If you extract an encrypted file and then delete the
file, it may be possible for someone to later
"undelete" the file using file recovery software or the
Recycle Bin.
When you open or view a file from an archive (e.g.,
by double clicking it), WinZip must extract the file to
a temporary location so that the associated program
can open it. If you subsequently close WinZip without
first closing the program that is using the file, WinZip
may not be able to delete the temporary copy of the
file, thereby leaving it on disk in unencrypted form.
The associated program may also make one or more
backup copies of the decrypted file, and WinZip will
not be able to delete these. In addition, as described
above, it may be possible for someone to later recover
deleted files using file recovery software or the
Recycle Bin.
When you "move" files to a Zip file by choosing the
Move action in the Add dialog, WinZip moves the
files into the Zip file by compressing them and then
deleting the original files from the disk. It may be
possible to recover the original, unencrypted files

from the disk.
After adding or extracting encrypted files, some or all
of the unencrypted file contents may remain in your
computer's memory or the page swap files on disk. A
malicious user may be able to retrieve this
unencrypted information.
WinZip does not encrypt Zip file comments or, as
described above, information about encrypted files
such as their names, dates, etc. Any user with access
to the Zip file can view this information without a
password.
You may be able to eliminate some of these exposures
using specialized software such as virus scanners, disk
erasers, etc.
Technical information on AES key generation
When you use AES encryption with WinZip, the
passwords that you enter are converted into keys of the
appropriate length (128 bits or 256 bits, depending on the
AES key length that you specify). This is done through
the PBKDF2 algorithm defined in RFC 2898 (also
available as Public Key Cryptography Standard #5) with
an iteration count of 1000. WinZip uses 8-byte salt values
with 128-bit AES encryption and 16-byte salt values with
256-bit encryption.

One purpose for the "salt" values used with WinZip's
AES encryption is to yield different encryption keys for
each file, even if multiple files are encrypted with the
same password. With the 8-byte salt values used with
WinZip's 128-bit encryption it is likely that, if
approximately 4 billion files are encrypted with the same
password, two of the files will be encrypted with the
same key. Someone who obtained copies of two files
encrypted with the same key could learn information
about their contents, so it is advisable to stay well below
this limit. This is why we recommend that if you are
going to be using the same password to encrypt very
large numbers of files with WinZip's AES encryption
(that is, files totalling in the millions, for example 2000
Zip files, each containing 1000 encrypted files), you use
256-bit AES keys, which use 16-byte salt values, rather
than 128-bit AES-keys, with their 8-byte salt values.
As part of the process outlined in RFC 2898 a
pseudorandom function must be called; WinZip uses the
HMAC-SHA-1 function for this purpose, since it is a
well-respected algorithm that has been in wide use for
this purpose for several years. The PBKDF2 function
repeatedly calls HMAC-SHA-1, which produces a 160bit hash value as a result, mixing the outputs in a fairly
complicated way, eventually yielding a 128- or 256-bit
encryption key as a result.

Note that, if you are using 256-bit AES encryption, the
fact that HMAC-SHA-1 produces a 160-bit result means
that regardless of the password that you specify, the
search space for the encryption key is unlikely to reach
the theoretical 256-bit maximum, and cannot be
guaranteed to exceed 160 bits. This is discussed in
section B.1.1 of the RFC 2898 document.
Information for software developers
Zip file utility developers who wish to provide WinZipcompatible AES encryption support in their own products
can find complete technical information at
http://www.winzip.com/aes_info.htm.
See also
Using Encryption
Encryption Passwords

Using Encryption
Please read about encryption.
Decrypting files
The correct password is required before WinZip® can
extract an encrypted file from an archive. If WinZip does
not already know the correct password from a previous
operation during the same session on the same archive, it
will ask you for the password when it is needed.
Note that WinZip extracts files not only for the Extract
operation, but also when you view or open a file and
when you use features such as Test, CheckOut, Install,
and Virus Scan.
Encrypting files
You can encrypt files while they are being added, or you
can encrypt (or re-encrypt) all files already in a Zip file.
Encrypting files while adding
The most efficient way to encrypt files is to do so while
you are adding them to an archive. To encrypt files while
they are being added, simply check the Encrypt added

files check box in the Add dialog. Before adding the files,
WinZip will display the Encrypt dialog, where you will
specify the password and encryption method.
When you add files to a Zip file from Windows Explorer,
you will have an option to encrypt the files if the Add
dialog is displayed. In some cases, however (e.g., when
you choose Add to recently used Zip file), there is no
Add dialog and therefore no opportunity to encrypt the
files while they are being added. In these cases, you can
encrypt files after they have been added, as described in
the next section.
Encrypting files already in a Zip file
To encrypt files already in a Zip file, either
open the Zip file and choose Encrypt from the
Actions menu, or
right click the Zip file in My Computer or Windows
Explorer and choose Encrypt from the WinZip
shortcut menu.
In either case, WinZip will ask for a password and
encryption method and then encrypt all files currently in
the Zip file.
If a file in the Zip file is already encrypted, it will first be

decrypted and then re-encrypted using the method and
password you specified. WinZip will first try to decrypt
the file using the current encryption password; if the file
cannot be decrypted with this password, WinZip will ask
you for the correct decryption password. If you are
unable to supply the correct password, the file will be
skipped, and it will remain unchanged in the Zip file.
Note that it is more efficient to encrypt files while they
are being added to the Zip file than to encrypt them after
they are already in the Zip file.
Notes on using encryption
The main WinZip window marks encrypted files with
an asterisk following the filename.
In the Encrypt and Decrypt dialogs, check the Mask
password check box to prevent the password from
being displayed as you type it. If you check this
option, the Encrypt dialog will require you to type the
password twice for confirmation (to avoid
typographical errors).
The quality of the passwords you choose can greatly
affect the security of your encrypted documents.
Please read about passwords.
Be sure to keep track of your passwords! You will not
be able to extract or open any files for which you do

not have the correct password.
See also
About Encryption
Encryption Passwords

Encryption Passwords
The security of your data depends not only on the
strength of the encryption method but also on the strength
of your password, including factors such as length and
composition of the password, and the measures you take
to ensure that your password is not disclosed to
unauthorized third parties.
You should keep the following considerations in mind
when choosing passwords for your files:
In general, longer passwords are more secure than
shorter passwords. In fact, taking maximum
advantage of the full strength of AES encryption
requires a password of approximately 32 characters
for 128-bit encryption and 64 characters for 256-bit
encryption.
Passwords that contain a mixture of letters (upper and
lower case), digits, and punctuation are more secure
than passwords containing only letters.
Because you can use spaces and punctuation, you can
create "pass phrases" that are long enough but still
easy to remember and type.
Avoid using easily guessed passwords such as names,
birthdays, Social Security numbers, addresses,

telephone numbers, etc.
Be sure to keep a record of the passwords you use and to
keep this record in a secure place. WinZip® has no way
to access the contents of an encrypted file unless you
supply the correct password. Before storing your only
copies of critical information in encrypted form, you
should carefully consider the risks associated with losing
or forgetting the passwords involved.
See also
About Encryption
Using Encryption

WinZip Self-Extractor Personal Edition
Overview
WinZip Self-Extractor Personal Edition is included with WinZip®, under
the terms of the WinZip License Agreement. It makes it easy to create
files that unzip themselves. The following information applies to both
WinZip Self-Extractor Personal Edition and to WinZip Self-Extractor 2.2,
a separately available extra charge companion product.
What is a Self-Extracting Zip File?
A self-extracting Zip file is an executable program file (.EXE file) that
includes a Zip file and software to extract or "unzip" the contents of the
Zip file. Users can run (execute) a self-extracting Zip file just as they run
any other program.
When a self-extracting Zip file created by WinZip Self-Extractor Personal
Edition is run, a dialog box is displayed. This dialog box makes it easy for
the user to change the "Unzip to" folder before starting the extract or
"unzip" operation.
Self-extracting Zip files created by WinZip Self-Extractor are 100%
compatible with the Zip 2.0 file format, so they can be unzipped by a
standard unzip utility like WinZip.
What are the advantages to Self-Extracting Zip Files?
Users can extract or "unzip" files from a self-extracting Zip file without
running a separate unzip utility or knowing how to use an unzip utility.
Thus, self-extracting Zip files are particularly suited for distribution of
software to beginning users who are not familiar with the concept of Zip
files.
Self-extracting Zip files created by WinZip Self-Extractor are native
Windows programs so they are easy to use.
How Does it Work?
There are two parts to the process:
The WinZip Self-Extractor program creates self-extracting Zip files.
When WinZip Self-Extractor creates a self-extracting Zip file it
includes part of itself in the self-extracting Zip file. The part of WinZip
Self-Extractor included in the self-extracting Zip file is what makes it

possible to unzip the files by simply running the self-extracting Zip
file.
The person who creates the self-extracting Zip file runs WinZip SelfExtractor once, specifying the name of the Zip file. The resulting selfextracting Zip file can be distributed to many people, and will unzip itself
when it is run.
Related Topics:
WinZip Self-Extractor Personal Edition - Operation
WinZip Self-Extractor 2.2

WinZip Self-Extractor Personal Edition Operation
To make a self-extracting Zip file, you must start with a normal Zip file
(.zip extension) that you have created with WinZip®, downloaded, etc.
Then you can either
open the file with WinZip and choose Make .Exe File from WinZip's
Actions menu, or
right click the Zip file in My Computer or Windows Explorer and
choose Create Self-Extractor (.Exe) from the WinZip Explorer
context menu.
Either of these actions will activate WinZip Self-Extractor Personal
Edition unless you have specified a different program in the Make Exe
field in the Program Locations tab of the Configuration dialog. If you
chose to create a WinZip Self-Extractor Personal Edition icon while
installing WinZip, you can also start the program by double clicking on
this icon.
WinZip Self-Extractor Personal Edition dialog box contains the following
fields:
Create self-extracting Zip file from
The name of the standard (not self-extracting) Zip file to turn into a
self-extracting Zip file.
Default "Unzip To" folder
The default target folder for the unzip operation. If left blank the
folder specified by the user's TEMP= environment variable is used.
Spanning Support
Removable disks such as diskettes have very limited storage
capacity. Sometimes, self-extracting Zip files you create will not fit
onto a single diskette. In this case, you can ask WinZip SelfExtractor to save one Zip file across multiple diskettes. This process
of creating a Zip file that occupies multiple disks is called
"spanning".
When you span Zip files across multiple disks using WinZip Self-

Extractor, no special software is required during extraction. Your
users are simply prompted to insert any additional disks in the
multiple volume set at the appropriate time during extraction.
The following choices determine whether you want to make use of
the spanning feature to create a single Self-Extractor on more than
one removable disk, and which method to use.
No Spanning - WinZip will not create a .EXE that spans
removable disks.
Safe spanning method - Selecting the Safe method causes
WinZip Self-Extractor to put two files onto the first disk: a Zip
file with the first portion of your compressed data, and a small
.EXE file with the executable code that is required to extract
your data. The second and subsequent disks contain Zip files
with the remaining portions of your compressed data. The Safe
method is the default, and recommended, method.
Old spanning method - In contrast, the Old spanning method
puts a .EXE file on the first disk that contains both the
executable code used to extract the compressed data and the
first portion of that data. The second and subsequent disks
contain the remaining portions of your compressed data in files
that (even though they don't actually contain any executable
code) have an extension of EXE. This is potentially dangerous
because, if a user inadvertently tries to run the EXE file on the
second or succeeding disks, random error messages, and even
system hangs, can occur.
Note: The WinZip Self-Extractor cannot make use of unformatted
disks. All of the disks that you use with WinZip Self Extractor must
already be formatted.
Overwrite by default
This check box determines if the "Overwrite files without prompting"
option in the self-extracting Zip file's dialog box should be checked
by default.
Click OK to create the self-extracting Zip file. Be sure to test the selfextracting Zip file before distributing it.
Related Topics

WinZip Self-Extractor Personal Edition - Overview
WinZip Self-Extractor 2.2

WinZip Self-Extractor 2.2
WinZip Self-Extractor Personal Edition is included with WinZip®, under
the terms of the WinZip License Agreement. WinZip Self-Extractor 2.2,
a $49 companion product to WinZip, includes the following features not
available in the Personal Edition:
Features to automate and customize software installation, such as
the ability to specify an icon and text for the main self-extractor
dialog box, and to delete temporary files after running a setup
program. It includes support for the InstallShield 3.0 SETUP
program.
Ability to run a command when the unzip operation completes.
Self-extracting files can be created from the command line.
All versions can be created with English or German messages.
Ability to automatically extract files when the EXE file is run.
A Wizard to simplify the process of building self-extracting files.
Click here for information on obtaining WinZip Self-Extractor 2.2.
Related Topics:
WinZip Self-Extractor Personal Edition - Overview
WinZip Self-Extractor Personal Edition - Operation

Double Clicking
Double clicking on a filename listed in the main WinZip® window will
perform the same action as when you double click on a file in My
Computer or Windows Explorer. If the file is executable (has a filename
extension of EXE, COM, BAT, or PIF), WinZip will run it. Otherwise
WinZip will open the file with the appropriate application. For example,
files with a filename extension of .TXT are opened by the Windows
Notepad application (unless you have changed the TXT association). The
appropriate application is determined via Windows Associations. If no
application is associated with the file, WinZip will run the program
specified as the Default association in the Program Locations tab of
the Configuration Dialog Box. If you modify the file while viewing it,
WinZip will offer to add the modified file to the archive.
If the Smart DOC file handling option in the Miscellaneous tab of the
Configuration Dialog Box is enabled and you double click on a file with a
file type of .DOC, WinZip will run one of two programs:
If the .DOC file looks like plain ASCII text WinZip will run the
program specified as the Default association in the Program
Locations tab of the Configuration dialog box.
If the .DOC file looks like a file created by a word processor WinZip
will run the program associated with .DOC files.
Smart DOC file handling avoids the overhead of loading a word
processor such as Microsoft Word when viewing ASCII text files like
"readme.doc". Note that Smart DOC file handling is used for double
clicked files only; it is not used when you right click on a .DOC file and
choose Open from the shortcut menu. In that case, WinZip uses the
same program to open the document that Windows Explorer would; for
most users, this will be Microsoft Word or another word processor.
Note: Pressing the Enter key performs the same action as double
clicking. Single clicking also performs the same action as double clicking
if you have:
chosen Single click to open a file in the View tab of the
Configuration dialog, or

enabled "Single click to open an item" in your system settings, and
you have chosen Use current system folder settings in the View
tab of the Configuration dialog.

Windows Associations
Windows associations
Microsoft has defined the word "associate" as follows:
To identify a filename extension as belonging to a certain application,
so that when you open any file with that extension, the correct
application is opened automatically.
For example, by default, Windows associates .WRI files with the Write or
WordPad application, and .TXT files with the NOTEPAD application. Most
Windows application installation procedures create associations. For
example, Word for Windows creates an association for .DOC files, while
WinZip® generally creates associations for files with the extensions ZIP,
LZH, ARJ, ARC, CAB, TAR, TGZ, TAZ, TZ, GZ, Z, UU, UUE, XXE, B64,
HQX, BHX, MIM.
WinZip uses associations when you Double Click on a filename listed in
the main WinZip window and when you use the CheckOut Feature.
WinZip, My Computer, and Windows Explorer all use associations the
same way. When you open a file with an association, the application
associated with the file is run, and the application automatically opens the
file. WinZip's CheckOut facility establishes associations when it creates
the CheckOut window for two reasons: to display the right icon for each
file and to ensure that the appropriate application is run when you double
click an icon.
You can view, add, and remove Windows associations using My
Computer or Windows Explorer. Open My Computer or Windows
Explorer and locate Options or Folder Options in the menus (the exact
name and menu location depends on your version of Windows). Open
the options dialog from the menu and click the File Types tab. Press the
F1 key for detailed instructions.
WinZip associations
You can easily review and modify the types of archives with which WinZip
is associated from within WinZip. When an archive type is associated
with WinZip, Windows will use WinZip to open files of that type.
To view and modify WinZip associations, choose Configuration from the

Options menu, click the System tab, and click the Associations button.
In the dialog that follows, you will see a list of archive types. You can
specify whether an archive type should be associated with WinZip by
checking or unchecking the checkbox next to the archive type.

Virus Scanner Configuration
WinZip® supports many virus scanners that can be run from Windows or
from the DOS command line, with a few important limitations noted
below. Virus scanners can be run using the Virus Scan entry in the
Actions menu or during CheckOut operations if the Run virus scanner
option in the CheckOut dialog box is selected.
Virus scanner configuration is done from the Program Locations tab of
the Configuration dialog.
When you first install WinZip, it automatically searches for virus scanners
in the folders specified by your system's PATH and in the "App Paths"
Windows registry entries. If one of the supported virus scanners is found,
WinZip will automatically use the scanner. A listing of and further
information about currently supported virus scanners can be found on the
WinZip web site at http://www.winzip.com/xvirus.htm.
If the installation procedure does not automatically find one of the
aforementioned virus scanners, you can have WinZip automatically fill in
the Parameters field by selecting the desired scanner from the dropdown combo box (for example, scan.exe) and then adding the full
filename for the scanner to the Scan program field (for example,
c:\mcafee\scan.exe instead of just scan.exe).
You can also configure WinZip to work with another scanner. See the
section titled Virus Scanner Configuration Details below for more
information.
Notes:
WinZip's default virus scanner parameters work with the versions of the
scanners that were tested. If the authors of a scanner change the
command line parameters in future releases of the scanner, then
WinZip's default parameters for the scanner may no longer work. For
example, McAfee SCAN 2.1 parameters are incompatible with prior
versions of SCAN. Version 2 requires the /ALL parameter while version 1
requires /A.
Unless a virus is found, no manual intervention is required while running
most virus scanners. However, some virus scanners, such as TFINDVIR,
always need to be closed manually, because they do not currently
support options to close automatically.

Virus Scanner Configuration Details
This portion of the documentation describes how to configure WinZip to
work with a scanner that is not listed above. Do not use WinZip's virus
scanning support with a different virus scanner unless you have read and
understood the following information.
To configure WinZip to work with a scanner, fill in the following fields in
the Program Locations tab of the Configuration dialog:
The Scan program field should contain the name of the program
(the full path name is required if the program is not in a folder
specified in your system's PATH).
The Parameters field should contain the appropriate parameters to
run the virus scanner as described below.
The Run minimized box determines whether the scanner should be
run minimized. See below for important notes on using this
parameter with DOS based scanners. Note that some scanners,
such as NAVW32.EXE, always run minimized, regardless how you
set this option.
Special character sequences for the Parameters field are:

*.*

indicates where WinZip should substitute the drive,
folder, and the *.* characters for the files that are to be
scanned. For example, "c:\temp\dir\*.*".

%d

indicates where WinZip should substitute the drive
and folder of the files that are to be scanned. Note
that the wild card characters *.* are NOT included
when you use %d.

%f

indicates where WinZip should substitute the name of
a temporary "report file". Report files should ONLY be
used when running DOS virus scanners.

%wscan

a special parameter required for McAfee's WSCAN
program.

If you do not specify any of the aforementioned special character
sequences WinZip will append the filenames to be scanned at the end of
the scanner command line.

Be sure to specify any parameters necessary to cause the scanner to
check folders of the drive and folder of the files that are to be scanned.
To configure WinZip for a Windows-based virus scanner, first ascertain
that the virus scanner reports suspected viruses by displaying a dialog
box. If the scanner simply writes to a log file when a virus is found you
(and WinZip) will not know about the problem.
To configure WinZip for a DOS-based virus scanner, be sure to verify that
the scanner can either be used with the Run minimized option (see
below for details) or issues a prompt if a virus is found. If neither of these
conditions is met and a virus is found you (and WinZip) will not know
about the problem.
The Run minimized check box should only be used for DOS scanners
under the following circumstances:
The scanner is configured to run in "batch" mode, without any
prompts. If the scanner requires any keyboard input when running
minimized, you will not be able to see the prompts, and the session
will appear to be hung.
The scanner writes all messages through DOS, or has an option to
write results to a report file. Messages written directly to the video
buffer are not captured by WinZip and will be lost. To determine
whether a scanner writes messages through DOS, run the scanner
with its output redirected (for example, issue the command "scan >
nul"). Any messages you see during this test will not be captured by
WinZip. If the scanner has an option to write results to a report file
you can use %f in the Parameters field to cause WinZip to capture
the results (see above for details).
The scanner returns a non-zero error level if it encounters any
problems. If the scanner does not return a non-zero error level,
WinZip will assume that the files passed the virus check, and any
warnings issued by the scanner will be lost. (Note: if the scanner
returns a non-zero error level, WinZip automatically displays all
messages written to standard error or standard output.)

Multiple Disk Spanning
WinZip® makes it easy to create Zip files that "span" multiple disks. This
is useful if the files you are working with will not fit on one disk.

Creating spanned Zip files
To make a Zip file that spans multiple disks, simply create a new Zip file
on a removable disk, then add files to the Zip as you normally would. If
the disk fills during Add operation, you will be prompted for another disk.
Simply insert the next disk and click the OK button.
Important: disk spanning is not available when adding files to an
existing archive; it is only available while creating a new archive. Also
note that you cannot add files to or remove files from a Zip file that spans
disks. WinZip requires pre-formatted disks (you can format disks using
My Computer or Windows Explorer).
Example:
To zip the files in your c:\data folder to a Zip file called A:\DATA.ZIP:
1. Start WinZip.
2. Drag and drop the c:\data folder from My Computer or Windows
Explorer to the WinZip window.
3. In the Add dialog box, type the filename of the Zip file (A:\DATA.ZIP).
4. Click the Add button.
If more than one disk is needed, you will be prompted for additional disks.

Extracting from spanned Zip files
To extract files from a spanned Zip file, insert the last disk of the series
and open the Zip file using WinZip; this will display the directory of the Zip
file and allow you to extract the files. WinZip will prompt you for the disks
as needed to complete the operation.
See also
Split Zip files

Potentially Unsafe File Types
WinZip® displays caution messages in some situations,
such as when you double-click on a .EXE file
compressed within a Zip file, to warn that you are
working with a file type that could potentially contain a
virus. These warnings can be helpful for WinZip users
who rarely or never need to use Zip files containing these
potentially unsafe file types. WinZip users who
frequently need to work with the file types involved can
easily turn the caution messages off.
To help prevent virus infections on your computer, you
should familiarize yourself with the information on this
page. A little knowledge and some sensible security
procedures will allow you to be comfortable working
with the Zip files that you receive.
On this page:
Overview
About potentially unsafe file types
WinZip's handling of potentially unsafe file types

Security hints and tips
Overview
One of the most common ways in which a computer
becomes virus-infected is that its user actively causes the
virus to run, not realizing that the file being opened could
contain a virus. This can happen when, for example, you
double-click a virus-infected attachment to an e-mail
message.
Viruses are sometimes compressed inside Zip files, which
are then sent as e-mail attachments. When you receive a
Zip file as an e-mail attachment, double-clicking the
attachment will open the Zip file in WinZip (or whatever
Zip utility is installed on your system). If, within your Zip
utility, you then double-click the virus-infected file, the
virus can run and your computer can become infected.
(An up-to-date virus scanner, scanning files in real time,
will stop most infections, but the newest viruses may
escape detection.)
One reason that viruses are able to spread is that doubleclicking a file has historically been a safe thing to do. It is
easy to casually double-click a file received as an e-mail
attachment, or a file within a Zip file received as an email attachment.

Unfortunately, because of the recent proliferation of
viruses, it is no longer safe to routinely double-click files,
especially files received as attachments to suspicious email messages or downloaded from untrusted web sites.
This issue has become so important that recent versions
of Internet Explorer and of e-mail programs such as
Outlook and Outlook Express warn you when you are
about to work with potentially unsafe file types.
Because Zip files can sometimes contain virus-infected
files, this version of WinZip displays similar warnings in
certain situations when a Zip file that you are working
with contains files of potentially unsafe types.
About Potentially Unsafe File Types
The file type of a file, sometimes referred to as its
extension, is the last portion of the name of the file. For
example, if you have a file called "memo.doc", the last
portion of the name of the file (that is, the portion
following the final period) is "DOC". This file therefore
has a file type of DOC, and would sometimes be referred
to as a DOC file or a .DOC file.
Windows generally uses the file type to decide how the
file will be handled when you double-click the file's icon.
For example, DOC files most often contain Microsoft

Word documents; if you double-click a DOC file and
Microsoft Word is installed on your system, Windows
will open the file in Microsoft Word.
As a second example, the file "game.exe" has a file type
of EXE. This type of file normally contains a program,
and if you double-click it, Windows will run the program.
The EXE file type is an example of a potentially unsafe
file type. While the vast majority of EXE files that you
are likely to encounter are safe and useful, malicious
individuals sometimes write programs that can harm your
computer and distribute them in the form of EXE files.
There are a number of other file types that are often
considered to be potentially unsafe because they have
been used to spread viruses. There is no definitive list of
these file types that everyone would agree with, and to
some extent the list is constantly changing, but here is the
list that is used by this version of WinZip:
ADE, ADP, APP, BAS, BAT, CHM, CMD, COM, CPL,
CRT, CSH, DLL, EXE, FXP, HLP, HTA, INF, INS, ISP,
JS, JSE, KSH, LNK, MDA, MDB, MDE, MDT, MDW,
MDZ, MSC, MSI, MSP, MST, OCX, OPS, PCD, PIF,
PRF, PRG, REG, SCF, SCR, SCT, SHB, SHS, URL, VB,
VBE, VBS, VBX, WSC, WSF, WSH, XSL

All of these file types have legitimate uses under
appropriate circumstances. The simple fact that a file is
one of the types listed above does not mean that there is
something "wrong" with the file or that it is infected with
a virus. But if you receive a file with one of these types
from an untrusted source or in unexpected or suspicious
circumstances, you should not work with the file until
you are sure that it is safe.
Of course, as mentioned above, there is no definitive list
of which file types are safe or unsafe, so even with file
types that are not on the above list, you should use
appropriate cautions.
For some general security guidelines, see Security Hints
and Tips below.
WinZip's Handling of Potentially Unsafe File Types
This version of WinZip has been enhanced to warn you
about some of the most common situations in which you
could become infected by a virus compressed inside a Zip
file.
This enhancement involves several small changes to
WinZip that we believe will, in these specific situations,
make it less likely for you to be affected by a virus that

has been placed inside a Zip file.
If you are using the WinZip Classic interface and you
double-click a file with a potentially unsafe file type,
such as .EXE, WinZip will display a dialog warning
you about the potentially unsafe file type. You can
then decide whether you really want to open it.
Note that this warning is only displayed when you
double-click a file within a Zip file to open that file
from within WinZip. You can still extract files from a
Zip file to a folder on your disk without a warning,
regardless of the file types involved.
If you are using the WinZip Wizard interface, the
Wizard will display a dialog to notify you when you
begin to work with a Zip file that contains any files on
WinZip's list of potentially unsafe file types. You can
then decide whether you want to continue working
with that Zip file.
WinZip also displays warning text when you try to
install software contained within a Zip file. For
example, when you use the Install button in the
WinZip Classic interface to install software from a
Zip file that contains a Setup program, WinZip will
display a dialog reminding you not to install untrusted
software.

Some WinZip users, especially "power users" who
frequently work with some of the file types that WinZip
considers potentially unsafe, will prefer not to see these
warnings repeatedly. Therefore, all of the new warning
dialogs have check boxes that you can use to stop them
from displaying again.
Security Hints and Tips
Know Your Source

Never open a Zip file that is attached to e-mail from
an unknown source.
If an unexpected Zip file is attached to e-mail from
someone you know, consider verifying with the
sender that the attachment is legitimate. Some viruses
spread by e-mailing copies of themselves to everyone
in the contact lists of infected computers; this means
that you can receive infected files even from people
you know.
Avoid downloading Zip files from untrusted web
sites.
Of course, these guidelines don't apply only to Zip files;
they apply equally to any file type.
Keep Your System Protected and Up-To-Date

It is very important to have a good anti-virus program
installed on your computer. We recommend that you
configure your anti-virus program to scan all files that
you work with in real time. Most virus scanners can
also be configured to scan e-mail as it arrives and
quarantine infected messages. We also recommend
that you enable this option. And, because new viruses
are discovered almost daily, be sure to keep your antivirus program up to date. Most anti-virus programs
have an automatic update facility that can help with
this.
You should also use Microsoft's Windows Update
feature to be sure that you have Microsoft's latest
fixes for your version of Windows. Windows Update
also has an automatic update facility that can help
keep you up to date.
To be sure that you find out about new WinZip
updates or maintenance releases, sign up for the
WinZip mailing list at
http://www.winzip.com/maillist.htm.
Disable Hidden File Name Extensions

All current versions of Windows are initially installed
with an option called "Hide extensions for known file
types" enabled. When this option is enabled, Windows
will not display the file name extensions (.EXE, .DOC,

etc.) for file types that it knows about.
This option is considered by many knowledgeable users
to be dangerous, primarily because it can mislead you
about the true nature of your files. For example, you
might have a virus-infected file named
"vacation.jpg.exe". If the hidden extension option is
enabled, this file will appear on your desktop or in
Windows Explorer as "vacation.jpg", leading you to think
that it is a harmless vacation picture. In fact, it is an
executable program, and opening it could infect your
computer.
To disable hidden extensions:
1. Open My Computer or Windows Explorer.
2. Click Folder Options, which will be located in either
the View menu or the Tools menu, depending on your
version of Windows.
3. In the Folder Options dialog, click the View tab.
4. Uncheck the box labeled Hide extensions for known
file types and click OK.

Desktop Theme Installer
What's a desktop theme?
A desktop theme is a collection of desktop attributes-colors, mouse pointers, sounds, wallpaper, and so on--that
create a "theme" for your desktop. Windows 95 (with
Plus! installed), Windows 98, Windows Me, Windows
XP, and Windows NT 4.0 (with add-on theme support
installed) provide support for desktop themes. Please
read this additional information if you are using
Windows 2000.
Caution: you should be careful when installing
any kind of software, including desktop themes.
Be certain that you trust the source of this Zip file.
Do not install anything contained in a Zip file that
was attached to an unexpected or suspicious email message. See Security Hints and Tips for
additional information.
Windows users have contributed a wide variety of themes
that you can obtain, usually at little or no cost, from
online sources such as the Internet or AOL. Most
commonly these are packaged in Zip files as a collection
of components, often lacking a Setup program for

installation. Without a Setup, themes can be somewhat
difficult to install--but WinZip's® desktop theme installer
makes it easy.
The WinZip desktop theme installer
If WinZip determines that the open Zip file contains a
desktop theme, the Install button is enabled and you will
be able to use it to install your theme. Simply click the
Install button or choose Install from the Actions menu
and follow the screen instructions. Note: if the Install
button isn't enabled, see the notes below; the desktop
theme installer may be turned off.
After WinZip has extracted the necessary files to the
correct folders, it will run the system theme installer
(normally Themes.Exe) to complete your installation.
Here you can preview many of the changes, such as
color, desktop icons, and wallpaper, provided by the
theme designer. (Under some versions of Windows you
may need to first select the new theme from the list of
available themes in the Theme drop-down list.) If you
like the theme, just click Apply and Themes will convert
your desktop to the new theme. If you don't like the
theme, click Cancel and your desktop will be unaffected.
Consult your Windows documentation or help for more
information about the theme installation program.

If you use the WinZip Wizard, the Wizard will
automatically lead you through theme installation when
you unzip a Zip file that contains a theme.
Please read this additional information if you are using a
third party theme installer.
Notes
Here are some additional notes regarding desktop theme
installation.
A desktop theme is defined by a Desktop Theme File
(.Theme extension), which must be contained in the
Zip file. WinZip assumes that any Zip file that
contains a file with a .Theme extension is a desktop
theme Zip file. The Desktop Theme File identifies the
various components of the theme and specifies
exactly where they are to be located. Because the files
must be stored in the folders defined by the Desktop
Theme File, WinZip does not provide you with an
option to specify the folders to which the theme
should be extracted. It does, however, show you what
folders will be used and allows you to cancel
installation if desired.
Microsoft has not documented the format of .Theme
files. The WinZip Desktop Theme Installer is

designed to work with .Theme files as used by the
current version of Microsoft's THEMES.EXE (4.0). It
is possible that Microsoft may change the format of
.Theme files or other aspects of desktop theme
support and that, as a result, WinZip will no longer be
able to support desktop theme installation. Current
information about desktop theme compatibility issues
can be found on our web site at
http://www.winzip.com/thminfo.htm.
Some desktop theme Zip files contain more than one
theme. When this is the case, WinZip allows you to
choose which theme to install.
If you would prefer to install your desktop theme
manually, choose Unzip only in the "Unzip/Install
Desktop Theme" panel. Alternatively, you can disable
the theme installer by choosing Configuration from
the Options menu, clicking the Miscellaneous tab,
and unchecking the box labeled Desktop
theme/screen saver installer. This disables both the
theme installer and the screen saver installer.
We have found that many free desktop theme Zip files
obtained from online sources are missing some
components (such as cursors or sound files). In some
cases, filenames are simply misspelled in the Desktop
Theme File; in others, components were omitted from
the Zip file. This does not necessarily mean that the
themes are unusable, just that they are incomplete.

Before it extracts any files, WinZip will show you
which components, if any, are missing from the theme
package.
A small percentage of free desktop themes simply do
not work at all, for various reasons. Unfortunately,
WinZip Computing, Inc. cannot offer support in
getting malfunctioning desktop theme packages to
work; please contact the theme's author or supplier
instead. (But don't let this discourage you--there are
many excellent free theme packages available!)
WinZip supports desktop themes only when they are
packaged in Zip format. It cannot install themes from
other archive formats (ARJ, LZH, etc.).
If the Zip file contains a SETUP or INSTALL
program, WinZip will use the standard software
Install feature rather than the desktop theme installer.

Keyboard Usage
WinZip® is easier to use with a mouse, but you can also use the
standard Windows keyboard interface. WinZip's keyboard accelerators
include:
F1
Activate help system
F7

Move an archive.

F8

Copy an archive

Alt+F4

Exit (terminate) WinZip

Ctrl+A

Select all items in the list box.

Ctrl+N

Create a new archive.

Ctrl+O

Open an existing archive.

Ctrl+P

Print a listing of files in an archive.

Shift+A

Add files to an archive.

Shift+C

Activate the CheckOut feature.

Shift+D

Delete files from an archive.

Shift+E

Extract files from an archive.

Shift+F

Favorite Folders.

Shift+G

View, add, or edit a comment.

Shift+H

Split a Zip file.

Shift+I

Install files in an archive.

Shift+K

Create a self-extracting archive.

Shift+L

Close an archive.

Shift+M

Mail an archive.

Shift+R

Rename an archive.

Shift+S

Run virus scanner.

Shift+T

Test an archive.

Shift+U

UUencode an archive.

Shift+V

View files in an archive.

Shift+W

Switch to the Wizard interface.

Shift+Y

Encrypt all files in a Zip file.

Direction key(s)

Move the cursor and/or scroll a list.

Shift+direction
keys

Select multiple items in a list box.

Enter

Same as double clicking in the main window.

What's New in WinZip 9.0
WinZip 9.0 SR-1
WinZip® 9.0 SR-1 is a maintenance release of WinZip 9.0. This version
of WinZip has been enhanced to warn you about some of the most
common situations in which you could become infected by a virus
compressed inside a Zip file. Please see Potentially Unsafe File Types for
full information about this change.

Major Changes in WinZip 9.0
Improvements in WinZip 9.0 concentrate on its core functionality:
compression, capacity, and a new, advanced data encryption capability.
Using WinZip 9.0, you can compress more data, compress it better, and
protect your confidential information with far greater security.
Details of these and other enhancements follow.
Advanced encryption
WinZip 9.0 supports 128- and 256-bit key AES encryption, which provide
much greater cryptographic security than the traditional Zip 2.0
encryption method used in earlier versions of WinZip.
WinZip 9.0's advanced encryption (FIPS-197 certified) uses the Rijndael
cryptographic algorithm which, in 2001, was specified by the National
Institute of Standards and Technology (NIST) in Federal Information
Processing Standards (FIPS) Publication 197 as the Advanced
Encryption Standard (AES).
After a three-year competition, the AES was announced by NIST as an
approved encryption technique for use by the U.S. government, private
businesses, and individuals. When properly implemented as a key
component of an overall security protocol, the AES permits a very high
degree of cryptographic security, yet is fast and efficient in operation.
WinZip's AES encryption is just as easy to use as traditional Zip 2.0
encryption: all you have to do is select the encryption strength and
specify your password.
Note: recipients to whom you send AES-encrypted Zip files must have a
compatible Zip file utility in order to decrypt the files. We have published
the full specification for creating WinZip-compatible AES-encrypted Zip

files, and we expect that other Zip file utility vendors will provide support
for the format.
Greater capacity
In addition to supporting the original Zip file format, WinZip 9.0 also
supports the 64-bit extensions to the Zip file format. The extended format
lets you store all the data you need in Zip files of virtually unlimited size.
The original Zip file format limited the number of member files in a Zip file
to 65,535, and the maximum size of both the Zip file itself and any
member file to 4 gigabytes. For all practical purposes, the 64-bit
extended format eliminates all these restrictions. Using the extended
format, the member file size, Zip file size, and number of member files
you can add to a Zip file are limited only by your system's resources.
WinZip remains fully compatible with the original file format and uses the
original format whenever possible. WinZip uses the 64-bit extended
format only when the limits of the original format are exceeded.
Improved compression
WinZip 9.0 supports the "enhanced deflate" compression method. This
compression method provides greater compression for many types of
files and reduces the size of your Zip files, saving you data transmission
time and valuable disk space.
Note: versions of WinZip prior to WinZip 8.1 will not be able to extract
files compressed with this new method.

Other Changes in WinZip 9.0
In addition to the new AES encryption technology, WinZip 9.0
provides a number of usability enhancements that make it easier for
you to use encryption. For example, you can now easily encrypt the
files that are already in a Zip file; previously, files could be encrypted
only while they were being added to the Zip file.
WinZip 9.0 makes it easier than ever for you to find the WinZip
information you need by presenting help information using the newer
Microsoft "HTML Help" facility. HTML help has a more attractive
appearance and includes many usability improvements.
WinZip 9.0 gives you easier access to your most important file
locations in many WinZip Classic dialogs. Key dialogs such as New
Archive, Open Archive, Add, and Extract contain "places bars" when

running under Windows versions that support them. The places bar
provides quick access to your top-level locations, usually My
Computer, My Network (or Network Places), My Documents, Recent
Documents (or History), and the Desktop.
WinZip 9.0 lets you quickly find out what is in your Zip files. In My
Computer and Windows Explorer, the tooltip that is displayed when
you position the mouse pointer over a Zip file now contains
information about the contents of your archives by listing up to 25 of
the files and folders in the archive.
When installed under Windows XP, WinZip 9.0 installs and registers
for all users. This change makes it easier to install WinZip in
business or home environments where more than one person uses a
computer.
WinZip 9.0 contains a number of changes to improve performance
and efficiency:
The "Use for removable media only" option for the working
folder (in the Folders tab of the Configuration dialog) is now set
by default. This results in faster Zip file creation in most cases.
By default, WinZip no longer automatically displays comments
when opening Zip files that contain comments.
In Windows XP network environments, the performance of
WinZip's Windows Explorer extensions has been improved.
Several changes have been made to improve performance
when extracting files from archives.
WinZip 9.0's Classic interface has been improved:
The Extract dialog has been redesigned to display more folders
in the folder tree view and to provide more space for typing
folder names.
Placing the mouse pointer over a truncated file name (one that
won't fit in the available space) displays a tooltip showing the
complete file name.
Because it is an action rather than a setting, the option to
"Restore all caution messages" in the Miscellaneous tab of the
Configuration dialog has been changed from a checkbox to a
pushbutton.

The main WinZip window now contains a watermark when used
under Windows XP with an XP-style theme.
WinZip 9.0 no longer triggers false warnings in certain security tools
that search for programs that use the "zlib" compression library. zlib
is not a WinZip component.
A list of features introduced in earlier versions of WinZip is available from
the WinZip web site at http://www.winzip.com/version.htm.

Hints and Tips
Here are the hints and tips displayed by the "Tip of the Day" dialog box:
The Tip of the Day dialog can be set to display automatically when
you start WinZip®. To turn this feature on, choose Tip of the Day
from WinZip's Help menu, then choose from the combo box at the
bottom of the dialog.
When you are adding files that you want to be encrypted, it is more
efficient to encrypt them while adding than to encrypt them later with
the Encrypt menu item.
If you forget to encrypt files when you add them, you can encrypt
them later by choosing Encrypt from the Actions menu.
If you are new to Zip files, you can use the Wizard interface to walk
you through the process of zipping and unzipping or installing
software from Zip files, MIME files, and other encoded files. Choose
Wizard from the WinZip File menu to activate the Wizard.
You can add, remove, or reorder buttons on the WinZip toolbar by
right clicking on the toolbar and choosing Select Buttons.
WinZip's toolbar buttons look much better if your display is in high- or
true-color mode.
Click Control Panel in the Start menu's Settings entry. Double click
Display and choose the Settings tab. Choose High Color or True
Color mode for Color Palette (under Windows NT 4.0 choose
65536).
For some quick lessons on how to use WinZip's main features,
choose Brief Tutorial from WinZip's Help menu.
For quick zipping and unzipping, you can right click on a file listed in
Windows Explorer and choose Add to Zip file or Extract to from
Windows Explorer's context menu.
The WinZip QuickPick taskbar tray icon provides instant access to
recently used archives, your Favorite Zip Folders, WinZip help, and
WinZip itself. Learn about it here.
For answers to Frequently Asked Questions (FAQs), choose
Frequently Asked Questions from WinZip's Help menu.

You can unzip all files from a Zip file without leaving Windows
Explorer. Use the right mouse button to drag and drop a Zip file from
an Explorer window to any folder, then choose Extract to from the
context menu. Be sure to use the right mouse button while dragging.
You can extract from multiple Zip files in one operation. Simply select
two or more Zip files in a Windows Explorer or My Computer window,
right click one of the files, and choose one of the Extract entries in
the WinZip context menu. The best choices for this operation are
usually Extract to or Extract to here using filenames for folders
because both of these entries allow you to use a separate folder for
each Zip file. You can use the other choices, however, if you want to
extract all of the files to a single folder.
You can create Zip files in Windows Explorer: right click in the
Contents pane, then choose New and WinZip File. An empty Zip file
will be created in the current folder.
Mailing your Zip files is easy! If you are using a MAPI-compatible
mail system, you can mail Zip files using the Mail Archive entry in
the WinZip File menu. Or, use the Zip and E-Mail or Zip and E-Mail
Plus features from Windows Explorer's context menu to quickly zip
and e-mail any file.
If you usually use the same folders when opening, extracting, or
adding files, choose Configuration from WinZip's Options menu
and specify the folders in the Folders tab.
You can run your virus scanner on the files inside downloaded Zip
files. Choose Virus Scan from WinZip's Actions menu.
If you need to send files to users who may not have an unzip utility,
try "WinZip Self-Extractor Personal Edition" (included with WinZip).
The self-extractor makes files that unzip themselves. First create a
Zip file, then choose Make .Exe File from the WinZip Actions menu.
To change the default WinZip window size and position to the current
window size and position, choose Save Settings Now from the
Options menu.
To display details about the open Zip file (for example, the date the
Zip file was last modified or the name of the folder containing the Zip
file), click on the WinZip status line or choose Properties from the
WinZip File menu.

You can make a Zip file that spans multiple disks. Simply create a
Zip file on a removable disk, then add to the Zip file as you normally
would. If the disk fills up while files are being added, you will be
prompted for another disk. Just insert the next disk and click the OK
button.
The file listing in the main WinZip window can be quickly sorted by
any of the fields displayed in the file listing. Just click on any column
title to sort on it.
You can quickly extract files from a Zip file by dragging the files from
WinZip to any folder or Windows Explorer window (or even to the
desktop).
You can quickly add files to a Zip file by dragging the files from any
folder or Windows Explorer window to WinZip.
WinZip has many features that make it easy to work with files
downloaded from the Internet and online services like America
Online. For a list of hints, see Hints For Working With Downloaded
Files.
Besides Zip files, WinZip processes many other formats, including
TAR, Z, GZ, TGZ, CAB, UUencode, BinHex, and MIME.
If you can't remember where you put your Zip files, you can use the
Favorite Zip Folders feature to find them. Choose Favorite Zip
Folders from the WinZip File menu.
You can easily view files in a Zip file by dragging them to an
application or a shortcut to an application.
You can easily print files by dragging them to a printer icon or a
shortcut to a printer. (To print a list of files in a Zip file, choose Print
from WinZip's File menu.)
Zip files opened with WinZip are added to the Start menu's
Documents list. To quickly open Zip files that you have recently
worked with, choose Documents from the Start menu.
Note: Windows XP does not display Zip files in the Documents
menu. You can use the WinZip Quick Pick taskbar tray feature to
open recently used archives.
You can add selected files to a Zip file directly from Windows
Explorer with complete control over the options. Right click on any

file (or selected group of files) and choose Add to Zip file from the
context menu.
WinZip can install software, desktop themes, and screen savers
contained in Zip files. To use this feature, simply open a Zip file
containing a software installation (SETUP.EXE or INSTALL.EXE),
theme, or screen saver and click Install.
To open or view multiple files in an archive contents list, hold down
the Ctrl key while clicking the files. Then click the View button on the
toolbar to view the files or right click on any selected file to display
the context menu.
WinZip displays useful information about Zip files you select in
Windows Explorer. The information appears in a tooltip or, if "View as
Web Page" is enabled, in the description area of the web page. The
Windows Desktop Update (Active Desktop) must be installed and
WinZip shell extensions enabled in order to use this feature.
Most of WinZip's major dialogs have "What's This?" help. Click on
the question mark in the dialog's title bar, then click on a control for
quick information about how it's used.
WinZip can automatically display the Zip comment when you open a
Zip file that contains a comment. And, when the open Zip file has a
comment, you can click the comment icon on the status bar to view
and edit the comment.
If you like the look of Internet Explorer's toolbar, you can have the
same look in WinZip. Choose Configuration from WinZip's Options
menu, click the Toolbar tab, and check Use Explorer-style toolbar
buttons and Use flat toolbar buttons. Uncheck Use large toolbar
buttons if you'd also prefer smaller buttons.
Related Topics:
More Hints and Tips
Hints For Working With Downloaded Files
Using the Explorer Interface
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More Hints and Tips
Here are more Hints and Tips:
To switch to another program during an archive operation, click on
the window for the other program, or hold down the Alt key and
press the Tab key repeatedly until the program's icon is selected.
Note: you cannot use the WinZip® system menu or minimize button
during archive operations. However, you can minimize WinZip by
opening the Miscellaneous tab in the Configuration dialog, checking
Display status dialog for long operations, and clicking the dialog's
minimize button.
You can move or copy files from one archive to another by opening
multiple WinZip windows, one for each archive, and dragging files
from one to the other. Note that you need to turn off the Reuse
WinZip Windows entry in the Options pull-down menu in order to
start multiple WinZip windows.
Long Filename Tips
The current versions of most optional external archivers used by
WinZip are DOS programs and do not support long filenames.
Therefore, WinZip will pass the short 8.3 version of all long file and
folder names to these external programs. Since normal 8.3 names
are usually more meaningful than the shortened versions of long
filenames, it is recommended you use standard 8.3 filenames when
working with external archivers.
The exception is ARJ 2.60 and greater, which support long filenames
when running under Windows 95, 98, or Me (but not under Windows
NT, 2000, or XP). If WinZip detects that you are using one of these
ARJ versions and you are using Windows 98, or Me, it will pass long
filenames to ARJ.
MS-DOS programs (other than ARJ 2.60 and greater) and 16-bit
Windows programs usually have trouble with long filenames and files
with spaces in the name. Therefore, it is recommended that you do
not use long filenames and files with spaces in the name if you plan
to work with these files from DOS. For example, LHA.EXE will
extract the file "A Long Filename" as "A LONG F", ignoring the extra

characters. To avoid this problem, check the Store filenames in 8.3
format checkbox in the Add dialog box when adding files.
Related Topics:
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Hints for Working with Downloaded Files
WinZip® makes it easy to work with files downloaded from the Internet
and online services like America Online.
The Install feature makes it easy to install most software distributed
in Zip files: if a Zip file contains a "setup" or "install" program, a
desktop theme, or a screen saver, WinZip can unzip the files, run the
installation program if present, and clean up temporary files. If the
Zip file does not contain any of these, you can use the CheckOut
Feature to try the downloaded file.
The Favorite Zip Folders feature makes locating Zip files you want to
open much easier.
The Downloading and Processing Files with WinZip topic provides
further hints, tips, and helpful procedures.
The Archive Management features make it easy to move archives to
floppies, or to delete them if they don't meet your needs.
Of course, you should always use appropriate caution when using
files downloaded from the Internet. See Security Hints and Tips for
some basic security information to keep in mind when you work with
downloaded files.
To print this page, click the Print button in the toolbar.
One strategy for handling downloaded files involves three folders:
\DOWNLOAD

Recently downloaded files

\UPLOAD

Files you are planning to
upload

\ARCHIVES

Archives you are planning to
keep

A relatively empty download folder makes it much easier to stay
organized. It is a good idea to download all archives into your
\DOWNLOAD folder, and after each on-line session perform the following
steps for each archive:
1. Open the archive. An easy way to open files is to first open the

\DOWNLOAD folder in My Computer or Windows Explorer. Then
double click on an archive to open it. You will probably want to click
on the Modified column header in My Computer or Windows
Explorer so that the most recent files are shown at the top of the list.
2. Read about the software in the archive. Many archives contain a file
named "file_id.diz". By convention this file contains a brief
description of the archive contents. If this file is listed in the main
WinZip window, double click on it to view its contents. When you are
done viewing the file, close the program being used to view the file.
Repeat this process for any files with the word "read" in the filename
(e.g. "readme.txt" or "read.me").
3. Try the software if the archive looks interesting. One easy way to do
this is with the Install or CheckOut buttons on WinZip's toolbar. If the
archive contains an "install" or "setup" program, a desktop theme, or
a screen saver, the Install button will be displayed, otherwise, it will
contain the CheckOut button. Note: downloaded software should
always be scanned for viruses before you install or use it. If you
download archives containing software, you should obtain a reliable
virus scanner, keep it up to date, and always use it on the contents
of such downloaded archives. See the section titled Virus Scanner
Configuration for information on configuring WinZip to use your virus
scanner to test the contents of archives for virus infection.
4. Move each archive out of your download folder after trying the
software. If you want to keep the archive on your hard disk, choose
Move from the Manage Archive submenu of the File menu to move
the archive somewhere else on your disk, such as \ARCHIVES. Note
that the folders you have most recently used for move and copy
operations are available for quick access in a drop-down list. If you
don't want to keep the file you downloaded, you can easily delete it
using the Delete entry in the Manage Archive submenu.
Of course, these are just suggestions. There are other good ways to use
WinZip to work with downloaded files. Feel free to use whatever method
works best for you.
Related Topics:
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Frequently Asked Questions
For more complete and up-to-date FAQs, please visit the WinZip® web
site.
Basic
How do I get started?
Technical
How do I use disk spanning?
How do I compress a folder and later restore it?
How do I view graphic/spreadsheet/word processing files in an archive?
How do I use WinZip to e-mail archives?
Why aren't WinZip's e-mail features working for me?
Non-technical
How do I purchase WinZip?
Do you keep track of address changes?
Related Topics:
Hints and Tips
More Hints and Tips
Hints For Working With Downloaded Files
Using the Explorer Interface

WinZip Standard License
WinZip® Copyright © 1991-2004 by WinZip
Computing, Inc.
All rights reserved.
This license applies to the standard-licensed version of
WinZip. If you have an evaluation version of WinZip, see
the section titled WinZip Evaluation License.

WinZip License
WinZip Computing, Inc.
Your Agreement to this License
This License only applies to the English-language version
of the WinZip 9.0 software and its accompanying files,
data and materials ("WinZip"). You should carefully read
the following terms and conditions before using,
installing, copying, or distributing this software. Unless
you have a different license agreement signed by WinZip
Computing, Inc. ("WCI"), your use, installation, copying,
or distribution of WinZip indicates your acceptance of
this agreement ("License").
If you do not agree to all of the terms and conditions of
this License, then: (a) do not use, install, copy, or
distribute any copy of WinZip with which this License is
included, and (b) in addition, if you paid WCI or an
authorized WCI reseller for a package consisting of one
or more copies of WinZip, you may return the complete
package unused, within thirty (30) days after purchase,
for a full refund of the license fee.
The terms and conditions of this License describe the
permitted use and user(s) of each Licensed Copy of

WinZip. For purposes of this License, if you have a valid
single-copy license, you have the right to use a single
"Licensed Copy" of WinZip; if you or your organization
have/has a valid multi-user license, then you or your
organization have/has the right to use up to a number of
"Licensed Copies" of WinZip equal to the number of
copies indicated in the documents issued by WCI when
granting the license.
Scope of License
Each Licensed Copy of WinZip may either be used by a
single person who uses the software personally on one or
more computers, or installed on a single workstation used
nonsimultaneously by multiple people, but not both. This
is not a concurrent use license.
Each Licensed Copy may be accessed through a network,
provided that you have purchased rights to use a Licensed
Copy for each workstation that will access WinZip
through the network. For instance, if 8 different
workstations will access WinZip on the network, you
must purchase rights to use 8 Licensed Copies of WinZip,
regardless of whether the 8 workstations will access
WinZip at different times, or concurrently.
Each Licensed Copy of WinZip includes WinZip Self-

Extractor Personal Edition, which may be used to create
an unlimited number of freely distributable, royalty-free,
self-extracting Zip files. These self-extracting Zip files
contain, among other things, a portion of WinZip SelfExtractor Personal Edition, including copyrighted
software, proprietary notices, and identifying information
(the "Extraction Software"). You may not alter or modify
the Extraction Software, nor permit anyone else to do so.
All rights of any kind in WinZip which are not expressly
granted in this License are entirely and exclusively
reserved to and by WCI. WinZip is protected by the
United States copyright laws and other applicable laws
and treaties. You may use, install and distribute WinZip
solely as expressly provided in this License. You may not
rent, lease, loan, sublicense, modify, translate, reverse
engineer, decompile, disassemble, or create derivative
works based on, WinZip, nor permit anyone else to do so.
You may not make access to WinZip available to others
in connection with a service bureau, application service
provider, or similar business, nor permit anyone else to
do so.
Warranty Disclaimers and Liability Limitations
WinZip, and any and all accompanying software, files,
data and materials, are distributed and provided "AS

IS" and with no warranties of any kind, whether
express or implied, including, without limitation, any
warranty of merchantability or fitness for a particular
purpose. WCI does not warrant, guarantee, or make any
representations regarding the use of, or the results of
the use of, WinZip. WCI does not warrant that the
operation of WinZip will be uninterrupted or error-free,
or that the use of any passwords and/or encryption
features will be effective in preventing the unintentional
disclosure of information contained in any file. Further,
there is no warranty for the optional virus scanning
feature. (WinZip does not scan for viruses; it simply runs
external programs that claim to perform this function.)
You acknowledge that good data processing procedure
dictates that any program, including WinZip, must be
thoroughly tested with non-critical data before there is
any reliance on it, and you hereby assume the entire risk
of all use of the copies of WinZip covered by this
License. This disclaimer of warranty constitutes an
essential part of this License.
Except to the extent expressly prohibited by applicable
statutes, WCI shall not be liable for any damage or
financial loss arising out of the use of, or inability to
use, WinZip. Any liability of WCI will be limited
exclusively to refund of the license fee paid to WCI.
Except to the extent expressly prohibited by applicable

statutes, in no event shall WCI, or its principals,
shareholders, officers, employees, affiliates, contractors,
subsidiaries, or parent organizations, be liable for any
indirect, incidental, consequential, special, or punitive
damages whatsoever relating to the use of WinZip, or to
your relationship with WCI, (including, without
limitation, loss or disclosure of data or information, loss
of profit, revenue, business opportunity or business
advantage, or business interruption), whether based
upon a claim or action of contract, warranty,
negligence, strict liability, contribution, indemnity, or
any other legal theory or cause of action, even if advised
of the possibility of such damages.
In addition, in no event does WCI authorize you or
anyone else to use WinZip in applications or systems
where WinZip's failure to perform can reasonably be
expected to result in a significant physical injury, or in
loss of property, or in loss of life. Any such use is
entirely at your own risk, and you agree to hold WCI
harmless from any and all claims or losses relating to
such unauthorized use.
Restricted Rights
WinZip is provided with "Restricted Rights". Use,
modification, duplication, release, performance, display,

or disclosure by the U.S. Government or government
contractors is subject to the restrictions set forth in
subparagraph (c)(1) and (2) of the Commercial Computer
Software Restricted Rights clauses at 48 CFR 52.227-19,
and the provisions relating to Rights in Commercial
Computer Software or Commercial Computer Software
Documentation at 48 CFR 227.7202-3.
Export Restrictions
WinZip is subject to certain export restrictions of the
United States Government. If you are (a) in a country to
which export from the United States is restricted for antiterrorism reasons, or a national of any such country,
wherever located, (b) in a country to which the United
States has embargoed or restricted the export of goods or
services, or a national of any such country, wherever
located, or (c) a person or entity who has been prohibited
from participating in United States export transactions by
any agency of the United States Government, then you
may not install, download, access, use, or license WinZip.
By accepting this License, you warrant and represent to
WCI that (1) you do not match the criteria set forth in (a),
(b), or (c) above, (2) that you will not export or re-export
WinZip to any country, person, or entity subject to U.S.
export restrictions, including those persons and entities
that match the criteria set forth in (a), (b), or (c) above,

and (3) that neither the United States Bureau of Industry
and Security, nor any other U.S. federal agency, has
suspended, revoked, or denied your export privileges.
General
This License is the complete statement of the agreement
between the parties on the subject matter, and merges and
supersedes all other or prior understandings, purchase
orders, agreements, and arrangements. This License shall
be governed by the laws of the State of Connecticut,
without regard to Connecticut choice-of-law rules.
Exclusive jurisdiction and venue for all matters relating
to this License shall be in courts and fora located in the
State of Connecticut, and you consent to such jurisdiction
and venue. There are no third-party beneficiaries of any
promises, obligations, or representations made by WCI
herein. Any waiver by WCI of any violation of this
License by you shall not constitute, nor contribute to, a
waiver by WCI of any other or future violation by you of
the same provision, or any other provision, of this
License. If any part of this License or the application
thereof to any person or circumstance is for any reason
held invalid or unenforceable, it shall be deemed
severable, and the validity of the remainder of this
License, or the applications of such provision to other
persons or circumstances, shall not be affected thereby.

WinZip Evaluation License
WinZip® Copyright © 1991-2004 by WinZip
Computing, Inc.
All rights reserved.
This license applies to the evaluation version of WinZip.
If you do not have an evaluation version of WinZip, see
the section titled WinZip Standard License.

WinZip License
Evaluation Version
WinZip Computing, Inc.
Your Agreement to this License
You should carefully read the following terms and
conditions before using, installing, copying, distributing,
or transmitting this software. By using, installing,
copying, distributing, or transmitting WinZip 9.0
("WinZip"), you agree to all of the terms of this
agreement ("License").
Please read the license terms below. If you do not agree
to all of the terms of this License, then do not use, install,
copy, distribute, or transmit WinZip.
Scope of License
This is not free software. Subject to the terms below, you
are hereby licensed by WinZip Computing, Inc. ("WCI")
to use one copy of WinZip, on one (1) computer or
workstation, for evaluation purposes without charge for a
period of 21 days. If you use this software after the 21day evaluation period, a license fee of $29 is required.
Payments must be in U.S. dollars drawn on a U.S. bank,

and should be sent to WinZip Computing, Inc., P.O. Box
540, Mansfield, CT 06268, USA. Use of WinZip after the
21-day evaluation period without payment of the license
fee is a breach of this License and a violation of U.S. and
international copyright laws.
Subject to all of the terms of this License, you may,
without making any payment to WCI:
a. give exact copies of this evaluation version of WinZip
personally to anyone;
b. distribute exact copies of this evaluation version of
WinZip, if done exclusively through electronic
channels; and
c. make as many exact copies of this evaluation version
of WinZip as you wish, for purposes of distribution as
described in (a) and (b) above.
You are specifically prohibited from charging, or
requesting donations, for any copies, however made,
and from distributing such copies with other products of
any kind, commercial or otherwise, without prior
written permission from WCI. WCI reserves the right to
revoke the above distribution rights at any time, for any
or no reason.
Self-extracting Zip files created by WinZip's Self-

Extractor Personal Edition component contain, among
other things, a portion of WinZip Self-Extractor Personal
Edition, including copyrighted software, proprietary
notices, and identifying information (this portion is the
"Extraction Software"). You may not alter or modify the
Extraction Software, nor give anyone permission to do
so. Under no circumstances are you licensed to
distribute self-extracting Zip files created by the
evaluation version of WinZip Self-Extractor.
All rights of any kind in WinZip which are not expressly
granted in this License are entirely and exclusively
reserved to and by WCI. WinZip is protected by the
United States copyright laws and other applicable laws
and treaties. You may not rent, lease, sublicense, modify,
translate, reverse engineer, decompile, disassemble, or
create derivative works based on, WinZip, nor permit
anyone else to do so. You may not make access to
WinZip available to others in connection with a service
bureau, application service provider, or similar business,
nor permit anyone else to do so.
Warranty Disclaimers and Liability Limitations
WinZip, and any and all accompanying software, files,
data and materials, are distributed and provided "AS
IS" and with no warranties of any kind, whether

express or implied, including, without limitation, any
warranty of merchantability or fitness for a particular
purpose. WCI does not warrant, guarantee, or make any
representations regarding the use of, or the results of
the use of, WinZip. WCI does not warrant that the
operation of WinZip will be uninterrupted or error-free,
or that the use of any passwords and/or encryption
features will be effective in preventing the unintentional
disclosure of information contained in any file. Further,
there is no warranty for the optional virus scanning
feature. (WinZip does not scan for viruses; it simply runs
external programs that claim to perform this function.)
You acknowledge that good data processing procedure
dictates that any program, including WinZip, must be
thoroughly tested with non-critical data before there is
any reliance on it, and you hereby assume the entire risk
of all use of the copies of WinZip covered by this
License. This disclaimer of warranty constitutes an
essential part of this License.
Except to the extent expressly prohibited by applicable
statutes, WCI shall not be liable for any damage or
financial loss arising out of the use of, or inability to use,
WinZip. Any liability of WCI will be limited exclusively
to refund of the license fee paid to WCI. Except to the
extent expressly prohibited by applicable statutes, in no
event shall WCI, or its principals, shareholders, officers,

employees, affiliates, contractors, subsidiaries, or parent
organizations, be liable for any indirect, incidental,
consequential, special, or punitive damages whatsoever
relating to the use of WinZip, or to your relationship with
WCI, (including, without limitation, loss or disclosure of
data or information, loss of profit, revenue, business
opportunity or business advantage, or business
interruption), whether based upon a claim or action of
contract, warranty, negligence, strict liability,
contribution, indemnity, or any other legal theory or
cause of action, even if advised of the possibility of such
damages.
In addition, in no event does WCI authorize you or
anyone else to use WinZip in applications or systems
where WinZip's failure to perform can reasonably be
expected to result in a significant physical injury, or in
loss of property, or in loss of life. Any such use is entirely
at your own risk, and you agree to hold WCI harmless
from any and all claims or losses relating to such
unauthorized use.
Restricted Rights
WinZip is provided with "Restricted Rights". Use,
modification, duplication, release, performance, display,
or disclosure by the U.S. Government or government

contractors is subject to the restrictions set forth in
subparagraph (c)(1) and (2) of the Commercial Computer
Software Restricted Rights clauses at 48 CFR 52.227-19,
and the provisions relating to Rights in Commercial
Computer Software or Commercial Computer Software
Documentation at 48 CFR 227.7202-3.
Export Restrictions
WinZip is subject to certain export restrictions of the
United States Government. If you are (a) in a country to
which export from the United States is restricted for antiterrorism reasons, or a national of any such country,
wherever located, (b) in a country to which the United
States has embargoed or restricted the export of goods or
services, or a national of any such country, wherever
located, or (c) a person or entity who has been prohibited
from participating in United States export transactions by
any agency of the United States Government, then you
may not install, download, access, use, or license WinZip.
By accepting this License, you warrant and represent to
WCI that (1) you do not match the criteria set forth in (a),
(b), or (c) above, (2) that you will not export or re- export
WinZip to any country, person, or entity subject to U.S.
export restrictions, including those persons and entities
that match the criteria set forth in (a), (b), or (c) above,
and (3) that neither the United States Bureau of Industry

and Security, nor any other U.S. federal agency, has
suspended, revoked, or denied your export privileges.
General
This License is the complete statement of the agreement
between the parties on the subject matter, and merges and
supersedes all other or prior understandings, purchase
orders, agreements, and arrangements. This License shall
be governed by the laws of the State of Connecticut,
without regard to Connecticut choice-of-law rules.
Exclusive jurisdiction and venue for all matters relating
to this License shall be in courts and fora located in the
State of Connecticut, and you consent to such jurisdiction
and venue. There are no third-party beneficiaries of any
promises, obligations, or representations made by WCI
herein. Any waiver by WCI of any violation of this
License by you shall not constitute, nor contribute to, a
waiver by WCI of any other or future violation by you of
the same provision, or any other provision, of this
License. If any part of this License or the application
thereof to any person or circumstance is for any reason
held invalid or unenforceable, it shall be deemed
severable, and the validity of the remainder of this
License, or the applications of such provision to other
persons or circumstances, shall not be affected thereby.

WinZip 9.0 Ordering Information
The following information is for the English language
version of WinZip®. All orders are subject to the WinZip
License Agreement.
To Order WinZip Now
To order online and download your order immediately, go
to the WinZip web site at:
http://www.winzip.com/order.cgi
You can also use our web site to order copies of WinZip
on CD for delivery by postal mail.
Other Ordering Options
In addition to ordering online, you can also place orders
in the following ways. These orders will be shipped by
postal mail (airmail outside the U.S.) and will leave our
office within two business days after the order is
received:
Credit card orders by phone
Credit card orders by fax or mail

Ordering by check
Purchase orders

WinZip Pricing
WinZip Single-User License:
WinZip Site Licenses:
2 to 9 computers:
10 to 24 computers:
25 to 49 computers:
50 to 99 computers:
100 to 199 computers:
200 to 499 computers:
500 to 749 computers:

$29
$22 per computer
$17 per computer
$14 per computer
$10 per computer
$7 per computer
$6 per computer
$4 per computer

If you need a quote for higher quantities, please send a
message to sitesales@winzip.com.
There is a $5.00 per order charge for shipping and
handling. Prices are in U.S. dollars and are guaranteed
through December, 2004.
Site Licenses
The WinZip site license from WinZip Computing is for
the English language version of WinZip. A site license
for WinZip entitles your organization to receive one copy
of the distribution package and to duplicate the software
as necessary for use within your organization on the
specified number of computers.

The WinZip site license is only for use within your own
organization. For example, you cannot give or sell any of
your site-licensed copies of WinZip to your customers, or
include site-licensed copies of WinZip in products that
you sell.
The WinZip site license is not a concurrent user license.
Each copy of WinZip may either be used by a single
person who uses the software personally on one or more
computers, or used on a single workstation used nonsimultaneously by multiple people, but not both.
If you have further questions, please send a message to
sitesales@winzip.com.
German, French, and Japanese Versions
There are German and French language versions of
WinZip. For Japanese users there is an English version
with the Help file in Japanese. Click here for additional
information.

WinZip 9.0 Order Form/Invoice
To print this order form, click the Print button in the
toolbar.
To order by check, send this completed order form and a
check (in U.S. dollars drawn on a U.S. bank) to WinZip
Computing, Inc., PO Box 540, Mansfield, CT 06268
USA.
All orders are subject to the WinZip® License
Agreement. Customer information is considered
confidential and will not be shared with or distributed to
any third party. This order form applies only to the
English language version of WinZip. Prices are in U.S.
dollars and are guaranteed through December, 2004.
For international orders, customer shall be deemed the
importer for all purposes, and shall be responsible for all
customs duties and clearance charges. Customer shall
also be responsible for all other duties, levies, or
government fees or taxes now in force or enacted in the
future including, for example, any value-added taxes.
WinZip Single-User License (on CD) _____ copies at
WinZip Site Licenses (includes one distribution CD):

$29 each = __________

2 to 9 computers: _____ computers at $22 each
10 to 24 computers: _____ computers at $17 each
25 to 49 computers: _____ computers at $14 each
50 to 99 computers: _____ computers at $10 each
100 to 199 computers: _____ computers at $7 each
200 to 499 computers: _____ computers at $6 each
500 to 749 computers: _____ computers at $4 each
Add $5.00 shipping and handling
Connecticut residents add 6% sales tax
Total payment US$

=
=
=
=
=
=
=
+
+

__________
__________
__________
__________
__________
__________
__________
$5.00
__________
__________

If you need a quote for higher quantities, please send a
message to sitesales@winzip.com
Date:
Name:
Company:
Shipping address:
City, State, Zip, Country:
Billing address:
(if different from above)
City, State, Zip, Country:
Phone:
Fax:
E-mail address:
Credit card (circle one):
Credit card number:
Expiration date:
Name on card:
Signature:

______________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
MasterCard
Visa
AmEx
Discover
______________________________________________
______________________________________________
______________________________________________
______________________________________________

WinZip 9.0 Fax/Mail Credit Card
Order Form
To print this order form, click the Print button in the
toolbar.
To order with a credit card by fax or mail, please
complete this credit card order form and send it to:
Fax: 1-860-429-3542
Mail: WinZip Computing, Inc., PO Box 540, Mansfield, CT 06268 USA

All orders are subject to the WinZip® License
Agreement. Customer information is considered
confidential and will not be shared with or distributed to
any third party. This order form applies only to the
English language version of WinZip. Prices are in U.S.
dollars and are guaranteed through December, 2004.
Note: You can also order by phone using your credit card.
WinZip Single-User License (on CD) _____ copies at
$29 each
WinZip Site Licenses (includes one distribution CD):
2 to 9 computers: _____ computers at $22 each
10 to 24 computers: _____ computers at $17 each
25 to 49 computers: _____ computers at $14 each
50 to 99 computers: _____ computers at $10 each
100 to 199 computers: _____ computers at $7 each

= __________
=
=
=
=
=

__________
__________
__________
__________
__________

200 to 499 computers: _____ computers at $6 each
500 to 749 computers: _____ computers at $4 each
Add $5.00 shipping and handling
Connecticut residents add 6% sales tax
Total payment US$

= __________
= __________
+
$5.00
+ __________
__________

If you need a quote for higher quantities, please send a
message to sitesales@winzip.com
Date:
Name:
Company:
Shipping address:
City, State, Zip, Country:
Billing address:
(if different from above)
City, State, Zip, Country:
Phone:
Fax:
E-mail address:
Credit card (circle one):
Credit card number:
Expiration date:
Name on card:
Signature:

______________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
______________________________________________
MasterCard
Visa
AmEx
Discover
______________________________________________
______________________________________________
______________________________________________
______________________________________________

WinZip 9.0 Credit Card Orders by
Phone
You can place credit card orders by phone at 1-877-7244600 (toll free; US only), or 1-860-429-4649.
WinZip Computing, Inc. cannot be reached at the phone
numbers above. These numbers are for our credit card
order handling service only. If you have questions about
WinZip®, or need WinZip technical support, you can
send e-mail to help@winzip.com; our goal is to respond
to all e-mail inquiries within one business day.
WinZip Single-User License:
WinZip Site Licenses:
2 to 9 computers:
10 to 24 computers:
25 to 49 computers:
50 to 99 computers:
100 to 199 computers:
200 to 499 computers:
500 to 749 computers:

$29
$22 per computer
$17 per computer
$14 per computer
$10 per computer
$7 per computer
$6 per computer
$4 per computer

There is a $5.00 per order charge for shipping and
handling. If you need a quote for higher quantities, please
send a message to sitesales@winzip.com.

Your order will be shipped by postal mail (airmail outside
the U.S.) and will leave our office within two business
days after the order is received.
All orders are subject to the WinZip License Agreement.
Customer information is considered confidential and will
not be shared with or distributed to any third party. This
order information applies only to the English language
version of WinZip. Prices are in U.S. dollars and are
guaranteed through December, 2004.

Purchase Orders
Purchase orders (net 30 days, subject to credit approval)
are accepted from government and accredited educational
institutions, and from corporations, provided that they are
submitted on purchase order forms with a purchase order
number. Please include a completed Order Form with
your purchase order and fax it to 1-860-429-3542 or mail
it to:
WinZip Computing, Inc.
PO Box 540
Mansfield, CT 06268 USA

German, French, and Japanese
Versions
There are German and French language versions of
WinZip®. For Japanese users there is an English version
with the help file in Japanese. Prices for these versions
may vary from the prices for the English language
version as purchased from WinZip Computing, Inc.
For more information on the German version of WinZip,
please visit our web site at
http://www.winzip.com/german.htm.
For more information on the French version of WinZip,
please visit our web site at
http://www.winzip.com/french.htm.
For more information on the Japanese version of
WinZip, please visit our web site at
http://www.winzip.com/japan.htm.

Support and Questions
To check whether you have the most recent version of
WinZip®, please check the WinZip home page at
http://www.winzip.com.
Please see the section titled Frequently Asked Questions
for answers to common questions.
Technical support is available at no charge as described
below. The best way to report problems is with the
support forms available from the "Support" link on the
WinZip home page (http://www.winzip.com). You can
also send e-mail to help@winzip.com or postal mail to
WinZip Computing, Inc., P.O. Box 540, Mansfield CT
06268.
When reporting problems, please include the following
information:
1. Is the problem reproducible? If so, how?
2. What version of Windows are you running (Windows
98, Windows 2000, etc.)?
3. What version of WinZip are you running? (To see
what version of WinZip you have, choose About
WinZip from the Help menu.) Please include the

entire "version" line in your problem report.
4. If a dialog box with an error message was displayed,
please include the full text of the dialog box,
including the text in the title bar.
5. If the problem involves an external program like
LHA.EXE or SCAN.EXE, what version of the failing
program are you using? Please see the section titled
System Requirements for minimum version numbers
for these programs.
Note: You can press F1 at any time while WinZip is
active for context sensitive help.
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Program Locations (Configuration)
Select the Program Locations tab from the Configuration Dialog Box to
specify the paths and filenames for the optional external programs
supported by WinZip®. Note that these programs are not required for
most operations involving Zip files.
If you are installing WinZip and are not familiar with these programs you
can just press the OK button to continue the installation procedure.
External programs are not distributed with WinZip. For more information
on these programs, including availability and minimum version numbers,
see the section titled System Requirements. For step-by-step installation
examples for external archivers see the section titled Installing Optional
External Programs. See the section titled Virus Scanner Configuration for
information about that portion of the dialog box.
If a program is not installed on your system, just leave the corresponding
field blank. Otherwise, fill in the program name. The extension defaults to
EXE. If no path is included for an entry, WinZip assumes that the
program is in a folder specified in your system's PATH.
The program specified as the Default association is used when viewing
a file that does not have an association. For additional information on
associations, see the section titled Windows Associations. The defaults
for this field are:
Quick View (quikview.exe), if you use Windows 98 or Windows NT
4.0 and you have installed this optional Windows component. If you
have one of these Windows versions and Quick View does not
appear here, you may be able to install it.
SCCVAPI.EXE, System Compatibility Corporation's "Outside In" file
viewer, if it is found in a folder specified by your system's PATH.
NVIEWER.EXE, the Norton Desktop for Windows File Viewer, if it is
found in a folder specified by your system's PATH.
WNFV.EXE, the PC Tools for Windows File Viewer, if it is found in a
folder specified by your system's PATH.
NOTEPAD.EXE, the Windows Notepad program, if NVIEWER and
WNFV are not found.

The entry for the Optional virus scanner could have any of these values
(the filenames shown are examples):
Value

Description

(blank)

If the entry is blank, WinZip
assumes that no virus scanner
is installed on your system.

SCANNER.EXE

Just the filename is needed if
the specified file
(SCANNER.EXE, in this
example) is in a folder specified
in your system's PATH.

The full drive, folder, and
filename are required if the
specified file (SCANNER.EXE,
in this example) is not in a
C:\SCANNER\SCANNER.EXE folder specified in your
system's PATH. Note that
C:\SCANNER is just an
example, any other folder can
be used.
The ARJ, LHA, and ARC file formats require external programs to be
available for them to be handled using WinZip. You can type the names
of these programs, or use the browse button to locate them. If they are
not available on your system, leave the fields blank. They are only
necessary if you use these other archive formats and want WinZip to
handle them for you.
See the section titled System Requirements for more information on
version numbers and availability of the external programs supported by
WinZip.
Note: When WinZip is installed it will attempt to locate the default
programs for each field in the folders specified by your system's PATH. If
it cannot find these programs, it will leave the corresponding edit fields
blank.
Related Topics (other Configuration tabs):
View Toolbar Folders System Explorer Enhancements

Miscellaneous

Brief Tutorial - Introducing WinZip
Click on each tutorial topic, in sequence, to learn all about WinZip®:
1.
Introducing
WinZip

2. The WinZip
3. Opening
Window
Archives

4. Viewing
Files

5. Extracting
Files

6. Creating
New Archives

7. Adding
Files

8. Deleting
Files

9. Custom
Configurations

10.
Additional
Features
WinZip is a tool to make working with Zip files and other types of archive
files easier. Let's start off by discussing some of the words used to
describe the files and the processes.
Archives are files that contain other files, and Zip files are the most
common archive format. Typically, the files in an archive are compressed.
WinZip uses the term "Add" to mean "compress files and add them to an
archive". "Extract" means "decompress files in an archive, creating
separate files on a disk". Some people use the verbs "zip" or "pack"
instead of Add, and "unzip" or "unpack" instead of "extract".
See About Zip Files and Other Archives for more detailed information.
<Back Next>

Brief Tutorial - The WinZip Window
Click on each tutorial topic, in sequence, to learn all about WinZip®:
1.
Introducing
WinZip

2. The WinZip
3. Opening
Window
Archives

4. Viewing
Files

5. Extracting
Files

6. Creating
New Archives

7. Adding
Files

8. Deleting
Files

9. Custom
Configurations

10.
Additional
Features
The WinZip window is where you start many of your operations. You can
open it through the Start menu. The WinZip window also opens
automatically if you double click on an archive in My Computer or
Windows Explorer.
The WinZip window includes standard Windows components. Of
particular interest:
The Title Bar displays not just the WinZip product title, but the name of
the archive you are currently working with. The Toolbar provides quick
ways of performing the most common tasks. The Main Window Area
displays information about the files in the archive, and you'll find as we
get further into this Tutorial that many operations can be done directly
with these files. Finally, the Status Line displays the number and sizes of
currently selected files, along with other archive information.
<Back Next>

Brief Tutorial - Opening Archives
Click on each tutorial topic, in sequence, to learn all about WinZip®:
1.
Introducing
WinZip

2. The WinZip
3. Opening
Window
Archives

4. Viewing
Files

5. Extracting
Files

6. Creating
New Archives

7. Adding
Files

8. Deleting
Files

9. Custom
Configurations

10.
Additional
Features
The first step is to open an archive. Use the Open toolbar button or
select Open Archive from the WinZip File pull-down menu to activate
the standard Open Archive dialog box.
Then, select the archive you want to open in the Open Archive dialog
box. This dialog box works just like the Open dialog boxes in other
applications: just select the file you want to open from the list of files. (If
you want to create an archive instead of working with an existing archive,
see the section Brief Tutorial - Creating New Archives).
Once an existing archive is open you can extract or work with the files in
the archive. The files in an archive are listed in a list box in the main
WinZip window.
You can look at all the file names, with details, stored in the archive,
using the scroll bar, arrow keys or usual Windows commands.
You can quickly sort the main window by clicking once on the header
(e.g. click on "Name" in the header above the list of files to sort the
list by filename).
<Back Next>

Brief Tutorial - Viewing Files
Click on each tutorial topic, in sequence, to learn all about WinZip®:
1.
Introducing
WinZip

2. The WinZip
3. Opening
Window
Archives

4. Viewing
Files

5. Extracting
Files

6. Creating
New Archives

7. Adding
Files

8. Deleting
Files

9. Custom
Configurations

10.
Additional
Features
You can easily view any of the files stored in an archive by double
clicking on the file in the main WinZip window. WinZip will open the file
with the associated application. For example, a Word (.doc) file may be
displayed in Word, and a text (.txt) file in Notepad. When you double click
on a program file (.exe), it is run.
Or, you can view a file with the built-in viewer or a viewer of your choice
by selecting View from the Actions pull-down menu.
<Back Next>

Brief Tutorial - Extracting Files
Click on each tutorial topic, in sequence, to learn all about WinZip®:
1.
Introducing
WinZip

2. The WinZip
3. Opening
Window
Archives

4. Viewing
Files

5. Extracting
Files

6. Creating
New Archives

7. Adding
Files

8. Deleting
Files

9. Custom
Configurations

10.
Additional
Features
When you extract a file, WinZip decompresses it and places it in the
folder of your choice. You can restore whole folders and retain the
structure of any sub-folders.
If you select Extract from the Actions pull-down menu or click the
Extract toolbar button, WinZip lets you choose the folder where you'd
like to place the extracted files. For more details on that dialog box and
its options, press F1 later, when you encounter it, or click on Extracting
Files from an Archive now.
Note: if a Zip file contains a "setup" or "install" program, you can use the
Install Feature to automatically extract the files, run the installation
program, and clean up temporary files.
<Back Next>

Brief Tutorial - Creating New Archives
Click on each tutorial topic, in sequence, to learn all about WinZip®:
1.
Introducing
WinZip

2. The WinZip
3. Opening
Window
Archives

4. Viewing
Files

5. Extracting
Files

6. Creating
New Archives

7. Adding
Files

8. Deleting
Files

9. Custom
Configurations

10.
Additional
Features
You can create a new archive by selecting New Archive from the WinZip
File pull-down menu or by clicking the New toolbar button. This activates
the New Archive dialog box.
First, you type the name of the archive you want to create, not the names
of the files you want to compress. This dialog box works similarly to
standard Windows file dialog boxes, so you can choose the drive and
folder where the archive will be created. The names of any existing
archives on the selected drive and folder are listed to help you choose a
name that is not already in use.
Normally after creating an archive you will want to add files to the
archive, so verify that the Add dialog check box is checked to
automatically activate the Add dialog box.
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Brief Tutorial - Adding Files to an Archive
Click on each tutorial topic, in sequence, to learn all about WinZip®:
1.
Introducing
WinZip

2. The WinZip
3. Opening
Window
Archives

4. Viewing
Files

5. Extracting
Files

6. Creating
New Archives

7. Adding
Files

8. Deleting
Files

9. Custom
Configurations

10.
Additional
Features
You can add files to an existing archive you've opened or to a new
archive you've created, as in the previous section. If the Add dialog box is
not displayed, select Add from the Actions pull-down menu or click the
Add toolbar button.
In the Add dialog box, select the files you want to add to the archive. The
easiest way to do this is usually to click on the desired files in the list near
the top of the Add dialog box. You can select multiple files using normal
Windows file selection conventions (for example, hold down the shift key
while clicking to select multiple files). For details on alternate ways to
specify which files you want to add, see the topic titled Adding Files to an
Archive.
Once you are done making your file selection, click the Add button to add
the files. Once WinZip finishes, it will update the file list in the main
window to reflect the new files in the archive.
You can also add files to an archive by dragging the files from My
Computer or Windows Explorer and dropping them on the WinZip
window using the drag and drop interface.
Note: When you add files to an archive, the original files on disk are not
deleted. If you want to delete the original files automatically after the Add

operation completes, select Move (and replace) files from the Action
combo box.
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Brief Tutorial - Deleting Archives and
Files
Click on each tutorial topic, in sequence, to learn all about WinZip®:
1.
Introducing
WinZip

2. The WinZip
3. Opening
Window
Archives

4. Viewing
Files

5. Extracting
Files

6. Creating
New Archives

7. Adding
Files

8. Deleting
Files

9. Custom
Configurations

10.
Additional
Features
WinZip can remove selected files from within an existing archive, or
delete the entire archive. Delete from the Actions menu activates the
Delete dialog box. There are two ways to start the action to delete files
from an archive:
Select entries from the list box in an open archive, then choose the
Delete entry from the Actions pull-down menu or press the Del key.
Choose the Delete entry from the Actions menu to bring up the
Delete dialog box. You can then specify the file names you want to
delete (standard Windows wildcards are accepted, so you could use
"*.doc" to delete all .doc files).
Note: these operations cannot be undone.
To delete an entire archive, choose Delete from the Actions menu to
bring up the Delete dialog. Then choose the All files/folders in archive
option and click Delete. Alternatively, you can choose Delete from the
Manage Archive submenu of the File menu.
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Brief Tutorial - Custom Configurations
Click on each tutorial topic, in sequence, to learn all about WinZip®:
1.
Introducing
WinZip

2. The WinZip
3. Opening
Window
Archives

4. Viewing
Files

5. Extracting
Files

6. Creating
New Archives

7. Adding
Files

8. Deleting
Files

9. Custom
Configurations

10.
Additional
Features
Many WinZip operations can be tailored using configuration options. For
example, you can change the default folders for the Extract and Add
dialog boxes. Most options are intended for advanced users. For an
overview of available options see the section titled Options.
<Back Next>

Brief Tutorial - Additional Features
Click on each tutorial topic, in sequence, to learn all about WinZip®:
1.
Introducing
WinZip

2. The WinZip
3. Opening
Window
Archives

4. Viewing
Files

5. Extracting
Files

6. Creating
New Archives

7. Adding
Files

8. Deleting
Files

9. Custom
Configurations

10.
Additional
Features
This is the end of the Brief Tutorial. As you get to know WinZip better, be
sure to explore the following more advanced features:
WinZip's Drag and Drop operations simplify archiving.
Internet, America Online, and other online services users: see
Downloading and Processing Files with WinZip.
The Install and Checkout features make it easy to try software
distributed in archives.
Using WinZip's Explorer interface, you can access most WinZip
functionality directly from Windows Explorer or My Computer
shortcut menus, from the Start menu, or from the desktop. See
Explorer Interface for details.
Reminder: press the F1 key at any time while working with WinZip for
context-sensitive help.
You may want to review the tutorial and explore some of the many links it
contains by pressing the buttons above.
<Back

The WinZip Tutor
The WinZip® Tutor should automatically open in a
separate window.
If the Tutor does not open, you may be encountering
Windows security restrictions and will need to open the
Tutor directly. To do this:
1. Close this help window.
2. Open My Computer or Windows Explorer and
navigate to the WinZip folder (usually C:\Program
Files\WinZip).
3. Locate the file named WZTUTOR.HLP and double
click it.
To return to the previous topic, click the Back button
above.

Downloading from the Internet
You can use WinZip® to work with archives you
download from the Internet just as you do with other
archives.
If you download an archive, the current versions of
Microsoft Internet Explorer and Netscape
Navigator/Communicator will give you a choice of
opening the archive or saving it to disk. If you choose to
open the archive, you should be aware that the Internet
browser will probably delete the file when the browser is
closed. To avoid this problem, use the Internet browser's
"save to disk" option, and specify an easy-to-remember
folder, for example, c:\download.
Problems Downloading? When you download a file,
many things can go wrong, resulting in a damaged copy
of the file that WinZip cannot open. The solution to
most download-related problems is simply to
download the file again. For more information on
resolving Internet download-related problems, please
check the web page
http://www.winzip.com/downprob.htm.
Note:

Many files available for download on the Internet are
executable (.exe) files. If the .exe file is a self-extracting
Zip file, you can open and process it in the WinZip
Classic interface by choosing Open Archive from the
File menu, or by right-clicking on the file and choosing
Open with WinZip.
Related Topics:
Downloading from America Online and other online
services
Hints For Working With Downloaded Files

Downloading from America Online
and other online services
An online service with its own access software will
generally have a specific folder on your computer where
newly downloaded files are placed. After you download a
Zip file from an online service in the normal manner, it's
easy to use WinZip® to open and process the file.
Start WinZip by clicking on its icon, then click the
Favorites toolbar button or choose Favorite Zip Folders
from the File pull-down menu. The resulting dialog box
shows all the Zip files in your Favorite Zip Folders with
the most recently downloaded files at the top of the list,
along with the folder in which they are located.
If your file or the special download folder is not shown,
you can have WinZip search for the item by clicking on
the Search button, then clicking Search hard disk(s) on
this PC, and then clicking OK. WinZip will check all
your hard drives and make a new list of Zip files, and
update your favorite folders (the places where WinZip
has found Zip files stored on your PC). When the process
is complete, newly downloaded files should be near or at
the top of the list. Highlight the file you wish to work

with to continue with the Wizard's unzipping process.
See Hints For Working With Downloaded Files for more
suggestions.
Note:
Many files available for download on the Internet are
executable (.exe) files. If the .exe file is a self-extracting
Zip file, you can open and process it in the WinZip
Classic interface by choosing Open from the File menu,
or by right-clicking on the file and choosing Open with
WinZip.
Related Topics:
Downloading from the Internet

Sending Files using Internet Mail
If you have a direct connection to the Internet, you may already be using
an e-mail program that allows you to attach files to messages. However,
many e-mail programs, including MSMail, cannot easily transfer files to
Internet addresses. WinZip® allows you to send and receive files using
nearly any e-mail program, including MSMail.
Note: If your e-mail program does have the ability to transfer files,
consider using WinZip to compress them before transfer -- it will usually
take far less time since the file will be smaller. If the recipients are
unfamiliar with Zip files, you can use WinZip to create a self-extracting
archive for their convenience.
UUencoded, XXencoded, BinHex, and MIME files
Sending Files using Internet Mail
The Why behind UUencoding and Other Schemes
Receiving and Preparing Files for Decoding
Decoding Files using WinZip
UUencoding a File using WinZip
Mailing a UUencoded File
Hints, Tips, & Troubleshooting
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The Why behind UUencoding and Other
Schemes
Some Internet protocols were not designed to carry binary (program and
other non-text files) files. They are able only to transfer messages made
up of conventional text (printable ASCII) characters. In order to get
around that limitation, UUencode and other methods were created.
These solutions all perform the same basic operation: they encode the
non-transferable binary file into ASCII characters that the e-mail system
can handle. The person receiving the message can then decode the
strings of characters to recreate the original file. Perhaps you have seen
one of these completely unintelligible messages; here's an example:
_=_
_=_ Part 001 of 001 of file encoded.txt
_=_

begin 666 encoded.txt
M5&5S="$-"@T*1V5N=&QE(%)E861E<CH"@T*5&AI<R!I<R!N;W1H:6YG(&UO
M<F4@=&AA;B!A('1E<W0@9FEL92!C<F5A=&5D('1O('!R;W9I9&4@9F]D9&5R
M(&9O<B!T:&4@=F%R:6]U<R!E;FO9&EN9R!S8VAE;65S+B!)9B!Y;W4@87)E
M('5S:6YG(&ET('1O('1E<W0L(&O;F=R871U;&%T:6]N<R!O;B!Y;W5R(&%G
M:6QI='D@:6X@8W5T=&EN9RP@<&%S=&EN9RP@<V%V:6YG+"!A;F0@9&5C;V1
:;F<@=7-I;F<@5VEN6FEP+@T*#0I%;FIO>2$`
`
end
WinZip® can easily open and extract UUencoded, XXencoded, BinHex,
and MIME files (base64, plain/text, and quoted-printable) that have been
sent to you, and create Uuencoded files for you to send.
UUencoded, XXencoded, BinHex, and MIME files
Sending Files using Internet Mail

The Why behind UUencoding and Other Schemes
Receiving and Preparing Files for Decoding
Decoding Files using WinZip
UUencoding a File using WinZip
Mailing a UUencoded File
Hints, Tips, & Troubleshooting
<Back Next>

Receiving and Preparing Files for
Decoding
The message you receive with an encoded file will need to be prepared
for the simple WinZip® decoding operation. The steps you take will
depend on the e-mail program you are using.
For example, if you are using MSMail:
1. Highlight the message (DO NOT open it; large messages are not
handled well by MSMail).
2. Select Save As from the File menu item.
3. Enter a file name using .UUE as the extension; for example:
FILENAME.UUE.
If you are using another e-mail program, a method similar to the above
may also work with your program. Be aware that some e-mail programs
may crash or cut off parts of unusually large messages, so saving them
as files without opening them is the preferred method.
Your e-mail program may save a message attachment as an external file
in a folder designated to receive them. In that case, it may automatically
be named; you may wish to rename it, using a .UUE extension, for
maximum convenience.
Sometimes you may receive multiple messages, where a file is split up
into more than one message because of size limitations. You will need to
use a text editor or the DOS COPY file command to paste the files
together into one large file, and save it as a text file with a .UUE
extension.
UUencoded, XXencoded, BinHex, and MIME files
Sending Files using Internet Mail
The Why behind UUencoding and Other Schemes
Receiving and Preparing Files for Decoding
Decoding Files using WinZip
UUencoding a File using WinZip

Mailing a UUencoded File
Hints, Tips, & Troubleshooting
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Decoding Files using WinZip
You do not need to worry if the file being received is UUencoded,
XXencoded, BinHex, or a MIME file (base64, plain/text, and quotedprintable). WinZip® will detect the method being used and automatically
decode it.
As is the case with Zip files, WinZip offers more than one way to open
encoded files. For example:
Double click the encoded file in My Computer or Windows Explorer.
WinZip will open and decode the file. If it is a Zip file, it will offer to
open it; if it has not been compressed, it will be shown in the usual
manner.
Drag and drop the encoded file onto the WinZip icon.
Use WinZip in the regular manner to Extract the file to your folder of
choice.
Note: You can also open a file using WinZip's Open toolbar button, or
drag and drop a file into WinZip, regardless of the file's extension.
UUencoded, XXencoded, BinHex, and MIME files
Sending Files using Internet Mail
The Why behind UUencoding and Other Schemes
Receiving and Preparing Files for Decoding
Decoding Files using WinZip
UUencoding a File using WinZip
Mailing a UUencoded File
Hints, Tips, & Troubleshooting
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UUencoding a File using WinZip
WinZip® UUencodes Zip files for mailing, so you must choose and open
an existing Zip file to encode or create a new one.
If the file is already archived as a Zip file, open it in WinZip using
your favorite method.
If the file(s) you wish to send are not already archived, use WinZip to
create a Zip file, and leave the program open for the next step.
Click the Actions menu item, and choose UUencode.
A UUencoded file has been created from your Zip file. For example, you
will find a TESTFILE.UUE file in the same folder along with your original
TESTFILE.ZIP.
UUencoded, XXencoded, BinHex, and MIME files
Sending Files using Internet Mail
The Why behind UUencoding and Other Schemes
Receiving and Preparing Files for Decoding
Decoding Files using WinZip
UUencoding a File using WinZip
Mailing a UUencoded File
Hints, Tips, & Troubleshooting
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Mailing a UUencoded File
Note: most modern e-mail programs automatically encode attachments
when necessary, so you will not need to. If, however, you are using an
older e-mail program that does not automatically encode attachments,
the following information could be useful. Please read about UUencoding
if you are not familiar with encoded files and why they are used.
To send a UUencoded attachment, first UUencode the attachment using
WinZip®, then attach it to your message. How you attach a UUencoded
file to a message will depend on your e-mail program.
For example, if you are using MSMail:
1. Create a message in the usual manner.
2. Click on the menu item Attach and select File.
3. Use the familiar file dialogs to choose the .UUE file you created
previously, then click OK.
4. E-mail your message as you would normally.
If you are using another e-mail program, a method similar to the above
may also work with your program. A "Send File" or similar option may be
available and of use in this situation. It may be necessary to open the
.UUE file you have created using a text editor, copy the entire contents,
or portions of it, to the Windows clipboard, and paste it into your open email message. Further information on handling large files is included in
the next topic, Hints, Tips, & Troubleshooting.
UUencoded, XXencoded, BinHex, and MIME files
Sending Files using Internet Mail
The Why behind UUencoding and Other Schemes
Receiving and Preparing Files for Decoding
Decoding Files using WinZip
UUencoding a File using WinZip
Mailing a UUencoded File
Hints, Tips, & Troubleshooting
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Hints, Tips, & Troubleshooting
WinZip® makes decoding these file attachments very convenient. Here
are some hints to make the road even smoother:
The most common problems we encounter with files that cannot be
decoded are incomplete data and missing header information. The
integrity of the message is critical, and the header must be intact for
decoding. We have included short examples of each of the following
encoding formats. You may find them helpful for comparison purposes
with messages you receive, to confirm that they appear properly encoded
and are not missing header and closing data. Click to review any of these
brief file examples.
UUencoded Example XXencoded Example BinHex Example MIME
(base64) Example
Multi-Part Encoded Files must be combined before WinZip can process
them. If you encounter encoded data spread across multiple files, you
can either combine the parts using a text editor, and then open them with
WinZip, or you can use another program, like the UUDeview package
from Frank Pilhofer. (WinZip's decoding subroutines are based on the
UUDeview package.) The original UUDeview is a text mode command
line driven program, or you can download a Windows interface by
Michael Newcomb. These free programs are available from Internet sites
in Germany and the USA.
Further information about encoding files can be found in many places
on the Internet. A good place to start is the "Introduction to Decoding"
article from the UUDeview home page. The MIME specification is defined
in RFC 1521, and is widely available on the Internet.
Bug Reporting: If, after examining and confirming that a file seems
properly encoded, you believe that WinZip should handle it, please
contact WinZip support. Send e-mail to support@winzip.com with details,
and include a Zip file of the file so that it is not changed by any mail
gateways or e-mail program. Do not remove any header or other
information. Please include the name of the program that created it, if
possible. Smaller files are preferred over huge sample files. We will
examine the file and respond as soon as possible.

UUencoded, XXencoded, BinHex, and MIME files
Sending Files using Internet Mail
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Zip and E-Mail Plus
The Zip and E-Mail Plus dialog allows you to specify the filename to be
used for a Zip file that WinZip® creates and attaches to the new e-mail
message. It also allows you to specify an encryption method and
password if desired (please read about encryption).
To use Zip and E-Mail Plus, simply select files or folders in a My
Computer or Windows Explorer window, right click on any selected item,
and choose Zip and E-Mail Plus from the WinZip Explorer context menu.
When the dialog appears:
1. Choose the name to be used for the Zip file. You can accept the
suggested name, or you can specify a name of your own by clicking
Use this name and typing in the desired name. Don't specify a
folder name, because the Zip file is temporary and will be created in
a temporary folder.
2. Check the Encrypt Zip file check box if you want to encrypt the Zip
file.
3. Click OK.
If you've chosen to encrypt the Zip file, a second dialog will appear that
allows you to specify the encryption method and password. Then WinZip
compresses the selected items into a temporary Zip file, creates a new email message, and attaches the temporary Zip file to the message. You
can address the message, add any desired text, and send it as you
normally would. WinZip automatically deletes the temporary Zip file when
it is no longer needed.
See also
About Encryption

Why aren't WinZip's e-mail features
working for me?
WinZip® support for e-mailing archives requires that you
have an e-mail program installed and properly
configured. If there is a problem with your e-mail
configuration, then these features will either be disabled
or nonfunctional.
WinZip uses a Windows feature called MAPI (Mail
Applications Program Interface) to "talk" to your e-mail
program. MAPI is a standard interface that allows
WinZip and other programs to instruct your e-mail
program to create a new message, attach a file to it, etc. If
MAPI is not properly configured on your system, then
WinZip and other programs can't create e-mail for you.
"Properly configured" means that:
you have a MAPI-compatible e-mail program
installed, and
the e-mail program properly supports the "Simple
MAPI" interface that WinZip requires, and
the e-mail program is configured to be the default email program (sometimes called the "default MAPI
client").

Examples of popular MAPI-compatible e-mail programs
include (but are not limited to) Outlook, Outlook Express,
Eudora, and AOL 7.0 and 8.0.
AOL versions 4.0, 5.0, and 6.0 are not MAPI-compatible
and therefore do not support WinZip's e-mail features.
If you are having difficulty e-mailing your archives with
WinZip, we have tips for some popular configurations
available on our website. Please visit
http://www.winzip.com/xmapi.htm.

The Encrypt Dialog
The Encrypt dialog allows you to specify a password and
encryption method when encrypting files. The dialog is
displayed
when files are being added to an archive and you have
checked the Encrypt added files check box in the
Add dialog, or
when you choose Encrypt from the Actions menu or
from the WinZip® shortcut menu in Windows
Explorer. Note that this action encrypts or re-encrypts
all files in the Zip file. Please see About Encryption
for more information about this action.
To begin encrypting files:
Type the desired password in the Enter password
edit field (read about passwords in the "Notes on
using encryption" section).
Tip: check the Mask password check box to prevent
the password from being displayed as you type it. If
you check this option, the dialog will require you to
type the password twice for confirmation (to avoid
typographical errors in the password).
Click the desired encryption method in the

Encryption method area. (Note: this option appears
for Zip files only.)
Click OK to begin the action you requested.
See also
About Encryption
Using Encryption

Add Dialog Box Options
The Add dialog box include these options:
The Action drop-down list provides four choices. Note that all of
these choices replace any files already in the archive that have the
same name and folder information as files that are being added or
updated:
Add (and replace) files: adds all specified files to the archive.
Freshen existing files: updates files already in the archive that
match the specified files. No new files are added.
Move (and replace) files: the same as Add except that files are
deleted from disk or moved to the Recycle Bin after they have
been added.
Update (and add) files: works the same as Freshen, but adds
any specified files that are not already in the archive.
The Compression drop-down list determines the compression
method. Faster compression options usually result in larger archives.
Note: The method listed as "Maximum (enhanced deflate)" was
introduced in WinZip® 9.0. This method provides greater
compression for many files, but WinZip versions prior to 8.1 will not
be able to extract files compressed with this method. It may also not
be compatible with some other Zip file utilities.
The Multiple disk spanning drop-down list controls how WinZip
handles disk-full conditions while creating a new Zip file on
removable media, such as a diskette. This drop-down list is disabled
(not available) unless you are working with a new Zip file on
removable media. When this drop-down list is available, you can
select from one of three available values:
Automatic will automatically prompt for another diskette when
the diskette on which you are creating a Zip file is full.
Automatic + wipe first disk prompt is the same as
Automatic, but will give you the opportunity to erase any files
on the first diskette.
No Spanning results in a "disk full" error message if the size of

the Zip file exceeds the space available on the removable
diskette.
The Include subfolders checkbox determines whether WinZip
traverses all folders underneath the specified folder when looking for
files to add. This provides an easy way to archive all files underneath
the folder containing the specified file.
Note: to restore a branch of a folder added with the Include
subfolders option, be sure to select the Use folder names check
box in the Extract dialog box.
The Save full path info checkbox causes WinZip to store complete
path information (from the root folder) with all files added.
If the Encrypt added files checkbox is checked, the files you are
adding will be encrypted. WinZip will ask you for an encryption
method and password. Please be sure to read About Encryption
before using encryption.
The Add with wildcards button adds the files specified in the File
name field. (In Windows "wildcards" are the asterisk and question
mark characters. These let you specify multiple files at once, for
example, "*.Txt" refers to all files with a file type of "Txt".)
The Store filenames in 8.3 format checkbox causes WinZip to
store the short 8.3 MS-DOS compatible form of any long filenames.
"8.3" refers to the maximum of 8 characters in the filename portion of
the name and 3 characters in the extension, for example,
"12345678.123".
The Attributes section controls WinZip's handling of file attributes.
Attributes are an advanced subject; you do not need to understand
attributes for normal WinZip operation. If you are interested but not
familiar with read-only, hidden, system, and archive attributes,
please refer to your Windows documentation. This section contains
three options:
The Include only if archive attribute is set option excludes files
whose archive attribute is not set.
The Reset archive attribute turns off a file's archive attribute after
the file is added to the Zip file.
The Include system and hidden files option causes WinZip to add
files with the system and hidden attributes. Normally files with these

attributes are included.
Note:
The Include only if archive attribute is set checkbox will exclude files
whose archive attribute is not set. This option does not control which
folders are searched when the Include subfolders option is selected.

Folders (Configuration)
Select the Folders tab from the Configuration Dialog Box to control these
options:
Start-up folder
Unless you start WinZip® by double clicking on an archive, WinZip will
optionally change to a folder of your choice when it starts up. Files in this
folder are automatically displayed in the Open archive and New archive
dialog boxes. The following choices control which folder is used.
System default - WinZip does not change folders, so the system
default folder is in effect. Usually this is the folder containing
WINZIP32.EXE.
Last open archive - WinZip changes to the folder containing the last
open archive during your last WinZip session, unless it is on your A:
or B: drive.
Folder - WinZip always changes to the specified folder.
Extract folder
These selections determine the default folder that WinZip automatically
lists in the Extract to field in the Extract dialog box. You can, of course,
type over this default folder name or select a different folder from the
folder list.
Open archive folder - WinZip lists the name of the folder containing
the open archive in the Extract to field. For example, if the archive
c:\download\tools.zip is open, WinZip will list c:\download.
Last extract folder - WinZip will list the name of the folder you used
during the last Extract operation, unless it is on your A: or B: drive.
This value is saved when you exit WinZip so you can use it during
your next WinZip session.
Folder - WinZip always lists the specified folder. This value is saved
when you exit WinZip so you can use it during your next WinZip
session.
Add folder

These selections determine the default folder when the Add dialog box is
opened.
Open archive folder - WinZip uses the folder containing the open
archive.
Last add folder - WinZip uses the folder you used during the last
Add operation, unless it is on your A: or B: drive. This value is saved
when you exit WinZip so you can use it during your next WinZip
session.
Folder - WinZip always uses the specified folder. This value is saved
when you exit WinZip so you can use it during your next WinZip
session.
Working folder
When an existing Zip file is modified (for example, by adding files),
WinZip must make a temporary copy of the Zip file. Normally, WinZip will
create the temporary Zip file in the folder containing the open Zip file. If,
however, the open Zip file is on removable media (e.g., diskettes), WinZip
will create the temporary Zip file in the folder specified here. This is done
because there may not be enough free space on the removable media to
hold two copies of the file.
You can tell WinZip to use the specified folder for all Zip files, including
those on nonremovable media, by unchecking the box labeled Use for
removable media only.
When using ARJ to create an archive WinZip specifies this folder name
via the -w switch.
CheckOut base folder
If specified, WinZip uses this folder as the prefix for the default folder in
the CheckOut dialog box. If this field is left blank WinZip will instead use
the folder containing the open archive.
Temp folder
This entry specifies the location for temporary files created by WinZip,
including files created during the View and Virus Scan operations. If you
run out of disk space during a View or Scan operation, change the Temp
Folder to specify a drive and folder with sufficient free space.
Related Topics (other Configuration tabs):

View Toolbar System Explorer Enhancements Program Locations
Miscellaneous

View Dialog Box
When you push the View button in the toolbar or choose the View entry
in the Actions menu the View dialog box is displayed. This dialog gives
you a choice of viewing the selected file(s) in one of three ways:
Using the associated program. The associated program is listed in
parentheses. This method is similar to double clicking on a file in the
main window (unless the file is executable; in which case the
executable file is opened with the program specified in the Default
association field in the Program Locations tab of the Configuration
dialog box).
Using the built-in internal ASCII text viewer. Multiple files can be
viewed in one view operation using this viewer.
With any viewer available on your system. You must specify the
name of the viewer.

Screen Saver Installer
If WinZip® determines that the open Zip file contains
one or more screen savers (.SCR extension), the Install
button is enabled and you will be able to use it to install
your screen saver. Simply click the button or choose
Install from the Actions menu and follow the screen
instructions. Note: if the Install button is disabled, see
the notes below; the screen saver installer may be turned
off.
Caution: you should be careful when installing
any kind of software, including screen savers.
Be certain that you trust the source of this Zip file.
Do not install anything contained in a Zip file that
was attached to an unexpected or suspicious email message. See Security Hints and Tips for
additional information.
After WinZip has extracted the necessary files to your
Windows folder, it will run Microsoft's Display control
panel application to complete your installation. Here you
can try out the screen saver and possibly modify its
settings. If you change your mind and don't want to
install the new screen saver, simply select a different one
from the installer's list before leaving the Display

application. Note that clicking Cancel from the Display
application does not cancel installation of the new screen
saver--it has already been installed. Consult your
Windows documentation or help for more information
about the Display application.
If you use the WinZip Wizard, the Wizard will
automatically lead you through screen saver installation
when you select a Zip file that contains a screen saver.
Notes
Here are some additional notes regarding screen saver
installation.
Screen savers are typically installed to the Windows
folder. Therefore, WinZip does not provide you with
an option to specify the folder to which the screen
saver should be extracted. It does, however, show you
which files will be extracted and allows you to cancel
installation if desired.
Some Zip files contain more than one screen saver.
When this is the case, WinZip allows you to choose
which one to install.
Some screen savers require additional components
(.DLL, .VBX, .OCX, .MID, and .WAV extensions).
WinZip assumes that any file in the Zip file with one

of these extensions is a component of the screen saver
and will extract it to your Windows folder along with
the screen saver itself.
If you would prefer to install your screen saver
manually, choose Unzip only in the "Unzip/Install
Screen Saver" panel. Alternatively, you can disable
the WinZip screen saver installer by choosing
Configuration from the Options menu, clicking the
Miscellaneous tab, and unchecking the box labeled
Desktop theme/screen saver installer. This disables
both the screen saver installer and the desktop theme
installer.
WinZip supports screen saver installations only when
they are packaged in Zip format. It cannot install
screen savers from other archive formats (ARJ, LZH,
etc.).
If the Zip file contains both a desktop theme and a
screen saver, WinZip will use the desktop theme
installer (the screen saver is probably part of the
theme and will be installed along with it). If the Zip
file contains a SETUP or INSTALL program, WinZip
will use the standard software Install feature.

View (Configuration)
Select the View tab in the Configuration Dialog Box to control these
options:
Columns
Select the columns that you want to appear in the file listing. Click
the Defaults button to return the column selection and sizes to their
original default values.
Tip: you can also choose columns right in the WinZip® window: just
right click any column header and choose the columns you want
from the shortcut menu. You can use your mouse to resize and hide
columns by dragging the column dividers in the header area. You
can also use your mouse to rearrange columns by dragging the
column header from one location in the header area to another
location.
General
Allow all upper case file names - WinZip normally shows filenames
the same way as Windows: if the filename contains any lower case
characters the filename is shown in mixed case. Otherwise the first
letter of the filename is shown in upper case and the remainder in
lower case. If this option is checked, filenames that contain no lower
case characters will appear in all upper case (rather than initial upper
case).
Full row select - WinZip's default action is to use Windows Explorer
style of file selection, requiring that the file name itself be clicked.
This option allows you to click anywhere on the file's row of
information in order to select it.
Grid lines - Display grid lines to separate rows and columns in the
main WinZip window. Due to a problem in Windows XP, this option is
not available for XP users.
Watermark - Display a WinZip watermark in the lower right corner of
the main window. This option is available only for Windows XP
users.

Mouse selection
Normally the main WinZip window will automatically use the same
mouse selection settings as your Windows desktop. Should you
need to change these settings for the main WinZip window, you can
use these fields to do so.
Note: these options are available only if you have version 4.71 or later of
the Windows Common Control library. This library is part of Windows 98,
Windows Me, Windows 2000, Windows XP, and Microsoft Internet
Explorer 4.0 or greater, or is available as a separate download from the
Microsoft web site as described in the section Windows Common Control
Library.
Related Topics (other Configuration tabs):
Toolbar Folders System Explorer Enhancements Program
Locations Miscellaneous

Toolbar (Configuration)
Select the Toolbar tab from the Configuration Dialog Box to control these
options:
Use Explorer-style toolbar buttons - use this option to display
toolbar buttons that are similar in appearance to the toolbar buttons
used by Internet Explorer: the buttons appear in gray until the mouse
pointer passes over them. This option has no effect unless Use flat
toolbar buttons is also checked. On Windows XP, setting this option
will switch from WinZip® icons for Windows XP to the old Explorer
Style icons when Use large toolbar buttons is selected.
Use large toolbar buttons - use this option to display larger toolbar
buttons. On all versions of Windows except Windows XP, the Use
Explorer-style toolbar buttons option affects the appearance of
large toolbar buttons: if Explorer-style is checked, the large buttons
are somewhat simpler in design than the standard WinZip large
toolbar buttons.
Show button text - use this option to display the name of the button
under the button graphic on the toolbar.
Show tooltips - use this option to enable the display of brief, pop-up
text describing a button's function when your cursor pauses over a
button.
Use flat toolbar buttons - use this option to give toolbar buttons a
flat look instead of a 3D look. If Use Explorer-style toolbar buttons
is also checked, the buttons appear in shades of gray and change to
color when the mouse pointer passes over them. This option is not
available under Windows XP.
Use high color toolbar buttons when possible - use this option to
control whether WinZip uses more colors to draw color toolbar
buttons on systems configured to display more than 256 colors. This
option is not available under Windows XP.
Click Select Buttons to open the Select Buttons dialog box, which
enables you to select and rearrange the toolbar buttons.
Note: Some toolbar configuration options are available only if you have
version 4.71 or later of the Windows Common Control library. This library

is part of Windows 98, Windows Me, Windows 2000, Windows XP, and
Microsoft Internet Explorer 4.0 or greater, and is available as a separate
download from the Microsoft web site as described in the section
Windows Common Control Library.
Related Topics (other Configuration tabs):
View Folders System Explorer Enhancements Program Locations
Miscellaneous

System (Configuration)
Select the System tab from the Configuration Dialog Box to control these
options:
General
Modifying the following system options will affect all users who log on to
this computer.
The Associate WinZip with archives checkbox determines whether
Windows will use WinZip® to open archives from My Computer,
Windows Explorer, most e-mail programs, etc. WinZip can associate
itself with the following archive types: ZIP, LZH, ARJ, ARC, CAB,
TAR, TGZ, TAZ, GZ, Z, TZ, UU, UUE, XXE, B64, HQX, BHX, and
MIM. If you check this option, WinZip associates itself with all of the
listed types. If you uncheck this option, WinZip removes all of its
associations. When the option is checked, you can click
Associations to control WinZip's associations with specific archive
types. See the section titled Windows Associations for more
information on associations.
If the Include WinZip Quick Pick in the taskbar tray checkbox is
checked, the WinZip Quick Pick icon appears in the system taskbar
tray. You can use this icon to open WinZip, access recently used
archives, etc.
If the Include WinZip in the Start menu checkbox is selected,
WinZip is automatically added to the Taskbar Start menu. Uncheck
this option to remove WinZip from the Start menu.
If the Include WinZip on the desktop checkbox is selected, a
shortcut to WinZip is added to the desktop. Uncheck this option to
remove the WinZip shortcut from the desktop.
Related Topics (other Configuration tabs):
View Toolbar Folders Explorer Enhancements Program Locations
Miscellaneous

Explorer Enhancements (Configuration)
Select the Explorer Enhancements tab from the Configuration Dialog
Box to control WinZip's® Windows Explorer enhancements.
You can disable all of the Explorer enhancements by clearing the
checkbox labeled Enable Explorer enhancements (including
additional Drag and Drop features). If this box is checked, you can
control the enhancements individually as follows:
General
The Display context menu items in a submenu checkbox controls
whether the WinZip Explorer context menu items are displayed in the
main Explorer context menu or in a submenu.
The Display icons on context menus checkbox determines
whether a small WinZip icon is displayed to the left of the WinZip
Explorer context menu items.
The "Add to" includes folder information checkbox determines
how folder information is stored when you right click a folder in
Windows Explorer or My Computer and then choose Add to foldername.zip from the WinZip Explorer context menu. If this box is
checked, folder information will be stored for all files added. If it is not
checked, folder information will be stored only for files added from
subfolders of the selected folder.
Check for self-extracting CAB files
When the WinZip Explorer context menu is displayed for an EXE file,
WinZip can check to see if it is a self-extracting CAB file. This operation
can take a few seconds; you can use the following options to control
whether or not it is performed on various types of media.
If the On Local hard drives checkbox is checked, WinZip will check
EXE files located on local hard drives. This operation is normally
quite fast.
If the On removable disks (e.g., diskettes) checkbox is checked,
WinZip will check EXE files located on removable media. This
operation may take a few seconds.

If the On other drives (e.g., network drives) checkbox is checked,
WinZip will check EXE files on other storage devices such as
network drives. The speed of this operation depends on the speed of
the device, network connection, etc.
Display comment tooltips for Zip files
When the mouse pointer is hovered over a Zip file in a Windows Explorer
or My Computer window, WinZip can display a tooltip containing basic
information about the Zip file, including the number of files in the Zip file
and the Zip file comment. This operation can take a few seconds; you
can use the following options to control whether or not it is performed on
various types of media.
If On Local hard drives is checked, WinZip will display tooltips for
Zip files located on local hard drives. This operation is normally quite
fast.
If the On removable disks (e.g., diskettes) checkbox is checked,
WinZip will display tooltips for Zip files located on removable media.
This operation may take a few seconds.
If the On other drives (e.g., network drives) checkbox is checked,
WinZip will display tooltips for Zip files on other storage devices such
as network drives. The speed of this operation depends on the
speed of the device, network connection, etc.
Context menu commands
You can use this list to enable or disable many of the WinZip Explorer
context menu entries individually. Check the appropriate checkbox to
include a command in the WinZip menu, or clear it to remove the
command from the menu (see Explorer Context Menu Enhancements for
descriptions of the individual commands).
Note: the command labeled Open unassociated archives with WinZip
corresponds to the submenu entry Open with WinZip that appears for
self-extracting archives, certain media player "skin" files, etc.
Related Topics (other Configuration tabs):
View Toolbar Folders System Program Locations Miscellaneous

Miscellaneous (Configuration)
Select the Miscellaneous tab from the Configuration Dialog Box to
control these options:
Start-up
Next time start with the Wizard interface - Whether WinZip®
should use the Wizard interface the next time it is started.
Automatically show the Open Archive dialog box - Whether
WinZip should automatically show the Open Archive dialog box
when you start WinZip.
Show Add dialog when dropping files on:
An archive in Explorer - Controls whether or not a dialog is
displayed when you drop files on an archive in Explorer. If checked,
WinZip displays an Add dialog, which allows you to specify various
options to be used during the archiving process. If not checked, the
files are simply added to the archive and no dialog is displayed.
An open WinZip window - Controls whether or not a dialog is
displayed when you drop files from Explorer on a WinZip window. If
checked, WinZip displays an Add dialog, which allows you to specify
various options to be used during the archiving process. If not
checked, the files are simply added to the open archive and no
dialog is displayed. Note: if no archive is open, WinZip must display
the dialog even if this checkbox is not checked because you will
need to use it to specify an archive name.
Other
Windows Explorer-style Extract dialog box - This feature
determines whether the Extract dialog box contains a tree view
control or the Windows 3.1 style folder control.
TAR file smart CR/LF conversion - When selected, this option
determines if "smart" CR/LF conversion should be performed when
extracting from TAR files. CR/LF is short for Carriage Return/Line
Feed, the standard end of line indicator. This option can be useful
when a TAR file contains text files created on a Unix or Macintosh

machine. Unix text files usually contain lines ending in Line Feed
characters only, and Macintosh text files usually contain lines ending
in a Carriage Return character. The standard Windows Notepad
program and many other Windows programs require a Carriage
Return and Line Feed at the end of each line. When the TAR File
smart CR/LF conversion option is in effect, WinZip determines
whether to perform CR/LF conversion f le inside a TAR file by
looking at the first 80 characters in each file. If the file is a text file
then single LF and CR characters are converted to CR/LF pairs so
the file can be viewed by Notepad and other Windows viewers. Files
are considered text when the first 80 bytes contain only characters
with ASCII values between 0x20 and 0x7f, carriage returns, line
feeds, form feeds, tabs, and other alphanumeric characters (as
determined by the Windows IsCharAlphaNumeric API).
Always have WinZip on top - When checked, WinZip is assigned
the "always on top" attribute, so that it is not overlaid by normal
windows.
Beep after long archive operations - WinZip will beep after archive
operations that take more than one second to complete when this
option is chosen.
Smart DOC file handling - "Smart DOC Handling" is enabled when
selected. This feature is described in the section titled Double
Clicking.
Use Recycle Bin for move operations - When checked, if you
select the Move (and replace) files action in the Add dialog box,
WinZip will put files in the Recycle Bin instead of deleting them.
Prompt when View button is pushed - Unchecking this option will
bypass the View dialog.
Desktop theme/screen saver installer - When checked, the
Desktop Theme Installer and the Screen Saver Installer are enabled.
When unchecked, WinZip treats Zip files containing desktop themes
or screen savers as normal Zip files.
Show comments when opening Zip files - When checked, WinZip
will automatically display the Zip comment when you open a Zip file
that contains a comment.
Display status dialog for long operations - When checked,

WinZip displays an animated progress dialog during lengthy archive
operations. The dialog allows you to minimize WinZip while the
operation is in progress or to cancel the operation.
Number of files in recent file list - Sets the number of files that
appear in the list of recently used files in the File menu. You can set
this to any number from 1 to 9.
Restore all caution messages - Click this button to restore all
caution dialogs that you have turned off (a caution dialog is "turned
off" by checking its "Do not display this dialog in the future"
checkbox).
Related Topics (other Configuration tabs):
View Toolbar Folders System Explorer Enhancements Program
Locations

Explorer Context Menu
Enhancements
You can access many WinZip® features directly from the
context menus of My Computer and Windows Explorer.
When you right click files or folders in My Computer or
Windows Explorer, Windows displays a context (pop-up)
menu containing actions that are appropriate for the
selected items. WinZip can add entries to the context
menu that allow you to open and create archives, add and
extract files, mail archives, etc.
Configuring the context menu
You can configure WinZip's context menu enhancements
using the Explorer Enhancements tab of the WinZip
Classic configuration dialog (choose Configuration from
the Options menu; Wizard users will need to temporarily
switch to Classic mode to do this).
Alternatively, if WinZip is configured to display its
entries in a submenu of the Explorer context menu, you
can access the configuration dialog directly by right
clicking any file or folder in an Explorer window and
then clicking Configure in the WinZip submenu.

In the configuration dialog you'll find options on how and
where WinZip's menu items are displayed, and you can
enable or disable many of the items individually. Click
the Help button or press F1 in the dialog for specific help
on the options.
Using the context menu
To use the context menu, simply right click a file or
folder in My Computer or Windows Explorer. WinZip
will add items to the context menu that are appropriate to
the file or folder you selected. These items will appear
either in the main context menu or in a submenu labeled
"WinZip," depending on your configuration option.
Some WinZip context menu items are also appropriate
for multiple selections. For example, you can select
several files and add them all to a Zip file in one
operation, or you can select multiple Zip files and extract
from all of them at once. To do this, left click a file or
folder to select the first item, hold down the Ctrl key and
left click to select additional items, and then right click
any selected item to pop up the context menu. See your
Windows help for more ways to select multiple files.
Main context menu items

These items appear in the main Explorer context menu if
the selected item is an archive.
Open with WinZip: starts WinZip and opens the
selected archive. If multiple archives are selected, a
separate WinZip window will be opened for each
archive. See also the separate Open with WinZip
submenu entry described below.
Print: this is a standard Windows menu entry;
however, if the selected item is an archive, Windows
will use WinZip to print a list of files contained in the
archive.
Submenu items
These are the menu entries you may see in the WinZip
submenu. The actual entries that appear in any particular
case depend on the type(s) of file(s) you have selected.
Note: these items will appear in the main menu rather
than a submenu if you have cleared the Display context
menu items in a submenu checkbox in your
configuration.
Add to Zip file...: adds the selected items to a new or
existing Zip file. A dialog appears in which you can
specify the Zip file name, and WinZip remains open
after the add operation is complete.

Add to filename.zip: adds the selected items to the
named Zip file; the name is based on the name of the
selected item, or the folder name if multiple items are
selected. WinZip adds the selected items to the Zip
file, creating a new Zip file if necessary.
Add to recently used Zip file: opens a submenu
listing recently used Zip files. The selected items are
added to the Zip file you pick from the list. Note: this
item is enabled or disabled by the configuration
option labeled "Add to recently used Zip file <file
history>".
Open with WinZip: this is a separate entry from the
Open with WinZip that appears at the top of the
main context menu when an archive is selected. It
appears when the selected item is a self-extracting
archive (.exe) or a media "skin" file for programs
such as Windows Media Player (.wmz, etc.). These
types of files are not associated with WinZip, so
Windows will place a standard Open option at the top
of the menu; Open will start the program (if it is a
self-extracting .exe file) or open the file in the media
player (if it is a skin file). However, these file types
can also be opened with WinZip, just like standard
Zip files. To do this, choose Open with WinZip from
the submenu.
Note: this item is enabled or disabled by the
configuration option labeled Open unassociated

archives with WinZip.
Zip and E-Mail filename: WinZip compresses the
selected items into a temporary Zip file with the
specified name, creates a new e-mail message, and
attaches the Zip file. You can then address and send
the e-mail as you usually would. WinZip deletes the
temporary Zip file when it is no longer needed.
Zip and E-Mail Plus...: this item is similar to Zip and
E-Mail filename, but you can specify the filename to
be used for the Zip file, and you can optionally
encrypt the files contained in the Zip file.
Configure...: displays the configuration dialog for
WinZip's Explorer enhancements, including the
context menu. This allows you to adjust the context
menu and other options without starting WinZip. Note
that this option is only available if WinZip's context
menu items appear in a submenu.
The following submenu items appear only if the selected
item is an archive or, in some cases, multiple archives or
self-extracting archives.
Extract to ...: WinZip's Extract dialog appears and
you can choose a folder to which the files in the
archive(s) will be extracted. Note: this menu entry
also appears when you use the right mouse button to
drag and drop an archive.

Extract to here: the files in the archive(s) are
extracted to the folder that is displayed in the
Explorer window. Note: this menu entry also appears
when you use the right mouse button to drag and drop
an archive.
Extract to folder folder-name: the files in the
archive are extracted to the specified folder, which is
created if necessary. The folder name is derived from
the archive name.
Extract to here using file names for folders: this
item appears only if multiple archives are selected.
The files in the archives are extracted to subfolders of
the currently displayed folder ("here"), using the
archive names for the subfolder names. For example,
if the Explorer window shows the folder Downloads
and you choose this option to extract from the Zip
files One.zip and Two.zip, the files are extracted to
Downloads\One and Downloads\Two.
Extract to folder ...: opens a menu listing folders to
which files have recently been extracted. The files in
the archive(s) are extracted to the folder you pick
from the submenu. Note: this item is enabled or
disabled by the configuration option labeled "Extract
to folder <folder history>".
E-mail filename: creates a new e-mail message and
attaches the selected archive. This option appears only
if a single archive is selected.

Encrypt: encrypts all files currently in the selected
Zip file(s). You will be asked for a password and an
encryption method. This option appears only if all of
the selected files are Zip files.
Create Self-Extractor (.Exe): starts WinZip SelfExtractor, which allows you to create a self-extracting
program file (.exe) from the Zip file. This option is
available only if the selection consists of a single nonself-extracting Zip file.
Related Topics:
Using the Explorer Interface
Explorer Enhancements (Configuration Dialog)

Explorer Add Dialog
The Explorer Add dialog is displayed when you use the Add to Zip file
entry in the My Computer or Windows Explorer shortcut menus and
during certain drag and drop operations.
This dialog lets you change the name of the open archive in one of two
ways:
Type the name of the archive in the Add to archive edit field.
Click on the New or Open buttons to activate the standard New and
Open dialog boxes, respectively.
These shortcuts provide a quick way to add files to a different archive
without going through the File menu.
See Adding Files to an Archive for a description of the options available
in this dialog.

Obtaining WinZip Self-Extractor 2.2
WinZip Self-Extractor 2.2 costs $49 for a license to create an unlimited
number of re-distributable self-extracting Zip files on a single machine.
Click here for information on the differences between WinZip SelfExtractor 2.2 and the Personal Edition included with WinZip®.
You can order WinZip Self-Extractor 2.2 online via the WinZip SelfExtractor Ordering Information web page at
http://www.winzip.com/orderse.htm.
You can also order WinZip Self-Extractor 2.2 by sending a check for $49
to WinZip Computing, Inc. at P.O. Box 540, Mansfield, CT 06268, USA.
All payments must be in US funds drawn on a US bank. Shipping by
postal mail is included in the $49 price. Be sure to include your name and
your organization name.
Phone orders for WinZip Self-Extractor 2.2 can be placed through
DigiBuy, a credit card ordering service. You can reach DigiBuy at 1-877724-4600 (toll free; U.S. only) or 1-952-253-8488.
You can download a fully functional evaluation version of WinZip SelfExtractor 2.2 from the WinZip Self-Extractor web page at
http://www.winzip.com/winzipse.htm.

Desktop Themes and Windows 2000
WinZip® does not officially support desktop theme
installation under Windows 2000. Please read the
following information carefully.
The WinZip desktop theme installer is not officially
supported under Windows 2000 because Windows 2000
itself does not support themes in the same way that earlier
versions of Windows did.
The initial release of Windows 2000 (build 2195) does
not include the Plus! package (or its equivalent) that was
available for Windows 95, 98, or NT 4.0. As a result,
there are some differences between desktop theme
support under Windows 2000 and earlier versions of
Windows, and some potential problems that you should
be aware of when using WinZip; to install desktop
themes under Windows 2000:
The system theme installer (THEMES.EXE) is
included with Windows 2000, but it is installed in the
Windows system folder (typically
C:\WinNT\System32) rather than in a separate folder
as in the past (typically C:\Program
Files\Plus!\Themes).

Because theme components are often extracted to
folders that are relative to the folder where
THEMES.EXE is stored, installing some themes may
require WinZip to extract files to the system folder.
Some users may consider this to be undesirable
behavior, and it is even possible for important system
files to be overwritten.
Some desktop themes specify that theme components
must be extracted to the Plus! themes folder
(C:\Program Files\Plus!\Themes) or to its subfolders.
In order to do this, WinZip must create the Plus!
themes folder if it does not already exist. Under
Windows 2000, if this folder exists, the system theme
installer THEMES.EXE may fail to recognize themes
and theme components that are properly stored in the
system folder and its subfolders. That is, you may no
longer be able to use THEMES.EXE to activate
themes that you have previously installed.
You may be able to correct this situation by deleting
the Plus! folder, but be certain that there are no
important files in the Plus! folder or its subfolders
before doing so!
Under previous versions of Windows, WinZip was
able to tell the system theme installer which theme it
should display when it starts up. This does not work

under Windows 2000; when the system theme
installer starts, it displays the current desktop settings
rather than the theme that WinZip has just extracted.
In order to view the components of the new theme,
you must select it from the drop-down list labeled
Theme.
It is possible that Microsoft might update Windows 2000
or release a Plus! equivalent that will address these
issues. However, at this time WinZip does not officially
support desktop theme installation under Windows 2000.
Please visit our website for current information on themes
and Windows 2000:
http://www.winzip.com/xw2kthm.htm
Related topics
Desktop theme installer

Third-party Theme Installers
WinZip's® Desktop Theme Installer proceeds in two main phases. The
first phase identifies and extracts desktop theme components; the
second phase launches the system theme installer to complete
installation of the theme.
The system theme installer is not part of WinZip, and its behavior may
vary somewhat from the description given in the main help topic for
WinZip's desktop theme installer.
In particular, some third-party (non-Microsoft) theme installers
automatically activate the new theme by immediately applying its settings
to your system. In this case, you will not have the opportunity to preview,
then accept or reject the theme as described in the main help topic.
WinZip Computing, Inc. cannot promise that the WinZip Desktop Theme
Installer will operate correctly when used with third party theme installers.

How do I compress a folder and later
restore it?
Note: there are easier ways to do this, but this is the easiest to explain. In
particular, using the drag and drop interface or the WinZip® menu entries
in Windows Explorer's context menu can save you most of these steps.
(The examples assume that we are compressing and restoring the folder
C:\MYDIR.)
How to compress a folder and its subfolders:
1. Start WinZip.
2. Choose New Archive from the File menu or click the New button in
the toolbar.
3. Type the name of the archive, for example:
C:\MYDIR.ZIP
and press the Enter key.
4. Choose Add from the Actions menu or click the Add button.
5. In the Add dialog, navigate to the folder you want to compress, or
type its name
C:\MYDIR
and press the Enter key.
6. Be sure the Include subfolders box is checked and the Save full
path info box is not checked.
7. Click the Add with wildcards button. (In Windows "wildcards" are
the asterisk and question mark characters. These let you specify
multiple files at once, for example,"*.Txt" refers to all files with a file
type of "Txt".).
How to restore a folder and its subfolders:
1.
2.
3.
4.

Start WinZip and open the Zip file created in step 1 above.
Choose Extract from the Actions menu or click the Extract button.
Be sure the Use folder names checkbox is checked.
Navigate to the desired folder or type the folder's name
C:\MYDIR

and press the Enter key.
5. Click the Extract button.

How do I view graphic/spreadsheet/word
processing files in an archive?
In order to view a file in an archive, you need to have a program that is
capable of displaying that type of file. WinZip® can display text files using
its built-in viewer, but for any other type of file (including word processor
documents) you will need an external program.
The program you need will depend on the type of file you want to display.
For example, to display graphics files such as .jpg and .gif, you will need
a graphics viewer; to display a Microsoft Excel spreadsheet (.xls), you
need to have either Excel or a viewer that is capable of displaying
Microsoft Office documents.
If you use Windows 98 or Windows NT 4.0, you can use Microsoft's
Quick View to view a variety of file types. See Installing Quick View for
additional information on this viewer.
Otherwise, a variety of third-party programs, many of them free, are
available for working with and viewing the main types of files that most
people are likely to encounter in archives. For more information about
these programs please visit our web page at:
http://www.winzip.com/viewer.htm

Do you keep track of address changes?
We track address changes, so we can send you upgrade notifications. If
you purchased a copy of WinZip® and have moved, please send us
the following information:
1. Your name (If you are not sure how you spelled your name when you
registered, please include common alternate spellings, e.g., "J. E.
Smith", "Jim Smith", etc).
2. Your e-mail address, if any (please double check it! Almost 10% of
the people that sign up for our mailing list type an invalid address; email addresses are notoriously difficult to spell correctly).
3. Your new postal mailing address.
4. Your old postal mailing address.
5. Approximate purchase date.
6. Important: please indicate how you purchased WinZip:
Online order placed through the WinZip web site
By check
By telephone order to PsL (Public Software Library) or DigiBuy
Reseller (please include reseller name)
Thank you!

Installing Quick View
When viewing a file that does not have an associated program, WinZip®
uses the program identified as the "default association" in the Program
Locations tab of the Configuration dialog.
Windows 98, and Windows NT 4.0 include an optional file viewing utility,
Quick View, that can be used as the default association. Quick View is
capable of displaying files in a variety of formats. If you have one of these
Windows versions and Quick View is not installed on your system, you
can install it as follows: open the Windows CD-ROM, click Add/Remove
Programs, double click Accessories, check the Quick View box, then
click OK. To use Quick View with WinZip, select Configuration from
WinZip's Options menu, click the Program Locations tab, type
"quikview" in the Default association field (don't type the quotes), then
click OK.

UUencoded Example
Here is an example of a UUencoded file:
begin 666 encoded.txt
M5&5S="$-"@T*1V5N=&QE(%)E861E<CH"@T*5&AI<R!I<R!N;W1H:6YG(&UO
M<F4@=&AA;B!A('1E<W0@9FEL92!C<F5A=&5D('1O('!R;W9I9&4@9F]D9&5R
M(&9O<B!T:&4@=F%R:6]U<R!E;FO9&EN9R!S8VAE;65S+B!)9B!Y;W4@87)E
M('5S:6YG(&ET('1O('1E<W0L(&O;F=R871U;&%T:6]N<R!O;B!Y;W5R(&%G
M:6QI='D@:6X@8W5T=&EN9RP@<&%S=&EN9RP@<V%V:6YG+"!A;F0@9&5C;V1I
:;F<@=7-I;F<@5VEN6FEP+@T*#0I%;FIO>2$`
`
end
Return to Hints, Tips, & Troubleshooting

XXencoded Example
Here is an example of a XXencoded file:
begin 666 encoded.txt
hJ4JnR02B0Uo8FqJiR4lZ637ZMKFZQXcB0Uo8J4VdQm-dQmiPrFcOKtb64pj
hQaIUR4VVPW-V65FZQrEUNaZgNG-XQaJVR4JY65Fj65mPrNdN4IUNaxYN4Jm
h64NjQW-oO4IURa3mOKxpQm-ZPaBjN4ZiNm-nMqVZPKJn9W-7NWtPrIUML7Z
h65JnOKtb64Zo65Fj65FZQrEg64BjPaRmMLFpP43oOKxiQm-jPWtPrJm643b
hOKldR5YUOKsUMrJoR4ZiNmkUQ43nR4ZiNmkUQq3qOKtb90VPaEUN4JXPqFd
OPaQURLBdPaQUJqZiKaZk9Uo81Ed3PadjSG2+
+
end
Return to Hints, Tips, & Troubleshooting

BinHex Example

Here is an example of a BinHex file:
VGVzdCENCg0KR2VudGxlIFJlYWRlcjoNCg0KVGhpcyBpcyBub3RoaW5nIG1vcmUgdG
c3QgZmlsZSBjcmVhdGVkIHRvIHByb3ZpZGUgZm9kZGVyIGZvciB0aGUgdmFyaW91cy
ZyBzY2hlbWVzLiBJZiB5b3UgYXJlIHVzaW5nIGl0IHRvIHRlc3QsIGNvbmdyYXR1bGF0
biB5b3VyIGFnaWxpdHkgaW4gY3V0dGluZywgcGFzdGluZywgc2F2aW5nLCBhbmQgZG
dXNpbmcgV2luWmlwLg0KDQpFbmpveSE=
Return to Hints, Tips, & Troubleshooting

MIME (base64) Example
Here is an example of a MIME file:
--Content-Type: application/octet-stream; name="encoded.txt"
Content-Transfer-Encoding: base64
Content-Disposition: inline; filename="encoded.txt"
Content-MD5: V8ttTjZgvmMkzwVFKr5Olw==

VGVzdCENCg0KR2VudGxlIFJlYWRlcjoNCg0KVGhpcyBpcyBub3RoaW5nIG1vcmUgdG
IHRlc3QgZmlsZSBjcmVhdGVkIHRvIHByb3ZpZGUgZm9kZGVyIGZvciB0aGUgdmFyaW
bmNvZGluZyBzY2hlbWVzLiBJZiB5b3UgYXJlIHVzaW5nIGl0IHRvIHRlc3QsIGNvbmdy
bGF0aW9ucyBvbiB5b3VyIGFnaWxpdHkgaW4gY3V0dGluZywgcGFzdGluZywgc2F2aW5
bmQgZGVjb2RpbmcgdXNpbmcgV2luWmlwLg0KDQpFbmpveSE=
----Return to Hints, Tips, & Troubleshooting

Select Buttons (Toolbar Configuration)
Click Select Buttons in the Toolbar tab of the Configuration dialog to
select and rearrange the WinZip® toolbar buttons. You can also right
click on the toolbar itself and click Select Buttons.
The left side of the Select Buttons dialog box shows the buttons and
separators that are available for use. The right side displays the toolbar
arrangement in a vertical, top to bottom format, which is then transformed
into the horizontal, left to right format that WinZip uses.
To Add a button, highlight the button in the left side of the dialog
and click Add. It is easy to move it to the preferred location. If
desired, you can highlight the button above which you'd like to insert
the new button, first, and it will be placed in that position.
To Remove a button, highlight the button in the right side of the
dialog, and click Remove.
To Rearrange toolbar buttons:
Select and drag a button to its new location; an arrow to the left of
the button display will indicate its placement.
Highlight a button and use the Move Up and Move Down buttons to
move it to the desired location.
To Reset WinZip to its original toolbar configuration, click the
Reset button.
Notes:
You can move buttons on the toolbar without using this dialog box:
just press the Alt key on your keyboard, and while holding down the
Alt key, click on and drag a toolbar button from its current location to
the desired location.
You can remove buttons on the toolbar without using this dialog box:
just press the Alt key on your keyboard, and while holding down the
Alt key, drag a toolbar button off the toolbar.
The separator at the end of the toolbar cannot be moved or
removed.
This dialog box is only available if you have version 4.71 or later of

the Windows Common Control library. This library is part of Windows
98, Windows Me, Windows 2000, Windows XP, and Microsoft
Internet Explorer 4.0 or greater, and is available as a separate
download from the Microsoft web site as described in the section
Windows Common Control Library.
Related Topics (other Configuration tabs):
View Toolbar Folders System Explorer Enhancements Program
Locations Miscellaneous

